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PREFACE

The Against The Clock series has been developed specifically for those involved
in the field of graphic arts.
Welcome to the world of electronic design and prepress. Many of our readers
are already involved in the industry - in advertising and design companies, in
prepress and imaging firms, and in the world of commercial printing and
reproduction. Others are just now preparing themselves for a career somewhere in the profession. Wherever you find yourself working, if it's in the
graphic arts industry, it>s likely you will either be working on a Macintosh or
working in a network where Macs are important workstations.
This series of courses will provide you with the skills necessary to work in this
fast-paced, exciting, and rapidly expanding business. Many people feel that
they can simply purchase a computer, the appropriate software, a laser printer,
and a ream of paper, and begin designing and producing high-quality printed
materials. While this might suffice for a barbecue announcement or a flyer for
a yard sale, the real world of four-color printing and professional communications requires a far more serious commitment.

The applications presented in the Against The Clock series stand out as the
programs of choice in professional graphic arts environments.
We've used a modular design for the Against The Clock series, allowing you to
mix and match the operating system, drawing, imaging, page-layout, web development, and video editing applications that exactly suit your specific needs.
Titles available in the Against The Clock series include:
Macintosh Operations
Windows: Basic Operations
Adobe Illustrator: Introduction and Advanced Digital Illustration
Macromedia FreeHand: Introduction and Advanced Digital Illustration
Adobe InDesign: Introduction and Advanced Electronic Mechanicals
Adobe PageMaker: Introduction and Advanced Electronic Mechanicals
Quark.XPress: Introduction and Advanced Electronic Mechanicals
Microsoft Publisher: Creating Electronic Mechanicals
Microsoft PowerPoint: Presentation Graphics with Impact
Microsoft FrontPage: Designing for the Web
MetaCreations Painter: A Digital Approach to Natural Art Media
Adobe Photoshop: Introduction and Advanced Digital Images
Adobe Premiere: Digital Video Editing
Macromedia Director: Creating Powerful Multimedia
File Preparation: The Responsible Electronic Page
Preflight: An Introduction to File Analysis and Repair
Trap Wise and Press Wise: Digital Trapping and Imposition

vii

ICONS AND VISUALS

Throughout the book you will encounter the following icons, which are designed
to identify the four different categories of sidebars: teachers comments, pitfalls and
potential problems, keyboard shortcuts, and hands-on activites.

The Pencil icon indicates a comment from an experienced operator or instructor. Whenever you see the pencil icon, you'll find
corresponding sidebar text that augments or builds upon the subject being discussed at the time.

The Bomb, or Pitfalls icon indicates a potential problem or difficulty. For instance, a certain technique might lead to pages that
prove difficult to output. In other cases, there might be something that a program cannot easily accomplish, so we might
present a workaround.

The Key icon is used to point out that there is a keyboard equivalent to a menu or dialog-box option. Key commands are often
faster than using the mouse to select a menu option. Experienced
operators often mix the use of keyboard equivalents and menu/
dialog box selections to arrive at their optimum speed.

The Pointing Finger icon indicates a hands-on activity- whether
a short exercise or a complete project. Note that sometimes this
icon will direct you to the back of the book to complete a project.
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Sidebars and Hands-on
Activities supplement concepts
presented in the materiaL

Chapter Openers provide
the reader with specific objectives.
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A comprehensive Index allows the
students to reference and find any
term or feature discussed in the course.

Periodic Reviews allow the student the
opportunity to refresh what they've
learned, and determine their progress.

1X

SUPPORT MATERIALS

A variety of student files are included on the enclosed CD-ROM. These files are
necessary to complete the many hands-on exercises.
During the exercises you will be instructed to install fonts on your workstation.
You will find these fonts in your student files folder. These ATC fonts are solely for
use while you are working with the Against The Clock materials.

The Instructor Kit consists of an Instructor's Manual and an Instructor's CDROM. It includes testing and presentation materials in addition to the files that
come standard with the student books.

Overhead Presentation Materials are provided and follow along with the
course. These presentations are prepared using Microsoft PowerPoint and
are provided in both "native,, PowerPoint format as well as Acrobat Portable Document Format (PDF).

Test Questions and Answers are included on the instructor CD-ROM.
These questions may be modified, reorganized, and administered throughout the delivery of the course.
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ABOUT AGAINST THE CLOCK

Against The Clock (ATC) was founded in 1990 as a part of Lanman Systems
Group, one of the nation's leading systems integration and training firms. The
company specialized in developing custom training materials for such clients as
L.L. Bean, The New England Journal ofMedicine, Smithsonian, the National
Education Association, Air & Space Magazine, Publishers Clearing House, The
National Wildlife Society, Home Shopping Network, and many others. The integration firm was among the most highly respected in the graphic arts industry.
To a great degree, the success of Systems Group can be attributed to the thousands
of pages of course materials developed at the company's demanding client sites.
Throughout the rapid growth of Systems Group, Founder and General Manager
Ellenn Behoriam developed the expertise necessary to manage technical experts,
content providers, writers, editors, illustrators, designers, layout artists, proofreaders, and the rest of the chain of professionals required to develop structured and
highly effective training materials.
Following the sale of the Lanman Companies to World Color, one of the nation's
largest commercial printers, Ellenn embarked on a project to develop a library of
training materials engineered specifically for the professional graphic artist. A
large part of this effort is finding and working with talented professional artists,
writers, and educators from around the country.
The result is the ATC training library.
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The Mac OS

-

The Macintosh is known for

In this Chapter, we're going explore the use of your Macintosh, starting with the basics,
such as turning it on, and moving on to the fundamental building blocks of your system:
the mouse, the Finder, the Desktop, and how the windows work.
To best experience this course, you should be in front of your Macintosh ready to practice
some hands-on activities that will help you learn to use your system.

its ease of use, but don't Jet
this fool you into thinking
that practice and experience aren't important. The
longer you use the system,
the better an operator
you'll be.

Turning Your Computer On
In order for your computer to work, you will need to turn it on - or power up your system.
While this seems obvious, you would be surprised at how many support calls come into
help centers because the computer hasn't been switched on.
Most Macintosh computers created since the eighties have had the Power-on switch on the
keyboard. On newer models - particularly the G3 and G4 models - the Power button is
on the front of the cabinet. Ifyou have a different system in your classroom, be sure to ask
your instructor where the Power button is, or consult the manual that came with your
particular system.

Turning On Your System
1. Ifit's not already running, press the Power button to turn on your computer. A chime

should sound letting you know that the system is powering up. After a brief wait an
introduction screen should appear, and the Macintosh Desktop will appear.

The Desktop
When you first turn on your Macintosh the monitor fills up with a background color,
picture, or pattern. This background is called the Desktop. Later, when we teach you how to
control and change the working environment, including what you see on your monitor,
you'll learn how to change the appearance of your Desktop.

6 CHAPTER i/THE MAc OS

What is the Desktop?
The Desktop is the area on which you do all your work. Even when you're using a program
that completely covers the desktop, it's still there. There are several aspects to the desktop
that you should notice. Take a look at this picture.
The Macintosh Desktop
The Finder and the Desktop

Your hard drive appears on the desktop as an icon, as do folders,
applications, and certain other types of objects. In the upper right hand
corner is the Application Switcher, which you can use to switch
between programs w hen you're running more than one.

are the two primary
components of the
Macintosh Operating
System. The Finder is the

The Trash icon is where you throw away Items that you don't need
anymore. Just as in the real world, you can dig around In there andtake
something out, as long as you haven't emptied it. The only difference Is
that this is a virtual can, and therefore doesn't ever smell.

core ofthe operating
system. The Desktop is the
visual environment in
which you do most your
work.
The Finder controls the
entire system - including
disks, applications, folders,
printing, scanning, making
use ofresources such as
modems, digital cameras,
monitors.
Think of the Desktop as
your virtual work area. It
holdsyour desk, letter trays,
and some ofyour file
cabinets - everything but

The menu bar provides you with control over the Finder and the Desktop. When you begin
using programs, you will see that menus and how they're structured remain constant.
Although each program has its own features, and its own specialized menus, the way they
work and the position of standard functions (such as printing and saving) remain the same.

At the top of the screen is a white region with words, such as File, Edit, View, and Special on
it. This is called the Menu bar.
ln the upper-right comer is a picture of your computer's hard disk. This picture and the
other pictures on your Desktop are called icons, and are at the core of running your
computer. Icons are the fundamental graphic component of your Macintosh- and your
Windows-based PC, for that matter - that both display and give access to everything
within your operating system.

your office chair. On the

The Keyboard

Desktop, you can view and

The most common way to get things into the computer is through the keyboard. The
keyboard is used for several different types of input.

access any ofthe software
programs installed on your
Macintosh. The Desktop
icons are the labels that
show you what's on your
Desktop.

Typing Information Directly into Various Programs
You might find yourself entering copy into a word processor or into a design. If you do have
to enter lots of copy, then learning how to type is clearly important. Other types of information you might find yourself inputting into the system are numbers. If you're working
on financial documents a lot, then you will become familiar with the numeric keypad, which
is usually found on the right side of the keyboard.
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Using the Keyboard to Control Programs
Almost all programs offer what are called keyboard commands or keyboard equivalents. All
programs on the Macintosh offer several ways to accomplish certain tasks. Saving a file, for
example, can be done using the mouse (which you'll learn about shortly) or by pressing a
combination of keys on the keyboard.

Using Function Keys
When you're first using your
system, it will be all you can
do to move the mouse,
watch the screen, and gasp

Function keys are positioned across the top of the keyboard, and are named Fl , F2, and so
on, usually through Fl2. These keys often consolidate common keyboard commands into
one keystroke.

passes, and you become

There are other ways you might find yourself using the keyboard, depending on the exact
nature of the program you're using at the time. A drawing program, for example, might
allow you to use the keyboard to "nudge" or move an object a little bit at a time; a game
might let you use the Arrow keys to maneuver your warrior through the bowels of Hell.

more comfortable with how

Using Modifier Keys

the system works, you

There are four special keys, called modifier keys, that you will use almost every time you
work on your computer. Here is a list of these special modifier keys:

in amazement when the
system responds. As time

should make a concerted
effort to begin using
shortcuts, called keyboard
equivalents, such as
Command-5 to save a file,
Command-P to print a
document, or Command-Q
to quit an application. As
great as the mouse is, it's
not nearly as fast as using
the keyboard when there's a
choice between pressing a
key or two and rolling the
mouse from one side of

The Shift key works just like it does on a typewriter, capitalizng the
letter it's used with. It's also used with the Command or Option ~eys.
The Macintosh Operating System provides four Modifier keys. The graphics in the
left column are usually the way these keys are represented in printed materials.

your monitor to the other.

If, for example, you want to open a file, you might have to hold down the "O" key while
pressing the Command key. Pressing "O" by itself might not do anything at all- or at the
most put an errant "O" somewhere in your important report. Pressing the Command key
while holding down the "O" key, however, modifies the key, and makes it do something
more than simply enter the letter "O."

The Mouse
In the old days, before the mouse (the mechanical, computer kind of mouse, not the
squeaky, pointy-eared species), using computers was quite a bit harder. To get the computer to do anything, you had to use the keyboard to enter confusing strings of (otherwise)
meaningless code.
The mouse was invented in the late seventies, but didn't make its public debut on a computer until Apple put one on an early model called the Lisa. This computer was never really

8
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popular; and it wasn't until the introduction of the Macintosh computer that the mouse
began to have an impact on computers everywhere.

There are several different
kinds of "mice," or pointing
devices. The first is the
regular one-button mouse
that comes with your
Macintosh. Theydifferfrom
PC mice in that they have
only one button - the PC
version has two (or more).
The second type ofdevice is
a roller (or "track") ball,

The way a mouse works is quite simple. Moving the mouse around on a flat surface (many
people use a piece of plastic called a mouse pad to keep the ball and rollers clean) controls
an arrow that you can see on the monitor.
On the top of the mouse is a button. By using the mouse to move the cursor around the
screen, and the button to click on the items on the screen, you can make things happen.
This is a much easier and more natural way to get computers to do things for you. Trust us,
we're old enough to remember the days when computers didn't have mice.

If using the mouse to point at different regions of the screen feels a little clumsy, just give it
time. Before you know it you'll be speeding around like a regular expert. You'll learn how to
adjust mouse operation later in the section about Control Panels.
Here's how the mouse works:

which is essentially a mouse
that's mounted upside

Mouse Mechanics

down, with the ball facing
upinsteadofdown. Youuse
your hand to roll the ball,
and the arrow pointer
moves accordingly.
The third is a tracking pad,
where you use your finger to
trace the arrow pointer's
path across the screen.
Lastly, there are stylus
devices, that look much like
a regular pen. You use the
pen to draw the path of the
arrow pointer on the
surface ofa special pad. The
unique thing about these
devices is that they're
pressure sensitive. When

Using the Mouse
The most fundamental skill that you will learn is the use of your mouse. Without this
pointing device to access the various menus, dialog boxes, and functions available to you,
you would need to learn literally hundreds upon hundreds of complex keyboard commands. An experienced operator makes use of both keyboard commands and the mouse;
depending on the type of work he or she does, they might lean heavily towards one or the
other.

used with painting and
drawing programs, the
harderyou press, the more
"ink" or ''paint" comes out of

Artists working on digital images, architects, or anyone doing a lot of drawing and painting
all use the mouse much more than they do the keyboard. They might access various tools
from the keyboard, and they often find themselves entering type or nµmbers into their
designs, but the mouse is their primary connection to the Macintosh.

the tip!
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Other people, such as copywriters, account supervisors, customer service representatives,
salespeople, accounting personnel, and data processing professionals spend a lot oftime at
the keyboard. Their typing skills are usually superior to those of someone who uses the
mouse all the time, but their eye-hand coordination - the time it takes them to get the
cursor onto the right part of the screen to click a button, for example - might not be that
accurate. The more one uses a mouse as their primary method of interfacing with their
computers, the more adept they become at correctly positioning the mouse cursor.
Adjusting the tracking and
double-click speed ofyour
mouse is a very useful
technique. All users have
their own preference for
how fast or slow the mouse
should move the arrow, and
not everyone can doubleclick at the same speed.
Throughout this course, you
will learn how to set various
"preferences"
such as the o v e s
foryour
· ,

As a student, you should seek to become proficient with the mouse as soon as possible.
You'll get plenty of practice during this course.

Dragging
The first thing to learn is how to click on something and drag it around. While this might
not sound important, you will come to learn that it's a critical skill.

Dragging is just that -you point at something, hold down the mouse button (if you're
working on a Windows system it's usually the Left mouse button), and move it around. You
drag the item where you want it and release the mouse button to drop the item. This works
for folders, icons, moving items from one folder to another, or from your system onto a
floppy disk or removable hard disk. It feels a bit clumsy at first, but will become second
nature as you gain experience.

Dragging Items

mouse.All
programs,
including the
Finder, can be customized

I. In the upper right comer of your Desktop there's an icon that represents the hard disk
in your computer. In the lower right comer, there's a little garbage (excuse us, Trash)
icon. We've shortened the distance between the two for this visual.

to fit the way you like to
work.

2. Position the mouse cursor directly over the Trash icon and hold down the mouse
button. The icon will become highlighted. Drag it up the screen until it's directly
below the Hard disk icon. Let the button go - essentially dropping the icon in the
new location.

3. Now drag the Hard disk icon until it is to the left of the Trash icon.

10 CHAPTER I/THE MAC OS

Double-Clicking
The next important thing to ]earn is the ability to click the mouse button twice in rapid
succession. It's called double-clicking. If you position your mouse on an icon and doubleclick your mouse, something will happen - as we'll see a little later in this chapter.

Mouse Preferences

or a very clean surface. Even

As you can see, there are two things you can do with your mouse: move it around and click
the button. How far the mouse cursor moves when you move your mouse on the pad
(called the tracking speed), and how fast you have to click your mouse button to make
something happen are both under your control.

then, ~hey'//~
occasion-

Adjusting Your Mouse Controls

Don't run your mouse on
anything but a mouse pad

ally become

'

•

gunkedup
and won't
workproperly. This is

1.

Point at the Apple in the upper-left corner of the Menu bar. Click and hold down the
button. Keep it held down, and slide the mouse cursor to the word "Control Panels."
Slide to the right a bit and down until the word "Mouse" is highlighted.

because the roller ball and
the tracking mechanism
become clogged with gunk
that's very hard to get off.

Ab Apple System Profller
IBJ ATM Del uxe
f!l

Calculator
~Chooser

You should remove the ball

Ill Favorites

on a regular basis and clean

i- Metronome

it with alcohol or soapy

~ Remote Access Status

water.Same thing with the
small rollers inside; examine
them and make sure they're

e

KeyCaps

!!I Network Browser
ji Run Dally H02
11!1 Scrapbook

Cl Screen Snapz
P Sllertoct 2
Stickles

clean. Ifthey have gathered
lint, remove it gently with a
wooden toothpick and a
pair of tweezers.

Adobe Gamma
Adobe Type Reunion Deluxe
Aladdin CompresslonM
Appearance
Apple Menu Options
Applelallc
Colo.Sync
Connguratlon Manager
Control Str1p
Date le Time
DlalAsslst
Enervv saver
Extensions-Manager
File Exchange
Fiie Sharing
flash-It 3.11.2
General Controls
Internet
ICeyboanr
Keythaln Access
Launcher

Despite your best precautions and rodent hygiene,
you can expea to replace
your mouse about once a
year- or less, ifyou're a
heavy-handed roller or

2. When you release the mouse button, a small window will appear that contains the
controls for your mouse. There are two sets of slider controls here. The top one
controls the speed at which your mouse cursor moves relative to the movement of the
mouse. Click on the slider and slide it to the left, to slow down its movement.

working in a machine shop
MousaTreekl1>9

or mining operation.

&!

~
YerySIW

8
Slov

Double-Ciiek Speed

s

-

••

+
+
+
+
+
+
c::::c==~~
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3. Move your mouse around a bit and feel the difference between Fast tracking and Very
Slow tracking. Notice that the icon for Very Slow is a stylus pad (which we talked
about in a sidebar a few pages back) . Adjust the mouse until you're comfortable with
how fast (or slow) it moves.

Although menu bars

4. Now adjust the Double-Click Speed slider. Notice how the mouse button flashes in
the lower left of the window. Adjust the slider until you can comfortably double-click
your mouse button.

change depending on what
program you're using at the
time, there is a great deal of
consistency in where
specific itemsare located.
For example, the Fife menu
always comes first, followed
by the Edit menu. Context,
orprogram-sensitive
commands come next,
followed by the Help menu,
which is always positioned
last in the list on the right
side ofthe menu bar.

5. When you're done, position the cursor directly over the little box in the upper left
hand corner of the window. Click once, and it will close. You have successfully
customized exactly how your mouse responds to you.

Menu Bars
Whether you're working on the desktop, moving things around folders, making copies, or
using an application program, you will see a Menu bar at the top of the screen.
Menu bars are said to be context sensitive, that is they display choices specific to what you
happen to be doing at the time. For example, at the Desktop level, they have to do with
copying files, printing the contents of a folder or window, emptying the Trash icon, or
shutting down your computer. We'll see these in a moment.

If, however, you're in an image-editing program such as Photoshop, the menu choices
display Photoshop commands.
Window Help

Un Ued•l@fi6.7%(

Let's move on and work with the basic commands available to you from the Mac's desktop.
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Working with the Menu Bar
1. Move the cursor to the first menu selection. It's called the File menu . Click once on
the word File. A drop down menu will slide down from the Menu bar, and you'll see
the choices available to you.
r "

, Edit View
New Folder

Open
Print
Move To Trash
OoseWlndow
Getlnlo
l abel
Duplicate
Make (\I la~
Add To F1>vorltes
Put Away
Encrypt
Find-

2. Slide over to the next menu - the one called Edit. That menu will drop down from
the Menu bar and you'll see more options. Don't worry about what they do just yet
-you'll have plenty of time later on to learn all the commands.

,.. ta

me

View Special
Undo

sz

Cut
Copy

:iex

g

Help

ace

xv

Paste
Clear
SelectAll

aA
Slfow Clpboard

3. The next in line is the View menu, where you can change the way files look and
behave on your system. This is another menu that we'll explore a little later.

,.. .i

Fiie

Edit

Special

as Icons
as Buttons

v as Ust

v

asWiniiOW

as Pop•up Window
Cl eanl]p

SortUst

Reset Column Positions

4. Next, slide past the Special menu, and take a look at the Help menu. We will discuss
the Help system in the following section.

5. Let go of the mouse without making a selection from the menu.
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Windows
A window is a fundamental component of the Macintosh Operating System. Windows sit
on top of the Desktop, which is always functional and immediately available. Windows
serve two functions:
• Displaying the content of folders, drives, removable disks, and CD-RO Ms.
• Displaying the working page of an application program. In most cases, programs show you a window containing the document you're working on and
display different sets of tools provided by that program. Some programs allow
you to view the windows of more than one document at a time.

Any computer operating
system that lets the user
interface with pictures (such
as icons and menu bars) is
often called a "GUI"
interface. GUI stands for
"Graphical User Interface."
The Mac OS and Windows
are the two best known.
Unix and Linux can be run

We're going to start out with the first kind of window of a hard disk or folder.

the one that displays the contents

Scroll Bars
Scroll bars are an important part of managing windows on your Macintosh, because it's not
uncommon to have more things in a folder or on a hard disk than can be seen at one time.
That's where scroll bars come into play. Here's how they work:

from a GUI, or from a

Scroll Bars

command line, where the
user types commands into
the system and the system
responds. Command-line
operating systems are more

Clicking and holding the Slider will
let you move the contents up or down.

difficult to learn, but some

j
Clicking on the gray area will "'ove the
content area the width (or height)
of the visible a{ea, exposing the next
region of the t ndow.

"power'' users feel that they
have more control over the
way the system works.

~e

Unless you're destined to be
a programmer or what is

it

If you click once on the arrows at
the top or bottom of the scroll ~ar,
the list will move up a bit at a ~me;
click and hold the arrow and t e list
( . will scroll until It hits ttle end.

importan~component

.,..~ 0 . . . . . .

Scroll bar an
of all windowt
You can hold the slider itself, click or hold down the arrows, or
click t!Je gray area. Each method moves the contents of the Window
i a slightly different manner.

affectionately called a
"propeller head,"you'll
probably find GUI systems
more productive and easier

This illustration shows a vertical scroll bar. Horizontal scroll bars, which appear at
the bottom of the window, work the same way.

to use.

Working with a Window
1.
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Position the cursor over the icon of your hard disk. It's the icon in the upper right
corner of your desktop. When the cursor is over the top of the icon, double-click the
mouse button.

2. It will open into a window. Some of the items inside might look different on your
system -you may have more or fewer folders, or you might have folders and other
icons representing files or applications. Here's what our hard disk looked like when
we double-clicked the icon to open our hard disk window.

-

How you organize your
work area is a personal
thing, and often closely
parallels your habits on a
real desk (as opposed to this
virtual desk). Ifyou're sloppy,
and your desk is normally
buried under tons of
paperwork, so will your
Macintosh desktop. Ifyou're

3. Move the cursor to the lower-right corner of the window. The diagonal graphic is the
Manual Resize handle. Drag the corner inwards, reducing the size of the window.
When you let go, the window will remain at the size you made it.

highly organized, and keep
every single thing in its
correct spot in the universe,
then your Macintosh will be
equally structured.
Most ofour desktops look
like the proverbial rubble-

It.=================~~

strewn field.

4. Resize the window until some of the contents are hidden.
5. Once your window is too small to show all the contents, use the sliders to expose
items you can't see.

~~
The Scroll bar becomes active as soon as
you make a window too small to show its contents.

6. Next, move the cursor to the top of the window (over the Title bar), click, and drag
the window around. You can position the window anywhere on the desktop - even
with part of it hanging off the monitor!
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7. Click the Collapse button (the one in the very upper right comer of the Title bar).

lttlmtj tte::-119eseHi. emm
8. Click the Zoom box (the second one from the upper right comer of the Title bar).
The window will get just big enough to show all the contents.
Ifyou hold down the
Command key while your
cursor is inside a window,
the cursor will turn into a
little hand, which you can
use to push the contents up,
down, or sidewayswithout using the scroll bars

9. You will notice that when you're working with a window, for example, resizing or
moving it, the Title bar shows a series of black horizontal lines. These lines indicate
that this is the Active Window. Click anywhere on the Desktop outside the window,
and see what happens.

at all.

t= t~;;it~z;u~"= ~::··~·~_m_:Nt~:=;~;;::.~: ;: ~·~,;~~:~=-~~

-- -

mt:::= - - -'

System f'older

3 lte111$, m.3t11hvllilo11le

Documorrts

Appllcotlorl$

. :;:-,

10. You will notice that the Title bar of that window is now grey- the lines indicating
that the window is active have disappeared. Click on the Title bar again. It will be
reactivated. This is very important when you have several folders opened at the same
time. We will see this feature in action a little later on.
11. Close the window by clicking the Close box in the upper left corner.

Reviewing the Anatomy of a Window
Whether you're looking at the contents of a folder or disk drive, or working in an application program that provides a window for you to work in, the basic features of a window can
be found almost universally within Macintosh programs.

Anatomy of a Window
In a later chapter, we discuss

Close Box

Title Bar

Zoom

several methods of
connecting to the Internet
besides T1 or T3 lines, such
as cable modems, and a
relative newcomer to the
scene known as DSL, which
allows high-speed access
over regular copper
telephone wires.

16
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Number of Items,
Total Space Available

~
~

AppllcalloM

~
~

O.Xumtnts

Scroll Bars
Contents

• Title bar. Contains the name of the folder or hard disk.
Close box. Closes the window.
Zoom box. Expands the window to display all of the contents, or shrinks it its
pervious size. If the contents require more than the space available on your
monitor to display, the Window expands to fill the entire monitor.
This section will provide you
with some experience in

• Collapse box. Shrinks the window down to its Title bar, or, if the window has
already been minimized, it returns it to the size it was before it was shrunk.

using the built-in Help
system that Apple provides
with the Macintosh. The
exercises are designed to

...,. Scroll Bars. Allow you to move the inside of the window horizontally or
vertically so you can see items not currently in the visible area.
• Resize handle. Lets you drag the window to whatever size suits your needs.

familiarize you with how
the system works - not to
go through the hundreds of
topics available. You should

In Chapter 2, we're going to work more with windows, and explore some of the more
advanced controls that are available to you. In the meantime we'll move on to other aspects
of the Mac OS.

make extensive use of the

Mac Help

help system as you're

always install help files

The Mac Help system built into the Macintosh is a powerful and effective interactive aid
that will provide answers to your questions and instructions on how to perform specific
functions. While a structured, hands-on course like the Against The Clock series of instructional guides is the best way to start learning about your Macintosh, a comprehensive Help
system is an indispensable tool as you move forward.

when we purchase new

There are two types of help available to you from the Mac Help system.

learning. Later, it will
become just another thing
thatyoudon'tuse. We

software. Some of the help
systems are very comprehensive, while others hardly
provide any assistance at
all. You will come to love
help systems ifyou're

• The first is stored on your internal hard disk when the Mac OS is originally
installed. It is very robust, and will provide answers to almost any question you
might have. It references all the core functions of the Macintosh and the Mac OS.
• The second - a relatively recent addition to the Help system - is available
directly from the Apple Internet site and works only if you are able to access a
connection to the Internet from the system that you're working on.

anything like us - bad at
reading manuals. Help
systems are meant to be
available at exactly the time
you need them.

Increasingly, corporate and education installations are connected directly to the Internet
through a high-speed connection called a Tl or a T3 line. These are special communications lines which allow multiple users on a local network to connect directly to the World
Wide Web. In fact, if you're connected to one of these networks, you're literally online all the
time, and never need to dial the phone, as you do with a modem. Actually, the modem does
the dialing for you, but if you've ever connected to the Internet through a modemequipped system you might have heard the phone being dialed from within your computer.
A direct connection doesn't connect each time you go to the Web.
If you are connected to the Internet, than the entire range of Help and technical assistance
is available to you at all times. For now, let's look at the built-in Help system, since we're
sure that it's available to you.

CHAPTER 1/THE

MAc OS 17

Using Mac Help Basics
1. Select Mac Help from the Help menu.

2. Take a moment to familiarize yourself with the Mac Help window.
Home-- - - - - - You can search for a
specific topic by
entering it in this box.

Back/Forth buttons

• Mac Help

I! Seorch J
Primary categories
of assistance are

-

A dialog box is a window
that opens on your
Macintosh that allows you

to interact with the window.
The Mac Help window is a

'"[_

Mac

Help
Typo some ""rds 11\d click

Subcategories
and instructions
will appear here.

Search, or click en undtrlin«I
word .

l!lru
~P.!fili!IO.ll!!llllllP..!!1.11'.1.

lillP.Dl!.!lJ.ll

B.l!Un!LP.lU!!!!!.1
lnhm et an f n elyprt lna
Wt,:!>uM.iog.i:wa

!illl.'Y.
M.l!l!lm

M.!!!!.!!W!i!

dialog box. All programs

f!nl!lli!l.1.lll.U!l.ml1.

have them.

f:rln!Jnu

~

lW.!uilY.
SeUlnu_

S!urtculs anf llp.1

ilmJ
~P-1.lih

On the left side of the Mac H elp window is a list of system-specific categories. The
first choice in the list is What's New, and provides a list of features that are new in
Mac OS 9 (or whatever version you're running on your system). This is fo r people
familiar with older versions of the Mac OS who want to see what changes and new
features are available.
3. Move the cursor until it hovers over the second selection on the left side of the Mac
Help window- the one called Basic. You will notice that as you move over the blue
underlined selections, the cursor turns into a little hand with a pointing finger.

What·s neY
Basic~

Color accuracY.

18 CHAPTER 1/THE MAC OS

When you click on the Basics link, the right side of the window changes to display the
subcategories under that heading. You should also note that the Basics link has
changed color from blue to green - to let you know that you've already visited that
topic.

-

Many different applications
make use ofsplit windows

Mac

Help

like this one, where a list
appears in one side, and the
content in another. Some
Web sites on the Internet
also make use of this

-

.

9.. AboUt icom and the {nt;ton
• ~\f!th )(lndoys
• C reoti!l9.!!!<l.mi!l9~

l2IKl
~UlllU!lllP.lllll'.!..

• llium.im

UIWD!n
.Ell.ll.!Df.P.lmm

Internet UJd nt!yoit!nq

technique.

Late·11ce11:1nuwa
MCIUIY

2. You will see that the list is further broken into categories. The second category is
called About Icons and the Desktop. Click on it and a discussion of icons and the
desktop will be displayed.

-

Some icons are buttons, and
some aren't. Buttons need to
be clicked only once, while a
regular icon needs to be

Whoo you turn on your computer. you ..., the d$$ktop. The
de3ktop I• where you do your work. On tho deoktop you...,
•mall plcturee, or !cono, which repreotnl tho lteme you work
with or cree1e on your computer.
Thore·,. different Icon for each kind of Item on the d$$ktop.
for example, a procirem icon Is an Item you can open and use to
craale documents; you can create folclen to hold t hooe
document..

double-clicked. It'susually
not a problem ifyou
accidentally double-click a
button, but sometimes it will
launch an application twice.
When you suspect an icon is
a button, try clicking only
once; ifnothing happens, it

To open en icon:

•

Double· cllck It. (Click tho icon l\ollce quickly, ba!OIJ
careful not lo mow the mouse ba1"'een clicb.)
When you open on Icon, lb conlent. .ppeer In a Ylndw.

Tip: To learn more about en Icon, open the He! p menu and
clloo>e ShoY BellooM, thon point to the Item you Ya nt to lea r n
about.

Related topic

needs to be double-clicked.
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3. Read the instructions. When you're done, click the Back button. It's on the top left
side of the window. This will return you to the main Mac Help window.
4. Click the Home button and look at the window. This is actually the top layer of the
Mac Help system.

Words or phrases that are
underlined and in a
different color are often
connected, or "hyper/inked,"
to other information. When
you pass the mouse over
such an object and the
cursor turns into a little
hand, clicking it will usually
take you somewhere else.
This is how Web pages work
as well.

As you can see, there are actually three different levels of assistance: one for
AppleScript, which is a programming language that comes with your system; one for
Mac Help (that's the one we already used), and one for QuickTime, which is a
collection of tools for displaying videos and playing sounds. We'll be exploring
QuickTime later in the course.

5. Click the Mac Help link and return to the previous screen.
As you saw from this short exercise, you can use the category listing to find a subject that
interests you, or something that you're having a problem with. You should take time to look
through the various categories. There is a tremendous amount of information stored there.
Another way you might find a subject is by using the Search function.

Whenyou

dr
~-

do a word or phrase search,

Searching the Mac Help system
1. Click in the Search field and type the word "folders." (Dodt put the quote marks in).

Click the Search button.

the system ranks each
response by the probability
that it's what you're looking
for. Selections with the
highest probability are
marked with five stars

Mac Help
Whal'oney

(*****)and ones less likely
to be the correct answer
have fewer stars. They
appear in the left column
next to the links.
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Typo somo \l'ordUnd,cltck
5"rch, or cltck on underl!ned

.-Jori!.
Color accuracy

-

2. A new window will appear with the results of your search. You will notice that there
are quite a few subjects in the list. Select the one named Organizing files.

MaCHelp

111 Search J

Search Results

Pa<JO I of 5 obout "folders" In t1ac Help

All programs come with
some sort ofhelp system

itclll;)llt** ~

l'Ult~** ~o~ folde<··;ryfln sr;ri~

F'•"'

Kevbotrll •iiidcY!• w vorklM ...1w .,.1ri!!Ow

built in. Although they don't
all look exactly the same,

~end

removing foldet action ;.cript.s

~iii(jn59rorMndt

"'"'"'"'

--~....

they all work on the same
basic principle of topics
organized in an index.

1'19re re•ults [>

When you're installing
software from a CD, you're
usually allowed to determine which features you
want on your hard disk.

3. A window will appear that contains a discussion of folders and how they work. We're
going to work extensively with folders in Chapter 2, so read this information to
familiarize yourself with how they can be used to organize your data.

Naturally, the more features
you install, the more space
you'll need for the applica-

[J i:

_

--i'""

n

.;~ MacHelp

El8

tion. Help files are among
the components that some
people choose to leave on
the CD. This way ifyou need

t;:

Organizing files
You ust fo lders to or9onl u yo ur file•. for exomple, you ml9ht
keep oil of the files re lated to• porllculo r proj eclin o folder.
folders let you or9onlze yo ur fll os in a hierarchy, or "tree"
3tructure.

Ill'

!II

Help, you're asked to install
the CD. Wefindthatwhen
you first install a program
it's probably a good idea to
sacrifice the space and
install the Help files. That
way ifyou do need assistance, you won't have to
look under all those pizza
boxes to find the original

Creating a folder
To cr eole e folder:
1 Svitch to the Finder. ( Open lhe Application menu In the
upper-rl9ht cor ner oflhe screen and choost finder.)
2 Open the ril e menu and choose He" folder.
3 Ciiek the n•me of the folder ("untilled") lo stlect It, then
type e nN name for the folderend press Return.

program disk.

4. When you're done, you can close the Mac Help system by clicking the Close box in
the upper left comer of the window.
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Balloon Help
There is another type of help available to you - and one that is very useful as you are
getting to know your Macintosh. It's called Balloon Help, and it's quite simple to use.

Using Balloon Help
1. Select the H elp menu, and choose Show Balloons.

2. This control is known as a toggle. When you select it once, it turns on. Select it again,
and it turns off. At this point your Balloon Help is turned on. Move the cursor to the
Apple m enu in the far upper left corner of the desktop and see what happens (You
don't have to click the mouse).
Balloon Help is helpful for a
beginner, but can get
Un this tMnU lo opM an ittm n tht
App,. Mtnu lttms fo~, or to s..
inform111tion about lht •ollvt
appllo.atlon or Pt"09f"i1Yl. You o•n
customin tht lttm• In this mtr.u by

distracting after a while.
Balloon Help was designed

~11-.9 or rtmovln9 lttms from tht
I.wit Mtnu lttms foldtr .

to be used by any application, with specific programs
providing a database of

3. Touch the mouse cursor on the Special menu and slide down the list. You'll see that
Help balloons exist for almost all aspects of the Finder and the Desktop.

help content that would
automatically use the buiftin Balloon "engine."

4. If you want, you can keep Balloon Help turned on, otherwise, select Help> Hide

Balloons to turn it off.
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CPUs and Memory
Inside your Macintosh cabinet is the CPU, which is short for Central Processing Unit. The
CPU is your computer's virtual "brain." Memory is just that- information that's currently
available to the brain. Like most of us, some computers have a whole lot of memory, and
some don't.

The CPU
If you opened up your computer cabinet, you would find a great deal of complex electronics stored inside. Among the many components is a special chip caJled the CPU. This chip
contains the basic instructions that the system needs to perform tasks like using software
tools, storing data, and communicating with devices like monitors, printers, and other
system components.
Increasingly, manufacturers are building computers that have more than one processor in
order to meet increasing demands from more and more complicated programs. Rather
than attempting to build bigger and bigger devices, manufacturers have decided that it's
easier to use multiple processors. That way, the demands on the CPU can be divided upby specialized operating system software - and shared among the processors.
This doesn't mean that companies like Apple, IBM, Compaq, Intel, AMD, and many others
aren't working to make CPUs more powerful. Using multiple processors is a strategy that
lets users like you select a system that's just right for your unique needs. For example, if you
work on digital images, which are very data-intensive, you might choose to buy a computer
with two or more processors. If you're going to be a copywriter, primarily using wordprocessing programs, which inherently place less of a demand on the computer, a singleprocessor system should suffice.

Memory
The amount of memory that's built into a given computer determines two things: how
many things the computer can do at once (how many programs can be loaded and readyto-go when you need them), and how fast certain functions execute.
Memory can be thought of as a honeycomb. Each cell on the grid represents one byte. A
byte is enough to store one character.

Whenever you're done
working on your system,
make sure you quit any
open applications and use
the Shutdown command
from the Desktop. This way
the computer performs a
series ofinternal tasks to
make sure everything is OK.
Simply turning it offcan
sometimes lead to corrupt
(unusable) files.

If you put together 1,000 of these cells (actually 1024, but let's not get too crazy here), it's
caJled a kilobyte. A million of them are caJled a megabyte, and a billion are referred to as a
gigabyte.
You may have heard these terms before, especiaJly when looking at promotional material
for computers or hard disks. Memory contained in the computer is caJled RAM, or Random Access Memory.
CHAPTER I/THE MAC
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RAM memory is only active and available when the computer is actually turned on and
operating. Things that were stored only in RAM (which is the case while you 're working on
a new document, that hasn't been saved, or written to a disk) are lost when the system is
powered down. When you want to store something permanently, you save the contents of
RAM to the system's hard disk (or some other storage media) . This transfer takes place
whenever you issue a Save command from within an application, or software tool. W e'll be
working with these concepts in depth a little later on in the course. Here's a graphic that
shows the difference:

Random Access Memory vs. Disk Storage
Random Access Memory, or RAM, is memory that is used for
the files and applications you have open at any given time.
This includes any demands that the OS requires. The
contents of RAM are volative and are lost whenever you
turn off your computer. The amount of RAM partially
determines how fast your programs run and how many
programs you can have active at the same time. RAM
capacity is measured in megabytes (MB). A megabyte is one
million characters.
Most computers today have an internal hard disk. Files are
written to these devices so that they can be recalled for
future use. Capacities are measured in megabytes or
gigabytes (a million million bytes). The larger the capacity,
the more files and applications you can store. There are
many different types of storage devices, most of which we
discuss in the text of this Chapter.

Storage
Ifyou' re new to computers, you h ave probably encountered someone who told you horror
stories about losing their data to a "crash." This usually happens when you're working on
the most critical project of your life, it's due in the m orning, and you have to work all night
long. Fret not.
Today's computers are quite able to keep your important (and not-so-important) information safe and secure through all but the most traumatic events. Computers offer several
different types of storage systems where you can save your information quickly and easily.
Later in this chapter we'll discuss backup and archiving methods, which ensure that even if
you do experience a system failure, you will be able to restore your system to the way it was
the last time you created a backup.

Hard disks
The most fundamental type of storage you'll encounter as a Macintosh operator is the
internal hard disk. This mechanical device provides the basic storage space available to you.
Most computers today are configured with an internal hard disk- built into the actual
system or portable unit. The way they work is quite simple. A read-write head modifies a
m agnetic field that's stored on the surface of the hard disk, sometimes called the platter. The
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platter is formatted with concentric rings, called tracks, and pie-like slices called sectors. This
segmenting strategy allows the entire surface of the device to contain unique addresses,
which programs and the Macintosh Operating System (we'll explain these terms later) use
when they store and retrieve your data, or when they launch (another word for start-up) a
program.

Physical Characteristics of a Hard Drive

Address

All physical drives have these same basic characteristics: tracks (the concentric
rings around the disk); sectors (the pie slices radiating from the center of the disk);
and physical addresses created wherever a sector line splits a track.

Hard disks do occasionally require maintenance, and have been known to fail now and then
- even with today's very secure and stable systems. Another disk-related problem that you
might see happen from time to time is when a file becomes corrupted, or impossible to read.
There are specialized programs that can be used to fix certain categories of problems. These
applications are called utility programs.

External Storage
Certain computers not only have internal hard disks, but are equipped with external storage
devices as well. These can take several forms.

Fixed
A fixed external hard disk is one that's contained in its own case, and usually has its own
power supply. When you're considering the expansion of your system, you can choose to
put another hard disk inside your computer (internal), or choose to put the device outside
your system (external). Depending on the configuration, some computers either don't have
the space inside to mount an additional drive, or aren't able to supply sufficient power to
the device.
Sometimes, adding an external fixed drive is just easier to do, since you, the operator, only
need to plug in the cables, supply power, and run a program that comes \.vith the external
hard disk in order to use it immediately. Installing an internal hard disk normally requires
you to take your computer into a service center where a trained technician will do the
installation without voiding your warranty or destroying some vital component.
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Removable Media
Removable media is just that: disks and storage systems that can be taken out of your
computer. There are many types of such media.
• Floppy Disks. Floppies are normally 3.5-inches square and fit into a slot either
within your computer or in an externally connected drive. They only offer
about 1.4 megabytes of storage space, and are often reserved for making copies
of small files to move to another machine, or as a limited backup media.
• CD-ROM. When most people think of CDs they either think of music CDs or
the kind that you get when you purchase new software or interactive titles.
There are three primary categories of CD-ROM devices.
The first is a regular CD drive that is only capable of reading what is on the CD
in their tray. These are called Read-Only CD drives.
The second type allows you to actually "burn" a blank CD with your own
information. These are called Write-Once/Read-Many. When you burn information onto a CD using one of these drives, you cannot change the information on
the drive - it's there to stay.
The third type, and one that will eventually (likely) become the standard is
known as a Rewritable CD. Using special CD blanks, these devices can put
information onto a disk after it's been burned the first time. You can easily
modify information on a Rewritable - almost like you can on a hard disk or
floppy disk.
• Removables. Removable platters were quite popular for a while as a manner of
both extending the amount of space available to the user, as well as moving
larger graphic files from one system to another. An example is the designer or
advertising agency who sends their files for output at a service bureau. While
they're still in use at many sites, larger, faster, and more reliable methods are
beginning to reduce their importance as removable media. Some of them, such
as Jaz and Zip disks, have become standards on both the Mac and Windows
platforms
• Optical Disks. Once quite popular, but losing ground to CDs, optical disks are

larger (usually 5.25 inches) media that are mounted in a specialized read/write
drive mechanism. Optical disks normally hold between 600 megabytes and 1.2
gigabytes of data - enough for most large projects and very reliable as a backup
media. The disks are relatively expensive though, and they're normally used for
projects, not daily backups.
• Tape Drives. Todays Macintosh systems offer substantial storage in their internal
hard disks. Making complete backups of your drive isn't really necessary on a daily
basis -- just making backups of stuff that's changed since the last time you backed
up often proves sufficient. Tape drives are internal devices that can either back up
your entire hard disk, or just portions (for example by a range of dates, or only
files that have changed). Tape drives are invaluable ifyou're in a commercial
environment. Many networks have centralized tape backup systems that work in
the evening while you're at home sleeping or out partying.
26
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Chapter Summary
In this first Chapter you have learned about the core components of the Mac OS: the mouse,
the Desktop, the Finder, and how windows work. You have also gotten a brief overview of
how RAM works, and how it differs from the storage provided by hard disks and external
devices, such as removable platters, Jaz disks, and Zip disks. You should also have a solid
understanding of how the Mac Help system operates, and how to access it when you need
to know the answer to a specific question.
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Notes:
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Files and Folders
In this chapter, we're going to work with files and folders. You saw folders in the first
chapter, and learned how the basic window controls operate. The following exercises and
discussions will expand your knowledge of how the Mac functions and how to keep control
of your work, your Desktop, and the files that you create.

Using Folders
You've already double-clicked an item when you opened the Hard disk icon in an earlier
hands-on exercise. That's going to help you in this section, where we're going to discuss the
way folders work on the Macintosh - and how you can create, name, arrange, and throw
away a folder when you don't need it anymore.

What are Folders?
You can tell a folder when you see one. It looks just like a folder would look on your desk.
Folders hold any files or other folders that you put in them.

App1ications
Creating Folders
Learning how to create folders is one of the most important basic skills that you will call
upon when setting up your system, getting ready for a project, or backing up your important files. In short, you are likely to use a folder every time you sit down in front of your
computer.
Creating folders and naming them is really quite simple, as you'll see from the next exercise.
It's not making folders that's the hard part. It's keeping them organized that gets tricky
depending on how organized you are - and we really can't help you with that.

Creating a New Folder
1. If your Hard disk folder isn't open, double-click the Hard disk icon on your Desktop

to open the window. Click once somewhere in the window just to make sure that it's
active. The window is active if the Title bar has lines in it instead of being gray.

-.

- -

System folder
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Appllcetlons

Documents

2. Grab the lower right-hand corner of the window and drag to the lower right. This
will resize the window so you can see more of the contents.

Sometimes using the
keyboard shortcuts to
execute commands is
arguably more efficient
than using the mouse. We
say arguably, because there
are many very proficient
users that rarely use the
keyboard. Ifyou're already a

3. Click on the File menu and slide the cursor down until New Folder is highlighted,
then click on it.

typist, you are more likely to
find yourself using keyboard commands in place
ofthe mouse.
L11bel
Dupllc11te
MlllceAllllS
Add To F11vorttes
PlltAWllY

In the Finder's File menu
alone, there are 77choices
available:

xv

Encrypt

Command-N

AndXF
Se11rch Internet... X H
Sf\OW Oritiinal
8m

New

-0

Open

-P

Print

-Fwd-Delete

Trash

-W

Close

-D

Duplicate

-M

Make
Alias

-Y

Put away

-F

Find

-H

Internet

-R

Show

P~ge

SetUp_

PrlntWlndOW-

4. As soon as you let go of the mouse button, a new folder will appear in the window. The
name of the folder is highlighted. Name it "My First Project Folder". Don't worry ifyou
make a mistake, just use the Delete key on your keyboard to back up and retype it.
u;,n

Ill?

Ql.

Sy$\Om folde r

original

-=- ,,

·~~·

~

Appli.. tioM

[My llev

~"""" ~

~em$., 79 1.2f1e"ai-e11e~1~ ~

~

' ml,l!i

·- •• .~~

A

Documents

-.

Project folder]

~

tl

.l• IW

When the name of a folder is highlighted, whatever you type will replace the existing name.

5. Click the cursor anywhere in the window (not on an icon) to deselect the folder.
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Renaming Folders
It's important that you know how to change the name of a folder. There are plenty of times
when this is necessary: when you want to add a date to a folder's name, when you want to
correct a misspelling, or when you want to change a name in order to better organize a
collection of folders. Doing so is simple.

Changing the Name of a Folder
1. Click once on the folder you just created. It will become highlighted.

My first Project folder

Throughout the course we
provide names for files and

2. Hit the Enter key on the right side of the numeric keyboard. If you don't have a
nwneric keypad (or if you just want to do it a different way), simply put the cursor
over the top of the name, click, and wait a second or two. A box will appear around
the highlighted name of the folder, indi~ating that you can now type a new name.
Change the name of the folder to "Project Folder".

folders that you create or
modify during hands-on
activities.
If you decide to change the
names to something more

3. Click anywhere to deselect the folder you just renamed.

personal, it may prove

Nesting Folders

confusing later on if

When folders are put inside other folders, and folders created inside those, it's called nesting
folders. For this exercise, we're going to use some of the files on the CD-ROM that came
with this book.

another exercise uses the
file or folder. The images in
the book an( ( &
those you
see on
screen will
differ.

''•'
_...,,,...

Because of this, we recom-

Organizing Folders
1. Double-click the Project folder you just created. It will open up and display its (now
empty) contents window. Notice how it sits on top of the folder in which it was
created. When wi ndows lay over each other this way they're said to be cascading.

mend that you put up with
the names we use for files
and folders.
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When you used your bui/tin Help files in Chapter 1, we
accessed information
about how files workedin particular their hierarchy.
Hierarchy and nesting are
the same thing. There is a
top level folder, folders
inside that one, folders
inside those, and so on.

2. Change the active window by clicking on the one underneath the Project folder.
When you see what happens, change back to the Project folder.

Ifyou think about it, this is a
very logical way to
organize projects. In a
design environment, for
example, you might have a
client folder, and inside that
client folder a series ofjobs
that you're working on for

3. With the Project folder active, hold down the Command key and press the "N" key
three times. Three new folders will be created inside the Project folder.

them. These folders might
havejob numbers instead
ofnames. Inside those job
number folders might be
other folders for scans,
drawings, copy files, and
layouts.

4. Name them "Copy Files", "Graphics", and "Artboards".
l!i"QJed1Folder ·~

Grephico

Cl

Arlboorcb
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5. Double-click SF- MacOps folder from the CD-ROM that came with this course.
Inside are several folders. Open the one called Worki ng with Folders. Inside you
will see several different types of icons.
[]

Cl Working with Folders • ""'
6 Items, 869. 1 M8evallable

l:!ttfi ..iilii

~

~

llil

shortcut to remember: Hit

Ro119h Rider Ad.Tl F

the tab key while this

=~~

il!f8

Berries.bet

EJ

Ge rclenlng Ponel.TIF

~

Berri.. Picture.Tl F

~
8enono Boet.TIF

Here's a good keyboard

-

~

..:!.;

S..mple Fiie • t (Statlonory)

t.!.

~

•

~

1>

~
~

window is open. Notice that
the folders each become
selected in turn, as you tab

6. Open the Project folder you just created Arrange the two windows so they're next
to each other on your Desktop.

::J Project Folder

through. Ifyou stop on one

§ii

3 1tem1 , 795

and hit the Enter key (on the
numeric keypad), the name

z r·1B l>'allable

CJ,

Copy rn..

Craphlco

Cl

Artboordo

becomes selected and you'll
be able to rename it without
.. g

using the mouse at all.

::
Q

D

Banano Soot.Tl F

8errles.txt

Ro119h Rider Ad.Tl F

Sample Fiie • 1 (Statlonory)

Gerdenlng Panel.TIF

•

~

Ifyou haven't done so

D

Serrin Plcture.TIF

7. Select the Banana Boat.Tl F file, and while holding down the Shift key, select the
Gardening Panel.Tl F file. Holding down the Shift key while selecting files lets you
select files that aren't next to each other - sometimes called non-contiguous files.

already, now's the time to
gather the student files
supplied with this course.

8. Now that they're selected, drag the two files over to the Project folder. You will see
them move together. Drop them onto the window by releasing the mouse button.
Project folder

lnsertthe CD, and locate the
folder named SF- MacOps
Copy Fllu

......

and drag it onto your
Desktop. It doesn't require a
great deal ofspace, so it

~

Artboerds

shouldn't be a problem. If
size is a problem, then you
can open the files directly

CJ

from the CD, but will still
need to save your work on
your hard disk.

•

AoU'lh Rider Ad TIF
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Burlu .txt
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•

Berrie) Plcture.Tl f

9. Drag the Banana Boat icon onto the top of the folder called Graphics. Hold it there a

moment, and the folder will open. Drop the file.
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Using the Shift key while

QHH£Q@li

clicking on elements lets
you select more than one
item. Another trick is to
press Command-A, which
selects all the items in a

~r

folder.

10. Close the folder by clicking on the Close box. Next, drag the Gardening Panel icon

Shift-clicking will also
deselect the items you don't
want. This is very useful
when you want to move or

onto the Graphics folder and drop it immediately. It will go into the folder without
opening. Remember, if you wait a moment, the destination folder will open by itself;
if you simply drag something onto a folder and drop it, the item will automatically
move to that folder. Open the Graphics folder and check it out.

copy almost all of the files in
a particular folder. It's much
easier to select all of the
Bencno Boot.TIF

folders then deselect a few

Ill

of them than it is to Shift-

GenSening Panel.TIF

click every one you do want.
Remember, always try to
minimize your clicking. If
there's a way to do something with three clicks
instead of twelve, the
shorter method is the most

This feature (where a folder automatically opens if you hold a file over it for a moment) is called a spring-loaded folder. Later on you'll see how you can turn this feature
on and off, and how to change the speed at which a folder responds.
11. Put the Berries.THT file and the Sample File
that you named Copy Files.

# 1 (Stationary)

file into the folder

productive. You can also
click on a window and
(holding down the mouse

EJ
~Stationary)

Berrie3.txt

button) draw what's called
a marquee around several

Sample File

files if they're next to each

-4T

other.

12. Put the Rough Rider Ad.Tl F file into the Artboards folder, and the Berries
Picture.Tl F into the Graphics folder, along with the other two images you dragged

into it.
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You might notice through-

13. When you're done, the Working with Folders window will be empty, and all the files

will be organized into the three folders you created.

out various hands-on
activities that we some-

f?'!

D
j

times change the size of the

Cl

window without giving you

Copy fi les

specific instructions to do

ProJectfolder
3 Items, 796.7 MB avelleble

Cl

Grophles

so. At this point you should
be comfortable with
resizing windows yourself.
So if they're occupying too
much screen space, by all

o Itern., 867 9 MB ev.i1loble

means do so. We're doing it
to adjust the size of the
screen shots for the layout
ofeach page in this book.

14.

Close all the folders so your Desktop looks the way it did when we started this
exercise.

When you look at the files
that we've supplied to you
in the SF-MacOps folder,
you will see that almost
every file name has an
"extension" on it - three
letters after a period at the
end of the file name. For
example most pictures have
a .TIF extension, and most
text files have a .TXT
extension. This is common
in the PC world, but not
necessary ifyou work only
on a Macintosh. Since most
of the real world works in
cross-platform environments, however, it's a good
idea to get in the habit of
including the extension
whenever you name a file.
Each application has its
own extensions.
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Navigating through Folders
In the last exercise, you created a folder with three subfolders inside it. When you're working on projects, especially complicated ones, your folder structure can become equally
complex. Knowing where you are at a given time, and being able to see at a glance which
folder happens to be inside which other folder, is very important.
There is no question in our
minds that the most
difficult concept for
beginning students to grasp
is how to dig around

When you create a folder within a folder it is considered a nested folder. Another word for
nesting is the hierarchy of your files and folders. You can think of hierarchy as a standard
flow chart, with the Desktop at the top, and all other things either at the same level, or at
some level below the Desktop.

Organizing Folders and Files on the Macintosh

through folders to find what
they need. This is particularly true when you're inside
an application, and need to
navigate directly to a
specific folder in order to
find the right file.Take
special care to study this
issue until you're quite

Things on the Desktop include:

II l

Hard disk
(MacHD)

Any other file, folder, or item
you put on the desktop

Trash

DESKTOP

Items on your Hard Drive include:

CD-ROMsl
Floppiest
Other Media
(these appearl
when they'rel
inserted)

t
System Folder

comfortable with how
folderscan reside inside
each other.

Any other file, folder
or item that you put
on the hard drive

(l eopyrnes

IJll

2 lteJM, 796 7118 6Yell&i>le

~

Berrie.>.txt

S.11pl1 fi le

~SUll_.y)

You dragged these files into their respective folders from
the "working with folders" folder, which was supplied on your
student files disk.

As you can see from this illustration, there is a logical method to how folders - especially
nested folders - work. As you begin to work on real projects, you will begin to learn how
to best create and organize folders to match the particular way you like to work.
One thing to remember is how to find out where you are at. Ifyou've been working for a
while, and you're deep within a nest of folders, you should know how to identify where the
current folder is in the hierarchy. This brief exercise will show you how.
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Identifying a Folder's Hierarchy
I . If any folders are open on your Desktop, close them.
2. Double-click your Hard disk icon.
3. Hold down the Option key and double-click the Project folder. You will note that
the Hard disk window automatically closed when the Project folder opened. This
automatic closing of one folder when you open one of its subfolders is very important
when you're going deeper and deeper into nested folders. Otherwise you would either
have to close each one individually, or live with a very cluttered Desktop.
4. Do the same thing with the Graphics folder. The Project folder will close, and the only
thing left on your Desktop will be the Graphics folder.
l:.IJ fL-~~_E_

:ff

fijJ

~
llanua Boal.Tlf

f!¥¥¥....,'"

.~ ~ Grophlcs ?"
3 Items, 796.9 MB avel!•bl•

Ila
Gerde nl119 Pa nel.Tlf

'IDS

~

•

~

Berri" Plcture.Tlf

f-;1~
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Ifyou take something out of
a folder for any reason, you
can put it back where it
came from with the

v~1

5. Hold down the Command key and click-hold on the folder's name in the Title bar at
the top of the window. Something called a pop-up menu will appear. (It's called a
pop-up menu because that's what it does. You will see many more of these during the
balance of this course.)

File>PutAway command.
Simply select the item,
choose the command, and
Banane Boat.Tlf

the document or folder will

Gerdenl119 Panel.Tlf

Berri.. Plcl ure.Tlf

go back to where it belongs.
The keyboard command for
putting something away is
Command-Y. Tryit,it'sfunto

6. Slide your cursor down until the word MacHD (or whatever your hard disk is
named) is highlighted. Let go of the mouse button.

watch and fairly useful, too.

0

Banana Boal.Tlf

Ge rdenl"'l l'onel.Tlf

Berri.. Plcture.Tlf

7. Notice that when you selected your hard disk by Command-clicking the current
folder's Title bar, its window automatically opened. You can use this technique at any
time either to open the containingfolderor simply to see where it is you're working at
any given time.
8. When you're done, press Command-Option-W (remember COW) to close all the
open windows.
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Changing Views
Another important aspect of managing and arran ging your folders is how the contents
appear when you open a folder. The way your files appear within a folder is called the view.
There are three different views to choose from .

You can close any active
window by using the Close
command (Command-W)
from the keyboard. This
makes three different ways
to close a window: using the
Close box on the window

• As Icons. This is the standard view when you first set up your Macintosh.
Within this view you can choose several different sizes of icons.
• As List. In the List view, you see file information displayed in columns. You can
arran ge the files by name, size, creation date, kind, label, date created, date
modified, and version.
• As Buttons. In the Button view, each icon becom es just that - a button. When
files are viewed as buttons, they only require a single click to be opened or
activated.

itself, choosing File>Close,
and pressing Command-W.
Ifyou add the Option key to

this last combination, or
Option-Command-W, it will
close all open windows on
the Desktop.
When you're working on a
project, there are many
times when you want
several foldersopen at the
same time - especially if

So far, we've been looking at icons, and while that's fine for som e applications, there are
times when a folder con tains so many files and folders that it's impractical to move around
using only little pict ures of files. There are times when we need to look at lists, and other
times when buttons are more appropriate.
For example, if we open our System folder (which is a special folder we'll be talking about a
little later), we see these icons.
e:i ~

~

Cxltn, loM

~

Control Poriela ( 0 1'8 -led)

Apple Menu Item'

Appeirua

ii.

Appl lc:atlon !SUPPofl

CMSCP

ColorSync Pronlu

11

ATM f'onl Ott.MM

~

Cllpi>Oonl

files from more than one
folder.

C:Ontrtl Strip t'Wults

"
~

cursor over any folder, the
cursor will turn into a
magnifying glass. Ifyou
continue moving it over a

Control Panel•

ia.

"
PtMIS

a

~

S\tiltm Raourc:.,

El

KPFMS

Lounche: r llt mi

HS Pnf1rence PtMll

Prtfen ncet

fonts

!J

11ocTCP ON

LOii•

PowrPC Enebler 9.0.4

StiutdiWn Items (Dl•bltd)

Ttxl [ -

ia

PrlntMDnltor Oocurnenu

lr>p

ii

~

ScrepDoot Filt

~

Scrlptift9 Addl tioM

~

S<rl pt•

~

Stu t..:plttms

~

Sy>tt ..

Shutdw• lltrn:s

a
a

~

A

f indt r

l•"J- I. Ae<jion Support

Startup llt mt (DIMbltcl)

Hllp

svs.t•m ~tntloro (Disabled)

Inter net Setreh Site•

Ifyou double-click-hold the

~

C.ntexhttl Menu llt ms

a

fxten,loM ( Dis.bled)

fa}.
~

you're moving itemsfrom
one to another, or opening

-

1!111

Gn.
~

This isn 't even a very radical example. Folders might contain hundreds of files - a catalog
which requires 400 or 500 individual scans, fo r example - and can be very confusing to
look at. Fortunately, there are many different ways that you can arrange your files in an
open window.

folder inside that one, it will
open, and the first one will
close automatically.
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Changing Views
I. Double-click yo ur Hard disk icon, then hold down the Option key and double-dick
the Project folder you created earlier.
2. Hold the Control key down and click inside the window. A pop-up menu will appear.

~

Copy Fl loo

as Buttons
as List
./ ASWilid.ow
as Pop-up Window

3. Slide down to the View menu, hold the mouse button down, and another pop-up
menu will appear. Continue sliding until the As List item is highlighted. Let go of the
mouse button. The Project folder contents be displayed as a list instead of icons.
Expand the window so you can view the columns.
j

3 ltemo, 796.? MBavolloble

IDete Modified I

lze Kind

-

-

"

folder
folder
folder

·~
4. Notice that each folder's name is listed on the left side of the window, and the last
time the folder was modified (or in this case created) is be displayed in the next
column.
5. To the left of each folder's icon and name is a small arrow. Click the arrow directly to
the left of the Art boards folder.
41temo, 796.9 MBmllable

Dal• Modlflod
Today, I :20 PM

Using Control-click will

Today, I 2:25 PM

access the View menu while
you're in the Finder. The
Control-click action on the
Macintosh is the same as
clicking the right button
while working on a PC and
using Windows98 or
Windows Millennium.
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Size Kllid
- folder
600 K Photoohop& Tl ff

Today, 1:14PM

-

folder

Today, I :20 PM

-

folder

mo

6. Do the same thing to all three folders.
EJ

l!l

v
Today, 12:25 PM
Jodey, 1:14PM

rrt, Nov 21,

-

j

-

1997, 2:32 PM

8 K SlmpleText text docu
- folder

Today, 12:27 PM
Todey, 1:20 PM

Whenever you close a folder,

folder

8 K SlmpleText text docu

Todey, 12:23 PM

44 K Pho1Dohop8 TIFF file

Today. 12:23 PM

260 K Phot.,hop8 Tiff file

I Todey' 12:24 PM

544 K Phot.,hop8 TIFF file

it remembers the view
options that you selected
before it was closed. This
ensures that you can keep
some folders open within

7. The List view displays a lot of information about each file that doesn't show in Icon
view. If you can't see all the information, enlarge the window.

each other, others closed,
and still others with
different view options.

8. Click on the arrows again to collapse the outlines until you see only the three Folder
icons again.
l 0. Control-click somewhere in the window and highlight View. In the pop-up menu
that appears, select the As Buttons option.
11. When you make this selection, the folders inside the Project folder will appear as
buttons - just like the ones we used to select how to use the H elp system.

Copy Flies

Views arejust that- views
- and don't fundamentally
change the way a folder

Grephico

Artboarcb

12. Try opening one of the folders. Notice that you only need to single-click a button to
open the folder.
13. When you're done, close all the windows again.

works, just how it looks.If
you're viewing folders as
buttons, you can still drag
items onto them. The folder
will open automatically if
the Spring-loaded option is
turned on in your Folder
options. (We'll be discussing
Folder options later in this
Chapter.)
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Windows as Pop-ups
As we've already stated, there will be times when your monitor is so filled with folders that
you can't find the forest (an important file) for the trees (dozens of other folders opened
and scattered all over the Desktop). There's a third way to view folders and their contents.
It's called a Pop-up view.

Ifyou've ever used a
Windows-based machine,
you're probably familiar
with the Minimize
command. Th~
command
reduces a

,

'

o

window to

We've used pop-up menus already; that's how we accessed the View menu in one of our
exercises (by holding down the Control key and clicking in the window). This is a different
sort of pop-up, though. It takes the active window and collapses it into a button that sits at
the bottom of your Desktop. You click the button and the folder opens into a tabbed
window. Click it again, and it goes back to the bottom of the monitor and waits patiently
until you need it. That way it's close at hand, but still out of the way of a busy Desktop.

Turning a Folder into a Pop-up
1. Open your Project folder and change the view back to Icons.

a small tab af"
the bottom of the Windows
Desktop. That's basically the
same thing that happens

Grephlco

Art boardo

when you choose
View> Windows As Pop-ups

.

on your Macintosh.

"

2. Hold down the Control key, and click inside the window (Control-click). A pop-up
menu will appear. Slide your cursor down to View, then down to As Pop-up Window.

Help
New folder
ao~eWlndow

Get Info
•
Add To favorites
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3. The window will be resized and positioned in the lower left corner of your monitor.

4. As you can see, the Title bar is no longer in the center of the window. Indeed, the
folder isn't even displaying a conventional window anymore. The Title bar is on a tab
at the left side of the pop-up window. Click on it.

5. Click on it again. Double-click the Graphics folder and turn it into a pop-up window
by Control-clicking and sliding down to As Pop-up Window. Now you'll have two
tabs on the bottom of your monitor.

6. Experiment with your viewing options. You can, for example, view the contents of
one folder as icons, another as a list, and another as buttons.

View Options for Windows
The Mac OS provides you with many ways to customize your working environment. Almost
every aspect of the Finder and the Desktop can be adjusted in some manner. This is true for
applications as well. Developers are constantly working to make their software more
adaptable to the many different ways that people like to work.
There are a number of options available to you relative to the way windows look and act on
your Macintosh.

Using View Options
1.

Open the Graphics folder, if it's not already open. Change back to icon view.
p

l(l Graphics

Bil

l!IJl!!I

3 ltllms, 796.9 MB wallable

~

Iii;!

Benana Boot.TIF

Ga rdenlRQ Panal.TIF

•

A

Berries Plcture.llf

~

4.1

.i~ ~
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2. Control-click inside the window and select View Options.

a

Banana Boot.Tlf

•

Gardonlno Penel.Tlf

Berries Plcture.Tlf

Help
New Folder
OoseWlndow
Get Info
Add To rovorttes

3. Look at the dialog box for a moment. You will notice three buttons. The center
button, Always snap to grid, is probably checked. Click the None button.
Vlewtjptlons ~

~

Grephtcs

~ Ylevs: Custom

Since we work with dozens

lconVlewOptlons --c=:==,..,,,-;::-o--,
Icon Arr• ... - •I:

ofwriters, editors, authors,

e'\ne

designers, illustrators, and

:J3

others, we recognize that

~ A11o1ayssntp to orld

:: 0

~porrenC)ed·l- ~-,-:.me----~
;I

there are as many ways to
set up your system as there
Icon Size:

are ways to dress. What
works for one person

I Set to Stor<lerlfVIOlol0 1 lbe optlono from Preferenceo

doesn't necessarily work for

I Concel I n

another. Snapping your
icons and files to grids is a
great example ofsome-

OK

1

4. Look at the upper corner of the Graphics folder. When the grid is off, the corner is
blank, and when the grid is on, the corner displays a small grid.

thing that one person hates

El•

and another person loves. If
you only have a few things

~

in your folder, then having
the grid turned on isn't as
critical as it is when there
are dozens or hundreds of
files. If, in fact, you do have
to work with very full
folders, then viewing the
folders contents as a list is
far more effective than
using icons or buttons.
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Benene Boet.TI f

System Folder

Appl icetlons

5. With the grid off, and the view set to icons, move the files around in the Graphics
folder until they're not neatly arranged.

..

~
Banono Boat.TIF

.

13 Graphics

,,,, t

D

*™HS

·-

3 ll<mo, 760.9 MBevolloble

~rr lu

l!ll'.!I

Pic tu re.Tl r

Gordenl119 Pe nel.Tlf

I

~1

6. You can place icons anywhere in the window if the grid is off. Control-click in the
window again, choose View Options, and turn the grid back on. Move the icons
around again. You will find that they snap to an invisible grid that keeps them from
overlapping each other vertically. You can still overlap them horizontally, but they
align quite neatly.

- - ; 1Cl Graphics
,_ ·-· 1J ..=.!: 3 ltemo, 760.9 MB ovalloble

0 p·-

Rf

·=

~~

~

•

~
BeMM

WMM'MM''

Boot.Tlf

m

Ga~nl l"lll

Panel.Tlf

~

I•

'..L

Notice that when you select
a radio button, the previ-

~

7. You can choose to arrange icons by size, file type, date created, or labels (which we'll
discuss in a moment). Access the View Options again by Control-clicking in the
window. Select View by Size and click OK.

ously active button turns off.
This is how old radios
worked; ifyou pushed one

Icon View Options

button in, another popped

Icon llrrHgetMnt:

~~-~~--,

0Hone

out. That's why these are

lif 0

called "Radio buttons." You

••
••

Alvoy.,nep to 9rld

will encounter them often
while working on your
Macintosh - they're a very
common component of the
Interface.

Icon

SI~•:

C)

( Sot to Stelldord Vlwi

J l);jl o ptiom from Prefortnte$

I Cancel I I!

OK

I
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8. Look at the Graphics folder; the ico ns have been rearranged according to the size of
the file. Yo u can see that the Gardening Panel.Tl F icon is the largest, and the Banana Boat Logo.Tl F the smallest. Berries Picture.Tl F, which was and remains in
the middle, was larger than Banana Boat.Tl F and smaller than Gardening
Panel.TIF.

ll
u
'"

When you look at a pop-up
menu, such as the one that

'f

.,

;

.

--

1U1

ri:i Graphics

•

m;;

Gudenlng Panel.Tlf

1!!11!!1

~

3 lterN. 780.'9 MB evelleble

~

Ber r lu Plcture.Tl r

comes up when you choose

~

Benona Boel.Tlf

View Optionsyou will see a
small black dot, called a
"bullet'' to the right of the
~

selected object.
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9. You can experiment a bit with View Options to see the effect that changes have on the
way files and folders are displayed within the window. When you're done, close all
your folders.

Finder Preferences
There are other chan ges you can make to the way folders are displayed, which you can do in
the Finder Preference dialog box. The Finder Preferences are broken into three catego ries:
General, Views, an d Labels.

Working with Finder Preferences
1. Select Edit> Preferences fro m the m enu bar. A dialog box will appear. At the top of the
window you will see three tabs - just like tabs in a book or a stack of index cards.
The General tab will pro bably be selected.

D Simple Finder
Provldeo only tile e»entlal features end comma~
------~

Gil Spri ng-loaded folders

You can el~• press the Spece bar to spring open I mmedletely.
Deley before opening
I

I

Short

Metllum

Grid Sp11cln o: Cl Cl Cl Cl

·'

Long

e Tight ( mor e Items)

Cl Cl Cl 0

W ide

(neeter arrangement)

• Simple Finder turns off many of the ad van ced features of the Finder. Yo u
sho uld leave this turned off.
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• Spring-loaded folders are something that you've had some experience with.
You can adjust the speed at which folders respond when click-holding an item
over them. Simply move the slider left (to make them slower) or right (to make
them faster). Note that you can make one open instantly if you press the space
bar while you're click-holding.
• Grid Spacing determines how close you can put files together when you have a
folder's Always snap to grid feature turned on. Remember when we could layer
files horizontally but not vertically? Turn on Wide (neater appearance) and files
will stay away from each other horizontally as well. The grid is bigger and files
stay further apart.

The "Relative Date" button
determines if the Finder
displays dates as "today''
and ''yesterday" or as their
exact dates. When relative

2. In the lower left hand corner of the dialog box, you will notice a small Help icon - a
question mark inside a circle on a button. Click it.

dates are turned on, the
display shows familiar
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3. This is an example of context sensitive help; clicking the Help button from within the
General preferences window accessed specific topics from the Mac Help system that
pertain specifically to what you're working on at the moment. You can look at some
of the responses, and when you're done, close the window.
4. Click on the Views tab. The Views preference window will appear.
0_£ ·'··

Preferences

l[Genera~
r Standard View Options for.

liif Uoe relellvo dale
0 C1lcul1to folder sizes
Ice• Size:

~

G

~

~

~

~
Q

~

.·~

..

B

(ust
1 ~1--,
s"""' Col umns:
Ga Dete Modl ned
0 DetoCreated
!if Slzo
!if Kind
0 Le bel
lif C.mmonta
Oversl on

Changes ere epplled to ell foldera that ore set to Stonderd
vlN•. Other folden ore not offoc:ted.

-
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5. Take a moment to familiarize yourself with the Views preferences. Set Standard View
Options lets you set the default, or standard, settings for viewing the contents of a
folder as icons, a list, or as buttons. Take some time to experiment with the settings in
this dialog box and when you're done, click the Labels tab.

-

The "Icon Sizes" button
effects the size oficons
shown in List view:

!iiiin Pr09res•
!ii~lCoo
_I~~~~~~~

Small

-

IPenonal

l l J IProjecl I
lllJIProJecl2

Medium

6. You can change any of these labels by clicking in the box containing the name of the
label. Try it.
fl!!

-lReally lmport•nl
liiiJ lReelly REALLY lmportenl

Large

!RllHot loo lmporlut

(lillPer.. ,.,I
[iillt1err1.. n Project
•

lw11eon Project

7. You can even change the colors associated with labels. Click on the first box. It's
probably the orange one. The Color Picker is displayed.
COior Pieter

~

Color for "Important"
12D°

CMYK Plcktr

60°

D

•

180°

()<

Hue Angle:

12.... 1·

Saturation:

@J"·
[§],..

11..SPlclctr

II

~.

0

!()

!

Value:
Cancel
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8. You can move the cursor around inside the circle and pick a color, or click on the
Crayons in the left column and choose from a box of crayons.
Color Picker

Original:~

Color for " lniportant"

~v. ~

CMYK Pl<ktr

The Apple Color Picker is a

Nome:
Evening Blue-lsh

very powerful tool, and one
that you will work with
more in a later chapter. It
offers the professional
designer, photographer,

tt.S Plcktr

[]
HSY Plcktr

videographer, and graphic
artist incredible control over
colors in their work. It's also
- as is the case with almost
everything Apple develops
- unique looking, fun, and
interesting to work with.

9. Pick one you like and click the OK button to put the Color Picker away.
10. Open the Project folder, then open the Graphics folder, and select the Berries
Picture.TIF file.
11. Choose File> Label from the menu bar. You will see your personalized labels in the list,
along with your custom color. Select a label and assign it to the folder. Ifyou used our
label names, select Harrison Project.
Special

..

Help

MN
MO

MP
Move To Trash
OoseWlndow

M<lD
MW

Get Info
Duplicate
Make Alias
Add To Favorites
Put Away
Encrypt

MD
XM

i!:V

•

11§41

.,.,,

Btnana lloet.Tl f
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12. Open the Finder preferences again, and go to the Views tab. Set the name an d label as
the only columns displayed in View> As List.

General
Standa rd View Options for:

I

Cl Uoc rclellve date
D Colc ule lo folder i lzea

I Ust

I ~ j.

Shov Col umu:
0 Oete Modlfleo
0 Oete Creoted

0Slze

Remember that the Finder

Icon Size:

QKlnd

0t.ebel
0Commen1'
0Yers1on

preferences are considered
the standard, or default,
preferences. Any window
can have its own settings

'i:iil CMl'll;tureapplled to ell folders thet eruet to Stellder d
~ vlevs. Other foldt" ere not effected

and views, but can be put
back to the standard

the bottom of the View

13. Click on your Graphics folder, and Command-click to change the view to As List.
Notice that the changes you made in the Finder preferences dialog box did not yet
take effect. Click the Standard Views button. This matches the current window's
preferences to those that you set in the Finder preferences.

Options dialog box.

14. Look at the window.

settings by clicking the
Standard Settings button at

me:

15. Label the other two files.

l.i Benona Boet.Tlf
•

Berr1..1 Plctur~.T I ~

•!•

.

Reell •.•runt

Later in the course when we
explore the extremely
powerful search capabilities
built into the Mac OS, you'll
see even more uses for the

16. You'll notice that there isn't enough room in the column to display the full labels.
Move your cursor until it's exactly over the right border of the Labels column, and a
double arrow appears. D rag the column to the right to make it wider.

Labels.
3 Items, 780.8 MB<Welltble

Lobel

lill Be no no Boat.Tl r

Rea lly REA LLY Important

•

Horrlson Pn>Ject
Really lmportent

Berri.. Plcture.Tlf

• ti
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17. Next, click on the Label column over the file list, and the list will sort by labels. You
can do this with any column by simply clicking on it. This is yet another way to
control how your files and folders appear.
~Graphics

tr
·~r

lill Banen• Boet.TIF
•
•

Btrr\n Picture.Tl f
Gardenlno Penel .Tl f

1!!fEI

3 lttlM, 780.8 MB Wtllablt

[ ~:I

r=

A

::D.."._

Reelly REALLY Important
Harrison Project

A

Really Importent

I-;'

4.l

_l_•

~

18. When you' re done here, go back to the Finder preferences and set the List-view
The dialog boxes we've
been working with during

settings back to where they were before. You might want to leave the Label selection
active.

this chapter utilize many of
Apple'scommon interface

General

components. When you're
adjusting the columns that
display in List view, you're

Ea Use rel111ve dote

SllevCela•u:

0

Ea Dote Modified
Ea Dote Creeled

Celculote folder sizes

using Check boxes, which
display a check when active

li!tSlze
liJKlnd
li!tL•bel

Icon Size:

0 Commento

and none when they're

0Ven ion

inactive. This is a common
device when you're able to
select several options from a

IA! Chan<J1$ are applied to all folders that art set to st.ndard
1!i!J vi...,.. Other folders ere not effected.

list. When only one option
can be selected at a time,
you'll see Radio buttons,

19. Put this window away, and close all your folders. Select the Project folder, and
choose File>Get Info>General.
Special

such as the ones used to

88N
880

determine the icon size

MP

when you're viewing a list.
Oose Window
l~bel

Duplicate
Make Alias
Alld 1"o ravorftes
Put Away

88<i!I
88W
._
880 r.,.-.::::.;;;c:!.:..------,~r-1r.i1
88M
Documents
App11..tton>
ICV

Encrypt
And-

88F

Search lntemeL. 8!1H
ShowOrlgllWll
MR

.
'
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20. You will see the General Information window for the folder. From here you can add
comments in the bottom of the dialog box, or set a label for the folder. You can do the
same with document files.

You can access information
about a file or folder by
selecting it and pressing
Command-I (for Information).

21. Enter a comment if you like. This column can be turned on in the As List view, so you
can keep short notes to yourself and display them in the List views.
22. When you're done, dose the dialog box.

Using the Trash
We know people who could best be described as computer-age pack rats. They have every
file, folder, icon, picture, game, saved game, email, and downloaded file they ever had. At
some point they buy more hard disks, hook them up, and continue building their electronic
equivalent ofldaho's The World's Largest Ball ofTwinemuseum.
In the real world, there will be times when you want to throw something away. It might be a
file that's been superceded by another, it might be something you just don't need anymore,
or it might be the game that you paid $60 for and can't make it out of the very first room of
the 12,000-room dungeon.
At times like this, it's fortunate that you have the Trash. The Trash is your friend. It lets you
junk, trash, rip-up, discard, and otherwise get rid of stuff you don't want anymore. It also
lets you discard important stuff that you need really badly (fret not, you can always dig
around in there and find it - at least until the garbage truck comes, so to speak).

Throwing Things Away
1. Open your Project folder. Make sure the view is set As Icons and As a Window. Make

three new folders inside. Call them "Junk", "Misc.,,, and "Stupid Games".

52 CHAPTER 2/FILES AND FOLDERS

= 1!!18:
6

ll!'ms, 760.5118 evallable

Cl.

Crap hie>

Art boarcb

ti}, ~ ~
Mi~c .

Junk

Stupid Gom<s

2. Make sure the view is set As Icons and As a Window. If necessary, resize the window
so you can see the contents, and can also see the three new folders you just made.
3. Drag the Junk folder to the Trash icon. Let it go.

4. As soon as you drop the folder in the Trash, the icon changes, so that it looks just like
our garbage can does - filled up and overflowing with junk.

5. You can also throw something into the Trash by using the Control-dick method.
Position your cursor over the Misc. folder. Control-click the mouse. Slide down until
you highlight Move to Trash. Let go of the mouse button. The folder will fly away,
landing directly into the Trash icon.

-· Cl ProJectrolder
· 1

!Flndsimitar Flies
Index selectlonAtt11ch 11 Folder ActlonMaglc Menu"'
~

6.

Oh, no! That Misc. folder contained the latest revision of your next great novel! Don't
fret. Double-click the Trash icon:
nlt[1 .;

~W
}Ea

~
Junk

ff

.,-•l ti):Tr11$h E E 3E!l8
Zltems

~

Cl.

~

M isc.

~
I• ~
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7. That's right, you can simply drag either of these folders (or, by digging into them,
something inside one of the folders) back to the land of the living. Unless...
8. Control-click the Trash icon. Take a look at the pop-up menu that appears.
Help

Open

Empty Trash•.
Ge~

Info

Ifyou have something in

label

the Trash, and decide you

MllkeAllllS
Add To Favorites

don't want to throw it away

Index selecUon_

'

after all, you can open the
Trash, highlight the file or
folder, and select Put Away
from the File menu or press
Command-Y.

Magic Menu"'

._

9. Select Empty Trash. The can is empty. At this point, you would need special utility
programs made especially for situations where you did throw away something critical.
They can usually recover trashed files, at least for a while after you threw them away
and emptied the trash. These utilities are not included with the Macintosh, but have
to be purchased from a third party.
10. There's another way to empty the trash, and that's from the regular menu bar at the
top of the Desktop. Drag the Stupid Games folder to the Trash, and empty the Trash
from the Special menu. Good riddance to bad rubbish.
DI
Eject

Help

88£

Er11se ot~lc...

Sleep

Restart
Shut Down

In general, you should be very careful before you empty the Trash. It can easily destroy
something you didn't mean to discard, because once you choose empty, it's pretty much
over. You can, however, set the Trash to ask you just one more time if you' re sure you want
it emptied.

Turning on the Trash Warning
1. Select the Trash icon and press Command-I for Info.
Cl

ii

Trash Info ·

-

Trash

w..n: on thtdeattop
C1111tute: Tht Trash ta empty.

tWlnM: Mon, Nov 24, 1997' t 0:23 AM

Owora Mfen
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3. See the small box in the lower left corner, in front of the words "Warn before emptying"? Click once inside it. A check mark will appear in the box, indicating that the
option is active. This is a very common interface item, and it's called a Check box. You
will see them from time to time when presented with a choice of something being
turned on or off (as is the case with this warning option).
4. Create two more junk folders in the Project folder window, so you have something to
throw into the trash. Drag them there, Control-click the Trash icon and choose
Empty Trash. You'll see the warning message you just turned on.
:=; ;

-tiiit

The Trash contains 4 Items, which use zero K
of lllslc space.Are you sure you want to
remove these Items pennanentty7

I cancel I ij,

This Bomb icon is our way of

OK

I

When first learning how to use your system, it's probably a good idea to keep this warning
active. Once you're an experienced user, you can turn it off, so that if you want to throw
something away- no matter how critical it might be -you can do it instantly without
any chance of recovery.

gettingyourattention. You
should take heed whenever
it appears - we're usually
trying to tell you something
important. We aren't
threatening that ifyou

Recovering Deleted Files
In order to recover files once you've emptied the trash, you will need a special utility. Here is
an example of Norton Utilities, one of the most popular set of utility programs on the
market today- both for the Macintosh as well as Windows-based systems. The program
gives you a wide selection of services, among them the ability to (hopefully) recover
unintentionally deleted files.

ignore our warnings, your

:J!I:'

__ lf!if±

computer will blow up, but

customized search-

J!ml

it might as well for all the
problems your operating
system and software might
give you ifyou don't pay
attention.
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Icons
Throughout this chapter you've been working with files and folders, using their icons. Icons
are yet another cornerstone of the Mac OS. As we move on in the course, you will begin to
see other types of icons in addition to the ones you've been looking at so far. You can see
that picture files, such as Berries Picture.TIF, have small pictures for their icons. Each
program on the Macintosh (and on Windows for that matter) has its own unique set of
icons. This table should help.

Commonly used icons on the Macintosh

-..

Icon

AppllcatloM

~Folder

~

I Type

Standard
Folder
System
Folder

•

M:lbe

Ii

•
•
Ore~.TIF

!]

Adobe Ser1f AdobeSsrcMM

This folder contains components
of the MacOS.
Hard disk icons look like this.
Some systems have more than one.

CD-ROM

CDs containing music, applications,
or data appear on your desktop.

Application

Each application has a unique icon .
This one is for Adobe Illustrator.

llllmrator

MoUle.eps

that you will see on your Macintosh.

Hard Disk

tbrdl>isk

II

Description
IThese
are the most common icons

File
(Illustrator EPS)

File
(Photoshop)

Font

When you create a file, the program
applies its own unique icon.
Some icons are actually small
thumbnail versions of the file.
Many fonts come in two parts, with
two icons. See Fonts for more info.

As you can see from this table, the look of an icon shows you what the icon represents. An
icon that looks like a folder is just that - a container in which other folders or files may be
located. An application icon is usually a small picture that (hopefully) is related to the type
of tool the program provides; and finally, each application has specific types of icons that it
uses when you save a file.

Chapter Summary
In Chapter 2 you learned about files and folders; how to create and manage folders, how to
move files in and out of folders, and how to delete items you no longer need. Also, you've
experienced the different ways that you can view the contents of your folders, including
lists, icons, buttons, and pop-ups. You learned about icons, and how they help you to
identify what a file contains, or what application was used to create it.
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Using Programs
So far we've been exploring some of the fundamental ways the Macintosh works - in
particular how you can create and manage folders. Folders are the basic building blocks of
file organization and structure on the Mac. In this chapter, we're going to use application
software - programs that provide functionality to the system.
In all likelihood, there are
many different programs
installed on the computer
you're working with. In this
section of the book, we're
going to make use ofa
simple word processing

Programs are tools that allow you to perform specific tasks, such as writing, drawing,
working on images, laying out pages, putting together video footage, creating animations,
and accounting for all the money that you're going to make. When you use a program to
create something- whatever it might be - the resulting information is stored in a file,
and saved somewhere. Somewhere might be your own internal Hard disk, a centralized
Hard disk on a network, or on a removable media, such as a floppy disk or removable Hard
disk.

program that comes with

Working with Files

your Macintosh. Thatway,

So far, we've explored the Desktop, menu bars, and folders. Now, it's time to talk about
data files.

we can be sure that the
application is available to
you. Thenameofthe
program that we'll be using
isSimpleText.

A file is something that was created within an application and contains data. That data
might be words, pictures, sounds, combinations of items, tables, numbers - in short,
anything that can be generated from software on your computer. There are dozens and
dozens of different types of files that you will encounter as a Macintosh user - particularly
in the graphic arts, where the type of file you send out for production is especially important. (Ifyou send out a disk with a project saved as the wrong file type, you will get it back
with a sticky note containing a not-very-nice message to fix and resend the file. ) For now,
it's sufficient for you to know that files contain data.

Examining a File
1. Open the Project folder, and then open the Copy Files folder.

f'l- S ~](Copy mes~
[:I:

2 Items, 80011 ~ovelleble

B

Berrles.txt

S.mple file
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~Stetlonary)

f!:.

2. These files were created with a very simple application called Simple Text, which came
with your Macintosh (specifically, it's included with the operating system supplied
with your Macintosh). Double-dick the called Sample File # 1. This action of
double-clicking on a file icon launches the SimpleText application and opens your file
at the same time.

" ~

A "stationary document" is

one that is specially locked
bytheMacintosh. You can
tell a stationary document
by its icon.

EJ

~·

Ale
. §£ _, ;:r

Edit Font Size Style Sound Help
'--:~.::~ ....~ . ;.":,J'"1!;lil'untltl~ I _

~

e'.18·

:JF~

~

!What is a File?

I

A file io a collection of text, tables, piclur1's, sounds, video, or other information that you h•ve ellher
creoted yourself, or r1'ceived from somewhere else. A file •ppean; on your desktop as an icon, orsme.11
picture.
In some cases, you might buy lnformotion from other bplo, os is the case when }'>U purchase ~es.
clip art. sounds, or !nten.ctive produ<ls, suc:h as educ..t onal CO..
In this Ago.inst The Clock course, you will !Mm how to creole files, copy them, throw them away, and
orgo.nlze them in folders.

Sample File "1

f;-

A stationary file opens
automatically into an
untitled window, protecting
the original from change.
That way, when you open
one and make changes, if
you want to save it you're
forced to assign a different
name than the original.
SimpleText, as we/las
certain other applications,
allows you the option of
saving a file as a stationary
document. Another way is
to change the document's

attributes under the Get

~

3. You'll notice that the document itself is in a window, which acts in the same way as a
folder window. The only difference is that this window contains data - not files and
folders. You can size the window, move it around the Desktop, or close it just like a
folder window.
4. Take a moment to look at the options on the Menu bar. Notice that they have
changed from the ones in the Finder menu bar. The commands you now see are
specific to this particular word processing program. This is an example of contextsensitive menus - one of the hallmarks of the Mac OS. If it helps, go to the Finder
(by clicking anywhere on the Desktop), and turn on Balloon Help. Click back on the
document to activate SimpleText and move the cursor to the Edit menu.
,.. ~

Ale ~'!!!_ Font Size Style Sound

:Q
::l;
What is mt'""'"
A file I. . coll!
yourself, or"'

~

U.. this......, to undo yo<.r 1" 1

;:~:: ~.t'c~~;·;,~~.

oonttnts of ai doo\mtnt,

Help

~ u n titled !

j1ds. video. or other information thU you htve either creoted
le appears on your desktop as e.n icon, or small picture.

~to

In some <Mes. show wh•t's on tho Cll>b<>M'<.
~other people, o.s ls the cose when you purch•se games, clip art,
sounds,or int.1.,.__ _ _ _ _ _ __,..Jono!CO..
In this Against The Clock course, you wlll leam how to crette files, copy them, throw them aw•y. and organize
them In folders.

Info command, which we

discussed in the last
Chapter.

5. When you're done looking at the file and examining the menus, you can close it by
selecting Close from the File menu, clicking once in the Close box (at the upper left
corner of the window), or by pressing Command-W.

Running Multiple Applications
Using SimpleText isn't the first time you've worked with an application. To the contrary,
every time you turn on your Macintosh you work with the Finder, which is an application
program itself. Now that we've started working with SimpleText, you actually have two
different programs running- the Finder and SimpleText.
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Managing Multiple Applications
l. Look up in the upper right hand corner of your Desktop. There is a small icon there.
Click on it and hold it down for a m om ent. You will see that the names of the two
programs are displayed on your monitor. (We had more than two programs running
when we made this screen shot).
ll~IAM

f

llde SlmpleText
llde others
Show All

I f?.I Adobe•

PageMokere 6.5

SI Adobe• Photoshope 5.5

CJ Finder

!QI Launcher

Notice that there are three
ways to close a file: one is to
choose File>Close from the

.1

SlmpleText

2. IfSimpleText is selected, you will see the Menu bar for that program.

Menu bar; second is clicking
in the Close box in the upper
left hand corner of the

3. Pick the Finder in the list, and it becomes active.

window; and third is
Command-W. Theseare

Hide SlmpleText
Hide Others
Show All

consistent throughout the

Ea Adobee PageMokere 6.5

Macintosh interface, and

II Adobee l!hotoshope 5.5

common in almost all Mac
Launcher
SimpleText

software.
The primary reason that
Macintosh software is so
consistent in the way it
operates dates back to the

4. Notice that when you select one program or the other, the icon in the corner changes
to reflect which program is running. If you want, you can show the name of the
program rather than just the icon. Grab the small dotted bar between the time and
the program icon. Drag it to the left until the program's entire name shows.

early BO's, when Steve Jobs
directed the development of
the machine and the OS. He
insisted that all developers
adhere to interface
guidelines developed at
Apple's Cupertino office.

5. While you're up there, notice that clicking on the date displays the time, and clicking
on the time displays the date.
6. There's a very neat trick that you can do with this Application Picker, which is to
create what's called an Applicatio n palette. Click on the menu and drag down until
you actually pull it right off the bar.

These instructions, which
defined how dialog boxes
looked, how buttons
worked, the position of
menu options, and
thousandsofother details,
are known as the Apple
Developer's Guidelines.
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4:28PM ~
llde Finder
fide Others

7. Once you've grabbed the menu and dragged it onto your Desktop, simply drop it. It
becomes a stand-alone object known as a palette This feature of dragging menus off
of the bar is known as tear-offs.

Although we tried to supply
you with a good collection of
hands-on activities, don't be
afraid to experiment. We do
suggest that you make a
copy ofany files you want to
experiment with, so that,
when you do try to follow
one ofthese exercises, the
machine acts the way we
sayitshould. Youcancopy
any file by holding down the
Option key and dragging it
to another spot in the folder
or into another one.

tr

8. Once you've torn off the palette, you can select the program you want to run simply
by choosing it from the list. If you want to get rid of the palette, use the Close box in
the upper left hand corner.
As you can see from the screen shot of our Desktop, when you have a number of programs
running at the same time, Application Picker can save you time and energy in switching
back and forth between programs.

Creating Files
With few exceptions, all of your activities on your Macintosh will result in the creation of
files. Each application creates its own type of file, and under normal circumstances, these
files are directly connected to the application that you used to create them. This is why
double-clicking the file in the last exercise started up the SimpleText program (another
word for starting up an application is launching).

Creating Your First File
1. First make sure that SimpleText is active. Choose New from the File menu.

crose·
save

aeo
aew
aes

S4VeAsP11geSetu11Print_
KP
Pnnt One Copy

2. A new document will appear. If you look in the Title bar, you will see that it's called
Untitled. Enter the following copy. To make blank lines, just hit the Enter or Return key.
Ifyou hold down the Option

My First File

key when you double-click

Dear Emperor Com modus.

an icon to launch the

matically close when the

I find that working conditions here at the Colliseum are
even worse then they were in the forests of Germania.
Please accept my request for two weeks vacation to the
Baltic sea.

application starts up. That

Sincerely

program that created it, the
folder it was in will auto-

way when you close the file,

General Maximus

the folder it was in will
already be closed.

3. Keep the file Open for the next exercise.
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Saving a File
At this point, you've entered some text into the file- but the file exists only in RAM memory,
which is only temporary. It doesn't reside in a folder somewhere on your Hard disk.
Saving files is obviously a very important function, and that's what we're going to do right
now. We just thought it would help if we took a moment and mentioned that when you
save a file, you should always think about where you're going to save it.
Many popular graphics
applicationsexist for the
Macintosh - indeed they
were originally developed
specifically for and on
Macintosh systems. Adobe

if

Systems, in particular,
created some of
theearliest
and most
powerful

'

Whenever you're working in an application, the Macintosh is keeping track of what folder
the program was "looking" in the last time you saved something. If you haven't saved
something recently, it's likely that the program will save the file in the same folder that the
program is stored in.
That's usually the last place you want to save a file. Normally you want to save your files
either inside a specific folder (related to the thing you're working on), or directly on the
Desktop. Some people choose to save their files on the Desktop while they're working, and
drag them into the appropriate folder before they quit for the day.

Saving a file

·

graphics

1. Choose Save from the File menu.
Edit

tools ever seen on desktop

Font Size
81lN
880

systems. Programs like

Style

Sound Help
untit(ed 2 --:::-:---

Adobe Illustrator,
Photoshop, and PageMaker
(which is the program we

fore

Page Setup _
Print_.
agp
Print one Copy

Si ne

Quit

I f in

use to layout the ATC
courseware), are examples.
Other programs include
QuarkXPress, which is the
graphics industry's most

lions here at the Coliseum are even
ase accept my request for two week

88Q

2. When you do, you will see something called the Save dialog box. Almost every program
you will ever use has a Save dialog box, and, although some have features that others
don't (depending on the exact application), they all work exactly the same way.

popular page layout
package. QuarkXPresswas
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originally a Macintosh word
The current drive. If you have
more than one, clicking will
sh uffle through them one at a time. The name
of the current drive appears above the button.

processing program called
WordJuggler.

This pop-up menu shows you the
hiearchy of the current folder.

r-::--l~G~~=n~11=
••~.~l--jL:::--:-i

Takes you to the Desktop. So does
usin g Command-D from the keyboard.

)OM'n"Urt

Contents of the current
folder.

~litW'fllf''I (\t•UO""'V)

'-='-'>L"'T_ _
Create

Q!!~ltt--

a new folder •on the fly."

Click here to cancel t he operation, or
p ress the esc (Escape) key.

\t.n U1h clGCurnent•':

l• lllt<l

Enter the file name you wi sh to
use for this document.

62

CHAPTER 3/USI NG PROG RAMS

Com plete the Save operation. Pressi ng
Ret urn or Enter will select this option.
Choose between saving
a regular fil e or a stationary
document (template).

3. By clicking the Up/Down arrows on the right side of the pop-up menu, doubleclicking the names of folders, or by clicking a folder then the Open button, you can
explore , or navigate through your Hard disk until you find the folder where you
want to save your file. Alternatively, you can choose to click the Desktop button and
save the file there. Pressing Command-D will automatically take you to the Desktop
as well.
You might have noticed
that when we show screen
images ofthe our Finder,
there is a small icon in the
menu bar that's not likely
on the system you're

4. Type the name of your file, "Vacation Request.TIP" in the field reserved for the file's
name. Click the Save button and save the file inside the Copy Files folder, which is
inside the Project folder that you created earlier.
I ct Copy Ales H~ I

l'l"'t""'Berries.bet
:"---====:=::::::::====-----r-i
H

=

Hard Drive I

~

aect

1:1 Sample fil e • 1(Stationary)

0es1ctop

I Newl):J

working on. It looks like this:

I

'------~----~~~
This icon belongs to a
program called "Stuffit" that
allows us to compress files.
This particular component

I
I

Save this document as:

Cancel

11

._lv_ac_a_uo_n_Re_q_u_est_._TI_~,__ ___.I e

El

)

savf:l
Q

a

5. After you click the Save button, the file will be written onto your Hard disk, safe from
(almost) anything.

of theprogram is called a
Magic Menu, and let's us
Stuff files by selecting them
on the Desktop and
pressing Command-S.
In the graphics

6. Once you've saved the file, choose Close from the File menu. The file will be closed,
but the program will continue to run while we work on something else.

Renaming Files
There will be occasions when you'll need to change the name of one or more files. You can
do this directly from the Desktop. It works the same way as changing the name of a folder.

the~

industry,
ability to
compress

•'

Changing the Name of a File

files is quite

1. Open your Project folder, then open the Copy Files folder.

important. Although disk

2. Highlight the file you just created.

space is important, it's quite
inexpensive these days. The

~CoP\lflles!m' l!!JB
~ 3 lterno, 900MB1YOlteble

real need for compression
comes when you have to
move large files around the
Internet, or across networks.
Then the reduction is size
that comes with compres-

El
~Stetlonory)

Berrlu.txt

Sample flit

wmlea•

sion equates to increased
speed when transmitting
files. Smaller is naturally
faster.
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3. Put the cursor inside the name, highlight just the word "Request" and type the word
"Demand".

a __
ffi

CopYFlles ~ e
3 Item, 900 M8 Miiiabie

EJ

EJ

6err1...txt

Serrl ...txt

El

Semple Fil• .. , (Stationary)

Sempla rile

~Stetlonary)

5. Hit Return or click anywhere else on the Desktop and the file will be renamed.

Copying Files
There are numerous cases where you will need to make copies of files. A very simple and
basic example would be where you wanted to make a backup copy of a file onto a floppy, or
into another folder somewhere on your system.
You can make copies quite easily on the Macintosh. There are several ways to accomplish
this basic function.

Making a Copy of a File
l. Click once on the file you just renamed Uacation Demand.TIU.

2. While the file is selected (highlighted), go to the File menu and choose Duplicate.
Ifyou check "Locked" in a
file's Info dialog, the file can't
be thrown away, at least not
so easily. Try locking one of

Move To Trash
ao;1eWind&w .

the sample files, dragging it

Get Info
Lnbel

to the Trash, and then

Make Alfiss' ,

emptying the Trash. You'll
see a dialog box appear.
u

1fh•fru11c.n..c11t..-.~,Mr•" .....
lll•ttuu•1t(.U.:Ulll•fl'6H,,.,..

IDtbe.1•'*'4l•*b:lllhM-'< .............

,,......

••_.tty..,..t )"O •<'*•e~

As the message says, you
can choose to delete a
locked file. Ifyou do get this
warning, it's usually a good
idea to check to see exactly
what you threw away.
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I

Add To Favorites

Put/>.WllY

' MM

acv

El

Berrl ...txt

Encrypt
~
t--Fln
_d___---~M
,.;.F-;--i lie ~Stationary)
Search Internet.. MH
Show ortglnal
~R

3. The file will be duplicated and named Uacation Demand.THTcopy.

El

Berrleuxt

Semple Filo

~Stotlonory)

~

Vocotion Demend.txt copy

4. Drag the copy to the Trash (and empty it if you like).
5. Click on the Vacation Demand.TIP file again. This time we're going to copy it to the
Desktop. Hold down the Option key and drag the file out of the folder and drop it on
the Desktop.
6. You will see a graphic appear. It's called a Progress bar.

Notice that the visual we used here shows almost 300 files being copied. We used a
large folder to make this screen image so we would have time to capture and discuss
the function of the Progress bar. With a tiny file like the one you're working with, the
bar appears and disappears very quickly.

This graphic is called a
Progressbar,andactsasa
time indicator for slower
processes. The faster your
computer, the faster the bar
moves. That's why people
always want the fastest,
biggest, baddest machine
on the block- so that they
won't have to look at these
bars too much.

Ifyou're copying a large file, or group of files, you can click the arrow to the left of the
Time remaining text (below bar) and the window will expand to display additional
information about the copying that's in progress.
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7. Once you've dragged the file to the Desktop, there will be two different copies of the
file; one inside the folder (the original document), and another on the Desktop.
(] ~

l::j

CopyRles ~ ~

3 ltemo, 899.2 MB Miiiabie

6
~Sletionery)

Be rr l...1xt

You can also make a copy of

Semple file

a file or folder by selecting it

G1't

and pressing Command-D,

0

Voe.lion Demond.bet

for Duplicate. This command works in many other
programs as we/1particularly drawing
programs, where copying
objects is a very common
task while developing a
drawing. Option-dragging,
which makes a copy ofa file
on the Mac Desktop also
copies images in Photoshop
and drawing elements in
Adobe Illustrator.

8. You can delete Vacation Demand.TXT.copy from your Desktop.

Working with Text
When the Macintosh came out, it was the first popular, mass-produced computer that gave
its users the ability to change typefaces. It was that feature, more than any other - including icons, the mouse, and other innovations- that led to the desktop-publishing revolution. The way the Macintosh handled text (also called fonts) and graphics brought real
computer power to designers, publishers, artists, and other people in the graphics industry.
While this isn't a course on graphic design (we have more than 25 such books in the Against
The Clock library), it is important that you know the basics of formatting text elements in a
document.

Text Formatting
Almost all programs allow you the opportunity to select text, and apply characteristics to
that te.>..1:. For example, there's italics, which you've seen throughout this book (and many
others); there's also bold text, which is darker and heavier than the text around it. And let's
not forget ou.fr.e text, Shadow te.>..1:, superscript (x3) and subscript (H20), underlined,
strikethrough, and something called SMALL CAPS. Naturally some programs give you more
flexibility than others; spreadsheet and database programs give you the ability to format
text elements with these standard styles.
If, on the other hand, you find yourself working with sophisticated illustration, imaging,
and layout applications, you can achieve stunning results using type.
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Applications, such as Adobe illustrator and Adobe Photoshop, give you sublime control
over things like depth, lighting, coloring, shading, drop shadows, embossing, beveling, and
what is called materials shading, or the application of textures to type. The possibilities are
limitless.

Working with Text
1. In the SF-MacOps folder, double-click on the Formatting Te Ht file. This will launch

the SimpleTex:t program that we used earlier and open the file. Check out the copy.

· Fiiied with alegory and symbolism, this classic story of good and evll unfolds among the
whaler community in the 1800's. The great white whale, Moby Dick, is pursued by the
obsessive and cruel Captain Ahab. In a prior battle with the leviathan, Ahab had lost a leg,
. and many say, his mind.

i

: Aboard the Pequod, Ahab and his men chase the beast across the world's oceans, until they
finally meet him -- and their combined destinies -- In a final, brutal battle of wlll,
; determination, and obsession.
A Book or the Month Club Selection

2. When you move the cursor into the area of the type, it will turn into a small I-beam.
Drag the I-beam across the first line, Moby Dick. It will become highlighted (the
same way that folders or icons become highlighted when you click on them).
til
H.._~Cfd
a novel
Hannan Helvl lie
Fiiied with alegory and symbol Ism, this classic story of
good and evll unfolds among the whaler community In
the 1800's. The great white whale, Noby Dick, Is
pursued by the obsessive and cruel Captain Ahab. In a
prior battle with the leviathan, Ahab had lost a leg, and
many say, his mind.
Aboard the Pequod, Ahab and his men chase the beast
across the world·s oceans, until they finally meet him
-- and their combined destinies -- in a final, brutal
: battle or wl II, detennlnalion, and obsession.
A Book or the Month Club Selection
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3. Go to the Font menu. Click on it and move the mouse down the list until the font name
Palatino is selected. Click on it and watch the type style change in the document
~

: :;!iltipt1a1 strlpt'i

; :~~cir!~ ~w~:
_"Oftltlrio S'ettt'

:

;; ·~nuc-e Hall : .
· ::son'd , . .:
. ;§~4'

Illustration programs in

~
a novel

:nchno; : .;;;

particular are great for

··mm:ri:!;':i!.!·f:·

achieving special effects
with type. Most type

:...

'.Symbol'.;· . ': . '.:

:rrmi!sR~roan:

Herman Helvl lie

:

4. With the text still selected, go to the Size menu, and select 24 point. When you do, the

title will become considerably larger than it was.

elements can be turned into
an art object, which you can
stretch, pull, twist, color, and

~
1nove1

distort in endless ways.

Something Fishy

Fllltd Wll/I al~Oty Ind sy~ll•m. 1111$ CllHIC stcty or
gooCI Ind ... 11 ... ro10t ~Ille "11altrclll1llTKlllly in
t,,. 1eoo·s Tho gr.at Wllll• w11a11, l1Cll)' Diet, 11
purs<Ad Dy th• 001n1l"9 Incl crutl Cagtaln Allllb. In a
prior 1111111 with tlle leviathln. Allllb had Iott a leg. ana
iNnY uy, his mind

Herman Melville
Filled with alegory an ·;t·mllWl'.Jn:\: this classic story of
good and eYil unfolds
ler community in
the 1aoo·s. The great white whale, Moby Dick, Is
: pursued by the obsassiYe and cruel Captain Ahab. In a
', prior battle with the leviathan, Ahab had lost a leg, and
i many say, his mind.

ADOll'CI tht PtQUOd, Ahllb 8'1d hit mtn chaH lho bOHl
KrGH \ht world"• ocaan•. untu they llnally meet him
lhtlr comlllnod dlatlnlts ·- In a flnal. brutal
Dalll• df Wiii, dt1trm1n1t1an, •nd obHHion

-- w

Ooct or u .. rt:lnlh Club Stlfl:llon

A

t;I

11!i!

5. Now make the title bold using the Style menu. Bold type is slightly darker than

normal type, providing a means of making something stand out from the rest of the
text.
~:

.:Ale

:J!.I]

: Herman Melville
I

J<f
,_
a··1·m1·',imil
""~·
• .

.

. l

·t.:. .•·tl:Z-..

-

Your font menu will
probably look different
than ours.
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a novel

Herman Melville

6. Highlight the words "a novel.,, Using the menus, select 10-point, Helvetica and make
the words italic.
~· - -- ..

·• --·~q -··· __ .

MobyDick
1

: ancJWI

, Herman Melville

I

Filled with alegory and symbolism, this classic story of
good and evl I unfolds among the whaler community In
. the 1600's. The great white whale, Moby Dick, Is
pursued by the obsessive and cruel Captain Ahab. In a
) prior battle with the levlathan, Ahab had lost a leg, and
I many say, his mind.

i Aboard the Pequod, Ahab and his men chase the beast

! across the world's oceans, untl I they finally meet him
' -- and their combined destinies -- In a final, brutal
· battle of will, determination, and obsession.
A Book of the Month Club Selection

I~

7. Look at the changes that we've made to the document One hint: we changed the font
for all the text below "a novel" to Times, and played around with the sizes a bit. We
also italicized some of the words within the text itself.
ll;J. -- ... :.

ttennan Mplvil!p
Filled with alegory and symbolism, this cla.ssic sto~ of ROOd and evil
unfolds among the whailer community In the 1800 s. Tlie great white
whale, Mi7'.,•0id.; is pumued by the otisenivo and c:rueJ Captain Ahab.
In a prior battle with the leviathan. Ahab had Jost a leg. and manyso.y.
bis mind•
. Aboud the ~m'let Ahab and hla men chase tho beest across the

world's oceans. untlJ theyfinallv meet him -o.nd their combined

i destinies - in o. fino.l, bruto.1 b&.tde of will, determination, o.nd
obsession.
A Book of the Month Cub Selection

8. When you're done experimenting, save the file in your projects folder. Name it "Moby
Dick.TXT". We're going to use it again later on.
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Editing Text
Although SimpleText is far from being a powerful word processing program, it will provide
you some insight into how the more powerful commercial programs operate. Since it relies
on the Apple Developer Guidelines, and some of them cover selecting, editing, deleting, and
editing text, when you move up to Microsoft Word, or Adobe PageMaker, you'll find the
sam e things work there that you learn here.

Editing Commands
• When you click the cursor and begin typing, the new text you enter is inserted
into that space, pushing everything else to the right.

Htzmtn Mtlvll)e
P!lled wltll e.lepy and ')'lllbolllm.11W cl&lllc ctor/of good U\cl nu IU\lolcll amongthe wlllkr
Ol)mmUl\lty In th• talO'a. The pat white .. we...Yai)'Lkt i. punuecl hr,' the ati-hre and aueJ Captain
<'lhob. ln • prl«batlle with thelcv!.othan. A bob bod loot o le&and many say. hh mind.
Ahoerd th.a hqucd. Ahd>t.nd blsmon <hue the beul acrocc 1b9wodd'cCIC8UI
TuntD 1i,..,t1n1!lyhlm - Vtd tliolrcmnb!ned dadnlos- In• Anal. brulUb-.ttl.e ot ..UI, d.iam
eel ~Ion.

I

A 1a.o1c..ui..~ C1&.1>S1hc1ioo

We clicked here to put in the /-beam insertion point.

. --------·-·-.J ._____

--- . -

•

- - - - -· · -

-

•

.

Hmpen Melyllle

When you're typing into a
word processing program,

Filled orith alOfFY and cymbollsm. th.t. ~luck otory_
ot tpod and eoU llAA:>lds un.ong the "holu
COJl'll'QwU1Y In Ille J800'•· theS-t WhJk NAala, Mcr/lyl)(d-. I' f'lml«i tlf Ille ~... W cruel C.J*ln
l'lhlb. In t. ptiorii.ttlt l'rilll w lnhlhN\. Alltb b&cl lott • les. Uld 1llUIY ...,. hil m!K.

don't use two spaces behind

~IM<Alrl!Alot~al\dbia11Dtn~IM1*11-tM-1.d'•OCMN,tun\!l)gl!Wtll6dcea1&ll

a period. It looks bad in the

reuon.until lfi.,,.n-llymool him -e.J.i lboircombined clalW...- In afinAl.brulalb.:ttleof will.
cldermlnallcn.and Clbsealon.

+II-_.

finished copy. That's
because fonts on the
Macintosh or on a PC are
spaced proportionately, not
monospaced like on an old
typewriter. Two spaces will
make a huge, visible, and

And entered the new copy. The copy to the right simply flowed
to accomodate the new material.

• Ifyou select a word, phrase, sentence, or entire document, and begin typing, the
highlighted material will be replaced with what you're entering.
• Ifyou highlight a word, phrase, sentence, or entire document and hit the Delete
key, it's gone.

unsightly gap in your copy.

• You can delete text by highlighting it and hitting Delete, or putting the insertion
point to the right of it and pressing Delete until it's gone.

70

C H APTER 3/USING PROGRAMS

Copying, Cutting, and Pasting
Another set of very powerful editing functions can be found under the Edit menu of just
about any program you will ever find yourself working with. These functions are called
cutting, copying, and pasting.

Moving Text with the Clipboard
1. IfSimpleText is still open, select Open from the File menu and open the file called
Moby Dick.THY.

2. Highlight the phrase at the bottom of the page, "A Book of the Month Club Selection,,, Choose Edit>Cut. (Notice that the keyboard equivalent ofEdit>Cut, Command-X, is displayed in the menu. It will make your work flow more efficient if you
learn to use these shortcut keystroke commands.)

11

clo.sslc story of good o.nd evil unfoldG omong tho who.ler
-:
te who.le, Md')•Did, is pursued by tho obsenivo and auol Ce.ptain
, Ahab had lost a leg. o.nd mo.ny say, bis mind.

One of the many components that are installed
when you first set up your
Macintosh is something
called the Clipboard. The
Clipboard is a specially
reserved portion of memory
that's used when you cut or
copy something from one

3. The text will disappear. It goes to the Clipboard The Clipboard is a temporary
holding area, used when you copy or cut text. The cut or copied text remains on the
Clipboard, which makes it possible to paste the text into another part of the file.
4. Put the cursor behind the words "a nover' and hit the return key twice. You can see
that this inserts blank lines.
5. Choose Edit> Paste or press Command-V. The copy will be pasted into place.

place and paste it into
another.
. .'f llllH$

A Book of tu Month Clm s.Iaction

Hmnan MeMl!e

Filled with o.loSOJY o.nd oymbo1ism. this c
community in the 1800's. The great whit•
Aho.b. In o. prior~ttlo wlth the leviathan
Aboo.rd tho /lfqu«I. Ahab o.nd his men cl
him - and thclr dmno.tic destinies - in e

6. Close the file without saving.
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Cutting, copying, and pasting are basic features of almost any application program you will
ever use on your Macintosh. They will become second nature to you as you gain experience
working with the Mac OS. W hich of the techniques you use will depend on what you're
trying to accomplish.
• Moving an object or text. To move something from one place to another, use
cut and paste. Cutting an object removes it from its original location.
Remember, the Clipboard

• Copying and object or text. To copy something from one place to another, use
copy and paste. Copying an object creates a done of the selected item that can
be pasted somewhere else. It doesn't effect the original item in any way.

can only hold one thing at a
time. Ifyou cut something
that you want to paste
somewhere else, and
accidentally copy something else before you paste
the first thing, the first thing
could be gone forever.

Ifyou want to store more
than one thing at a time
where each item can be
copied and pasted at will,

Using Aliases
An Alias is a special function- one that occupies almost no space at all on your Hard disk.
What it does is point to another file or program. The item to which the alias points is
called the original, and the alias acts just like that original in every way. You can put an alias
anywhere on your system, and when you double-dick it, it acts exactly as if you had found
and double-clicked the original.

In a real working environment, you'll eventually end up with lots of files, and many levels of
nested folders. To access any program or file on your system will require double-clicking
your way through the maze of folders until you have found the correct item - the one you
need at the moment.

then you'll have to use the
Scrapbook, which we talk

Here's an example:

about in the Chapter on
Built-In Software.
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Nesting items inside folders is a great technique for organizing your folders, data files, and
applications, but can easily lead to an awful lot of double-clicking to get where you need to
go. In this case, you have to double-click five different times to launch (another word for
start) the Adobe Illustrator program. That's a lot of clicking.
In this next illustration, we've created an alias of Adobe Illustrator, and placed it on the
Desktop. Check out the savings in clicking time.

When you create an alias, the same icon is used for the alias as was assigned to the original
item. To keep aliases from being confused with original files, the Mac OS italicizes the names
of aliases, and adds a small arrow to the alias icon. This is a good idea since you can
throw an alias away without causing any problems, since it's only a pointer file. The original,
on the other hand, represents an entirely different story - throw it away and you might be
in trouble.
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Here are some rules and guidelines for using aliases:
• An alias can be duplicated many times, and each copy, regardless of where it's
placed, relates to the original.
• An alias can be trashed without hurting the original. And if the original is a
folder, it will not hurt any of the contents.
• An alias can be renamed. This does not affect its connection to the original file.
• An alias can be created (once the original is selected) either by going to
File>Make Alias or by pressing Command-M.

• If an original has been moved to another location that you can't recall, it can be
tracked and found by selecting the alias and choosing File>Show Original or by
pressing Command-R. The last folder that the original resides in will come to
the Desktop, showing the original.
• Any item with an icon - the Hard disk, the Trash, the System Folder, control
panels and extensions - can have an alias.

• Ifyou are working with the alias of a document folder, then you can put items
into the original folder simply by touching the items to its alias. In some cases, you
might prefer to hold the Option key to send duplicates of the items into the folder.

Duplicating an Alias
Once an alias is made, you do not have to trudge back to the original to make more aliases
for other access locations.
• If you select an alias, then go to File> Duplicate, a copy will appear.

~

Ne<e' Folder

~

~

~.·~.

~

Mrv Fqffkr #If# Ab' FM/tr #liM &tJPV

Accessing the Original
There might come a time when you actually need the original on the Desktop to make some
modifications. You do not have to go digging through folders to locate it. You also might have
forgotten just where the original resides. Just single-click its alias icon to select it, then go up to
File>Show Original. The folder that contains the original will open on the Desktop.
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Creating an Alias
1. Go to the Hard disk icon and double-dick to open the Hard disk folder. Listed in

the Hard disk should be an Apple Extras folder. Open it.
2. You should see an AppleScript folder. Open this folder.

3. Inside this folder you should find the Automated Tasks folder. Open it.
4. Inside the Automated Tasks folder, press Command-N to create a new folder. Rename

this folder "Hidden Tasks".
5. Click on the About Automated Tasks document to select it. Press
Command-M to make an alias of it. Drag the alias into the Hidden Tasks folder.
6. Select the Hidden Tasks folder. Go to File>Make Alias to make an alias.

Ifyou have aliases lying
about in various folders,
and you choose to remove
or delete the original, you

Drag the alias out of the Automated Tasks folder and onto the Desktop.
7. Now close all the folders you opened in this exercise.

will see a warning message

8. On the Desktop, you will see the Hidden Tasks alias you placed there.

ifyou double-click on one of

9. Double-dick on the alias. The Hidden Tasks folder, which still resides deep in the
folders, will open on the Desktop. Inside this folder will be the About Automated
Tasks document alias.

the related aliases. The
warning tells you it could
not find the original.
The best thing to do in this
case is trash the defunct
aliases.

10. Double-click on this alias. The application, SimpleText, will launch in order to open
this text document.
11. You have succeeded in manipulating items without needing to dig deep in folders to
get their originals. Close the SimpleText document. Close the Hidden Tasks folder.

Chapter Summary
In this Chapter you learned how to start up a simple word-processing program named
SimpleText that was supplied with your Macintosh. You used it to create files, and save them
into appropriate folders on your Hard disk. You also learned to enter and edit text, along
with the basic formatting functions available in most Macintosh programs. You learned to
change fonts and sizes in order to add more graphic interest to your documents. You also
learned how to use aliases, which are small pointer files that can dramatically improve your
ability to navigate through nested folders with a minimal number of mouse clicks.
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Notes:
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Built-In Tools
There are several powerful tools and applications that come with the Mac OS. They're
installed into special locations on your hard disk the first time you run the installation
program to set up your machine. In this chapter, we're going to explore some of these tools
and applications, and examine how they can make your working environment more
friendly and effective.

It doesn't matter which
application menu bar is

There are two different places where these tools and programs are located. The first is under
the Apple menu, and the second is within a special folder called ControlPanels.

active. TheApple menu icon
will always be on the far left

Apple Menu

ofthe Menu bar. Also, items

The Apple menu is the pull-down menu you see when you click the Apple icon in the
upper-left corner of your Menu bar. It contains a collection of applications and tools that
are contained in a special folder inside the System Folder on your hard disk.

in the Apple pull-down
menu are the same
regardless ofwhich

me Edi~ YleW ~peclitl
• Aboutifhls C!On'il!uter

program is running.

~
A?) Apple S~m Profller

Iii ATM Deluxe

rs ca1cu1ator

~ Cllooser

Q

Control Panels

IB Fovorltes
!El Key caps

&:.. Metronome

!JI Networlc'8rowser
Ii. Recent Appllcotlons
d Remote Access Stotus
~ Run~llyH02

l!I Scrapbook
~ Screen Silopz

~

~ Sherlock2

Stickles

The Apple menu contains applications and tools that are available all the time.

If you were to open your hard disk and double click the System Folder, you would see,
among many other things, a special folder called Apple Menu Items. It is within this folder
that the applications you see in the pull-down list are contained. Anything you put into this
special folder would appear in the Apple menu.

rme

t:lf
I>

Sun, Oct 3, 1999, 1:2 •
Mon, May 8, 2000, 1
Tue, May 2, 2000, 10
Mon, Jan 23, 1995, I
Today, 9:44 AM
Tue, feb 29, 2000, I

Set, Jun 3, 2000, I 0:
Wotl, Apr 26, 2000,
Today, 9:44 AM
Wed, Apr 26, 2000,
Wed, Apr 26, 2000,
/

Today, 9:45 AM
Wed, Apr 26, 2000,

... .

•w
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By opening the folder, you will note that the list inside the folder is exactly the same as the
one you see when you access the pull-down Apple menu.
1!!18

System Folder ~

Appeeranc.

v

Sun,Oct3, 1999, 1:20PM

GI Apple Menu Items
ifJ Apple System Profiler
m llrtf/.l!lm~

Wed, Ap r 26, 2000, 8:01 PM

ra C.lculalor

YHterday, 11 : 14 AM

~C hooser

Yute rdoy, 12:20 PM

G1 C4'nf/'l>I 1'1""1.•
Q& Fm11i""1

i;I! MJIM1rJ·~

Wed, Apr 26, 2000, 6:38 PM

~ Recent Appllcattom

Tue, Moy 2, 2000, 10:21 AM

d Remote - Stotuo
rl Run Delly HD2

Sot,Oct9, 1999, 7: 10PM

~Scrapbook

Thu, Nov 21 , 1996, 12:00 PM

~Sherlock 2
~<f;' Sllcklu

Thu,5e p 23, 1999, 12:00PM

ta Scm-11 $Mp.•

I>

Wed, Ap r 26, 2000, 6:38 PM

W.O, Ap r 26, 2000, 6:38 PM
Thu, Jon 7, 1999, 12:00 PM
Men, Apr 17, 2000, 1:44 PM

liJ Kay C.?>
&.. Metronome
I>

Mon, Moy 8, 2000, 11 :43 AM
frl , Jon 14, 2000, 12:00 PM

Mon,AUl)30, 1999, 12:00PM

Mon, Moy 8, 2000, 1 t :43 AM
frl , Jun 26, 1998, 12:00 PM

II, Application Supporl

'II ATM ront Detobue

Anything you drag into the Apple Menu Items folder will appear in your Apple Menu.

The best way to understand what these applications and tools are designed for is to experiment with them.
'

Using the Apple Menu
1. Select Apple System Profiler from the Apple menu. This tool is designed to display a
profile of the system you're working on. It's invaluable when you're seeking technical
support and need to know specific characteristics of your computer.
u

DI

.lfifApple System Pro~

~~ 1!18

iV

Sys ltm Profilt \[Dtt<loff andYoUnn~ContnlP-ts~ Exlonsions~olc>Plloatn~ByslttnFolilitt_i

1::

~ Softwart ovtrVi•w

1:~ I> Mfmory OYKVifV
I> ....dvw• OYH'VitoV
I> Hthf"Of"k ovtrVJtv
I> p,.lnttr ovtrvitv
I> Production infonn~Uon

A

~

t-;1
[ <J:

I• ~
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2. Click on the small triangle next to Software Overview and Profiler will give you
detailed information about the Mac OS version running on your machine.
B

lAIJpte System Proftte12

':E

v

lndtr:
9.0
y1\tm :
9.0.4 US
Aotlvt ..,..,ltr : Powtr"PC Enll>ltr 9.0.4 9.0.4

Any media - floppy disk,

G
-=

11¥dOrlv.,
Typo: ll¥d drlvt

or CD is considered a
•

I
I

Star1w dtvlot

removable drive, hard disk,

Quld<Timo :

4 .0 .1

Fl1tslwln9: Iron
,.,.,ltlp1tU.tr"r:l.1

J

i.o..t lon: ., • o
Bus :
SCSI Bus 2

I

11tmOf'y OVtr"V1tW

~ Kvdw.,..ovtf"'V •w

I>

Some drives allow a
technique called "partitioning," which lets the user split

•

Hthfork ovtrV1tw
Prlrlttf' O'ltf'Vltw

I>

Procb>t lon infornwl lon

t;"

__::_

-=-

IT

one large drive into several
you to manage your files

~

SoRwM• OvtrY5t'W'

~M>0 OS OVtrV1tW

smallerones. This allows

~

Sysitm ProOlt v._Dt¥1ots n V.Ui>H_M~I ,..,,.ls~E>i-~loot ....~Sysltm_f!ldor1_1_

'

volume to the Mac OS.

CIT C'lJ

..:..2

~

::r~

¥i

3. Next, click on the Devices and Volumes tab and you will see information about the
hard disks and volumes attached to your system.

somewhat more effectively
than having one huge
space where everything is

l-l11t~ltdnwd~-"

placed. We typically split our
: :::::

drives into several parts,

. -lELI•_3_,..C___
D-R01 dr_lv_•- - - - - - - - . 1 -!No-.ntHmH~ lnstf'IH

reserving one for the
System Folder and Applica-

• l E DRemovll>lt mHI•

tions, and others for specific

l-l11t......,tHmH~lnstf'tH
1 - lHo ......tHmH~-H

projects and data files.

i •Il.s..,.@~!::::Ktr=d=Or=lv=t=I======~

,..-------------,!.

- - - - - 1»! E E J1t.rddrlvt

;;-

I>

Slo\SCI

Ktrd Drlv• 2

~---------~

,..----- l>~l
oi.::.tP""r
"'-'o"'-=ord _ _ _ _ _ ___,l - 1> lo1spttr

-----ils1o1 io2
l11t '"°""ltd mtd~ Ntrttd

A system with multiple volumes and drives connected might generate a fairly complex report.

4. You can use the information from this application in a number of ways. One effective
technique is to use the Mac OS Clippingfeature. Go back to the System Profile tab and
click on the Software Ovenriew triangle. Drag the entire section onto your desktop.
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l!l IB

Mlo~~tn'"W ~~~~~~~~~~~~~~~~

Flndtr :
Sysltm :

9D
9 ,0.4

us

Aotlv• """'"'' Po.....-PC Enoblw 9D.4 9D.4

G

s1 ...1.... c1ov1c>

I

.....,. , llwdl>rlv•I
Typo : Hwdcrin

You should rememberthe

I

Oulcl<Tlm< :

4D.3

Fllulwfng:

is on

MJltlplf.UJft"s : 1.1

L...tlon : D•O
&is :
SCSI Bus 2

Clipping feature, as it can
prove quite useful in the real

Nttwor1c OVtf"'YitY
Prlntft" owrvltw

world. It works in just about

~ ProOJotlon lnfonn>llon

every program. Just select a
range ofcopy, a picture, or
both, and drag them onto
the Desktop. This will
automatically create the
clipping file, andyou can
use it later for anything you
want. It's more effective

5. As soon as you let go, a new file appears on the Desktop. Double-click it and the
clipping will open. You can copy and paste this information into any program, such as
SimpleText or the word processor of your choice.

than copying and pasting,

[!) ~§I Moc OS overview A- cllpl!nGJ!l!l I!!!
CllppllllJ contents: text

because the stuff will

M&c OS overviw
finder: 9.0
System: 9.0.4 us
Active enabler: Po..,.rPC Enabler 9.0.4 9.0.4
QulckTI me: 4.0.3
flle shorl lllJ: Is on

remain inside the clipping
file untilyou throw it away.
When you copy something
and don't immediately

I

r·l.:ic

o·:, ove r v ie·.....· Fi ..

Multiple Users: 1.1

cl i ppi n9

~

paste it somewhere, you

~

a

might forget about it and
copy something else over it.

A

I~ ~

6. You can generate formal reports of the entire profile, or any parts thereof, by using the
Report function. Select File> New Report. A dialog box will appear that lets you select
which of the information panels you would like to include.

PIHft cllOOH tilt lnfo.-rNtll>n that you wist> lo vll.w in your rtporl :
(its~t.m Profll•
lif o.,.io.. ..i voi..n..

{l3 Softw.-. OYff'vitw

lif Control P.,.is

lif ~onrvi.w

0
0
0

91i.rdw.,.•owrvw
li!Httwonco....-..i....

£xtonsl0ns
"91>lleitlcns

Sysltm Fo-s

!if'PrW.t.r ovorvi.w

(if Produollon lnfOf'm•llon

I Cancel J I!

OK

I

From this dialog box, you can select which panels you would like to include in a report.
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7. When you've selected the information you would like to include in your report, click
the OK button and the software will format and create a report.

_,
· View report as: ., Apple System Profller document
O Shbw mes• region Information

-

ms
O Text document

Rtport Cf't•ttd: 6/8/00 •t 10 :!'9 :•~ AM

I

Soflwor• ?•trvltw

I

Mao OS ovtr<tltw -~-,..:-H-'.~-~.,.,,.,~7.::;-,-'-,-;;.-=-;;.,,..;,,;~~i I

You can flip through each

FfncUr :

Systorn;

of the information panels

9.0
9 .0.4

us!

AOtly. .noblH' : PowtrPCEnobltr 90.4 9.cl.4

QulokT~ : 4.0.!
Flit lh>ri1'9: Is on
Mltt(pltUMn: l.I

by using the keyboard
commands:
Memory OYtn'\tW

Command-1
Command-2
Command-3
Command-4
Command-5
Command-6

Software
Volumes/Devices
Control Panels
Extensions
Applications
Systems

7111
ls off

l>lslcoooM :

Ylrtuolmtmery:
Bull\-Jn~:

~111

l.W.1lml

llu

B3
IM

161'8
161'11
'41'8
'4113
'41'11

e:s
A6

116

[)1111
[)1111
01111
01111
01111

Tota l L2oocht:
ExttrnalL2oocht :

St~

- l d t l2 o - :

8. Note that you keep the document formatted as it is, or select Text Document from the
radio button at the top of the report. This option is sometimes more effective when
you want to open the report in another application, such as a word processor.

9. Before you close the program, select the Commands menu and familiarize yourself
with the functions you find there. Among them is the ability to refresh, or reassemble
the information from your system into its original order. This is useful if you put a
new device on your machine, such as an external hard disk.

One of the best uses for
Profiler is to check for
duplicate files and/or

Windows Help
Gather remaining Information f!eG
MU
Update all Information
Update System Pruflle
MR

applications. Some
programs, like SimpleText,

· Show US6Alerts and events-

are often included in the

Sean:h options-

Installation utilities that are
used to install new programs. Each time you install
a new program, you

Profiler, you can periodically

8111

•Devices and Volumes
' Control Panels
EXtenslons
Applications
s em Folders

M2
Ml
M4
885
X6

You can see that there are keyboard equivalents for each of the information panels.

potentially install another
copyofSimpleText. With

MF

~ sYstem f>rollle

10. When you're done looking around the Profiler, press Command-Q or choose Quit

check to see if there are
eighteen copies of Dark
Raiders of the Moon
floating around on your
hard disk, and get rid of the
extras.
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from the File menu.

Calculator
Another useful tool- one that's been around as long as the Macintosh-is the calculator.
It is selected from the Apple menu.

You can either use the Numeric Keypad (if there's one on your keyboard), or click the
operators directly on the calculator itsel£

The Calculator is a very useful desk accessory that's even easier to use ifyou have a numeric keypad.

The operators are the same as on a physical calculator:
+

Addition. Adds two or more numbers together.
Minus. Subtracts the next number entered from the amount in memory.

I

Division. Divides the number in memory by the next number entered.

* Multiplier. Multiplies the contents of memory times the next number entered.

=

Equals. Completes any equation.

c

Clear. Clears memory and lets you start over.

There are a number of other Apple menu items that we will discuss later in the course as we
explore the functions to which they're related. For now we're going to use one more
application that many people find useful - the Stickies feature.
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Stickies
Stickies are the digital version of those little notes that you leave stuck all over your desk
(dead center on the monitor is our favorite spot) to remind you to do things that you forget
to do anyway. Just like their paper counterpart, Stickies can be any color. But unlike the
paper version, you can use different typefaces the same way you can with a word processor
and you can import or export copy to and from other word-processing programs.

Using Stickies
1. Select Stickies from the Apple menu. One note will be blank. Enter something in it;
here we wrote "this is a note to myself...".

Slidcits ltls you wrttt not.. (lb
\hos<)""' slide lhtm lo yo<r
"'"""· Yw C¥I UR Slidcits io }>t
quldc notts, to writt rotmlndtr-s,
Olf to stort frtqutatly us.cl ttxt .
Y0tr notts,,,.. vis iblt whtntvtr
tht Stickiits proc;ram is ltQUv t .
stli:k... -11<#1/y U'(ff !f<Jll
t.;r;X"" don't /II:\¥ 11> dl90~

~~~::Z~"'~°*'·

i;:,~;,, ~o.no\h&ve scroll~, To ,,,,..,n, ~"'"

~v~,. or Cle Pace Up/""o DovnlceY$. To
melte 1h! no1e ~er, drec the siu box In llW
lo'V9l' di:bt comer of the oo•.

...)

2. There are two ways to create a new note. The first is by selecting File>New Note.

Notes exist in their own
"space"- that is they
remember where they were
when you last put them
away. Whenever you start
Stickies again, they will all
appear in the same place
you had them.

3. A new note will appear. Type something into it and go to the File menu. You will
notice that there is no option for saving only one note. There is, however, a Save All
selection. Choose it and all the notes are saved at one time.
4. The second way to create a new note is to import text from an existing document. It
will automatically appear in a new note. Choose Import Text and find the document
called Stickies that is contained in your SF-MacOps folder.

Desktop

I

'-=~---'=--~~~~-L.J·
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cancel

I

iiiiiiiii

5. Read the story.
D

Vtry ft w ptop~ know th• rH I story .about

st icky nolts. Htrt

t..,_ lnnntion of 31'1 '1 vtry populv

al
1

it 11 :

I

As p..,-t of tti.lr" normt l ..otivit its, ttMo ttoginffrs .Ind sclflltisls .1 t 3H cont iwalty
Jffk. n.w 9 Ws ~ .c1htsivtt for products lict sk)ns, s~, W tM
thouundsofothtr th"9s U..t U..ym.ib .

~

I

One of thtir txptrlmtnts WH' • 9lff th.it vu rnHnt to ti. uud on tht bK:I: of 1
l.tbtl. Unforttm1ttly I tht 91iJt dido't s tick v+ry Ytll, so it VH .t>.andontd.

Ont of tlw tft19intw1 on Ult projtc)t v.as .also a choir dirtc:t or .at tlw k>c1 I d'u"<:h,

WMt ht f t lt thlt .a llhouQh Ow 9lu• didn't :Stick wt ll fonOU9h (Of' tM or'°inal un, It
1
would prov~• 9fHl "'"Y for him to put notts on tht choir books tNt oou~ ~\.tr 1
bt t-1ktn off without dwn1ging UM ptqts. It workf'd so wtll for that 'C>Plio.ltlon
th• t hot m1dt • ft'tl do:tn p1ds up and distributtd thtm to stortt.¥5ts thrC)U9hout

tht oompany. It worktd so "Wtll for notts on circul•l.d doo..mtnls thlt thty
to m1kt ft a r ul pt·oduct .

dtoi~

Unless you have a pretty

Th• rtsl ls hlslory J

large monitor, you prob-

I

~

ably won't want to keep too
many Stickie notes around,

6. Select Note>Text Style.

although coffapsing them
down tiff they're smaff helps
a bit.
Many productivity
programs, such as
AppleWorks or Microsoft
Office provide sophisticated To-Do fistsand Note
functions, and ifyou end up
working on a computer
that's equipped with such a
program, you wiff probably
use these more robust
commercial applications in
place ofStickies.

7. Change the font to New York and the size to 14 pt. You will see all the copy immediately respond. Note that you don't have to select the copy before you make the
change, as you do in a program like SimpleText or a word processor.
r

'41

f'lle

Edit Note Color Help

Very few people know the r eal story about the
Invention of 3M's very popular sticky notes. Here ll
is :
As part of their normal aclivili .,- -and scientists al 3Mcontinual!
adhesives for products like sig
Font :
the thousands of other things t
si ze:
Sty le:

One of t heir experiments was a
meant to be used on the back o
Unfor tunately, the glue didn't
was abandoned.

¥Text Style
l_Nw~~Y•~rk~----~
I :c_tl

W=nD
Ea Ploi n
0 Bol d

O Oulllno
0 Shadov

Oltollc
O Underli ne

0

0 Colldenud
Extended

I Cancel I

OK"

I

8. You can also change the colo r of any note. Try it by selecting the Color menu.
Hell!
.,, Yellow
BIU j!

Green
Pink
Purple
Gray
Black & White

9. Close the note by clicking in the Close box. An Alert dialog will appear.
Closlngthls note will delete ltfrom the
desktop. Do you wantto save Its contents
as a text file before closlng IU

I Don't Save I

, I Cancel I lt5)
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10. Ifyou want to delete your file, you can do so by choosing Don't Save. Ifyou want to
keep it open, click Cancel. If you want to save it for use in another program, such as
SimpleText, click Save and pick a name.
11. Quit the program when you're done.

Scrapbook
The first time you use
Stickies you'll get a message
when you Quit asking ifyou
want to have Stickies
running whenever you start
up your Macintosh. Ifyou
say Yes, an alias ofthe

We've already discussed the concept of cutting and pasting text and graphics. One of the
major limitations of the process is that you can only have one item copied or cut at a time,
because the Clipboard (that special place in memory that stores copied or cut items) can
only hold one thing at a time. Ifyou have something on the Clipboard, and copy or cut
something else, the original item is gone and replaced with the new item.
The Scrapbook is like a clipboard that can store multiple items. Choosing the Scrapbook
from the Apple menu presents a window containing a number of items that were put in
there by the people at Apple Computer. They haven't changed much over the years.

program will be stored in a

s_crapliooic:. --:a

special folder called Startup

_.. ..

Items, located inside your

,(.lo

1.. .... .. ...

~

......

~ .~

--

• . • "'"""

lll!IB
'Ill~

U•• the Scrapbook os • place to keep pictures, text, movies, and sound•

~~-~~=~~

System Folder. This will

• Build a gn.phks library

automatically launch the

I~;
!

i

• Store your favorite soundund movies

application when you

• Keep a letterhead design to paste into your memos

power up your Macintosh.

•Store a dl•tnbullon llst or other frequently used text
See your user's guide for more information.

Like the copy says, you can use the Scrapbook to store multiple objects that you
copy or cut from another source.

You can store different types of objects in the Scrapbook. The process is to copy or cut
something from a document, open the Scrapbook (Apple>Scrapbook), and paste the object
in place. Objects pasted into the Scrapbook appear before the entry you're looking at, so
you can position them wherever you want.
At the bottom of the window, you can see that there is a horizontal scroll bar to use for
finding the items in the Scrapbook. If you look through the items, you will find graphics.

86 CHAPTER4/ BUILT-INTOOLS

· Scr11)1boolc

Although it's possible to use

lt.m : 6of 10
Ty,. : sound

the Scrapbook for creating

Size: 4K

a library ofgraphics
elements, in the real world
this simple accessory!
application isn't robust

lle91: 2of10
pleb.rt
Siu: 131<

T~:

enough to meet the
demands ofa professional
graphic artist. File formats
and the ability to attach
searchable text to the items
are two of the many
limitations that the regular
Apple Scrapbook exhibits.

There are a number ofgraphics and at least one sound stored in the Scrapbook
that came with your Macintosh.

You can even put QuickTime Movies (a special type of file for video and animations) in the
Scrapbook, and play them from there. We will be learning about QuickTime later in the
course.

Control Panels
The second place we'll find a collection of application programs and tools is in yet another
special folder called Control Panels. There are quite a few items in the Control Panels menu;
some of them come with the Macintosh and others are commercial applications that
professional users purchase to add functionality to their systems. In this section we'll go
through most of the important and useful control panels so you can get a feel for how they
work. At the same time, using these applications will give you more experience with using
your Macintosh.

frl , Apr 28, 2000, 2:40 AM

§'i Mobe-Tyiie lleunloq D!,liixo
11!1 Alecldln Coll)pr~lon.;
~ 11peeenenct

1

' I!! AP,l'I• Menu Op\l;oM
!!J ApploTel k
l!J ao1orSync

Wed, Oct 20, 1999, 5:12 AM
Tue,Nov9, 1999, 12:00AM
Thu,AUQ 26, 1999, 12:00 PM

_ To<loy, 9:44 AM
Tue, Oct 1, 1996, 12:00 PM
Tue,AUQ 10, 1999, 12:00 PM

Ill Cllnf19urellon MeMQ!er
I!! C11.11trol Strip

Mon, AUQ I 0, 1998, 12:00 PM

l!!JDoleUlme

Mon,AUQ 30, 1999, 12:00PM

Thu,J&n 22, 1998, 4:01 PM

!§_ DlelA.,lst

Mon, AUQ 30, 1999, 12:00 PM

Iii._Enerw Sever

Tue, J&n 18, 2000, 12:00 PM

gj Extenslons M&MQer

Fri , Jul 24, 1998, 12:00PM

Ii! f !lo EXCheOQO
Ill file Sheri nQ

frl ,AUQ27, 1999, 12:00PM

A special folder within the System Folder contains the items that you see when you
access the Control Panels menu from the Apple menu. This screen capture shows
items that probably aren't installed on your system - and many that are.
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Appearances
In the Appearances control panel, you can modify the look and feel of the Finder and the
Desktop. You can change backgrounds, use pictures as wallpaper, and choose which fonts
are used to display text in Menu bars and dialog boxes.

~
IFW

=

Changing the Appearance of Your Desktop
1. Choose Appearances from the Control Panels. The Appearances dialog box will

appear. It is probably set to the Desktop tab. If not, select that tab so that your screen
matches the image below.

[ii

rP•att•e•m•s•=-----~~~
Azul Dark
Azul Extra Ll9hl
Azul Li9ht
Blueberry

-

Bondi
Bondi Dar k

le~J·~
~r.;Di~
riot!'lfil"'""1i.,.<>-!"l••·...,...,..-

-

eond1 li9ht

P1t1ern: Bondi Extni Derk
16 X 16, 126 bytea

Picture: None

The ability ofa commercial

It l!j

Rlate P.lcture_

or MAM. This is a very
competitive field, with a

I

11~~· 1

graphics, sounds, video, and
Media Asset Management,

,

I ~sltion A1rto,m11~cofly l ¢)

application to manage
text information is know as

.,.

f'!tture:

2. Use the scroll bar to slide down the list until Mac OS Default pattern is highlighted.
This is the standard desktop background that comes with your Macintosh. Ifit's
already selected on the computer you're working on, pick another one and choose Set
Desktop. The entire desktop background displayed on your monitor will change.

number ofhigh-profile
companies offering
solutions that range from
fess than $ 700 to over a

lollipop 5
lollipop 6
l li*OS~ult~_
Peanuts Azul
Peonuts Pistochlo
Pistechio Oerk
Pistachio Lloht
Pistachio Medi um

miffion doffars in demanding environments where
there are miffions of
different items to track,

Petlern: Mee OS Oefoult
128X 128, 16K

multiple languages, and

Plctare: Hone

...
..:::

..

Picture:

I·

P.111cJD>f@!re:;;

)

Irosltton Automatically I ~ J

copyrighted materials.
Although the Scrapbook

lrset DesttoPJ

can come in handy, it
cannot replace these
industrial-strength
commercial programs.
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3. Select the Themes tab. Feel free to experiment with the various themes. Notice that
they change color combinations as well as the fonts being used for dialog boxes and
title bars.
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When you place a desktop
picture into the Appear-

Grope Ml..lon

ances dialog, you will see

li me Horizon

Current Theme: Custom Theme

three small icons in the

I

To create o ,,..,, theme, modify thesettl n<p In the foll~l ng ...uons,

upper right hand corner of

I Sftvi!'Tlle-me.• l

the Open dialog:

4. Go back to the Desktop tab, and select the Place Picture button at the bottom right
side of the dialog box. Navigate to the SF-t-iacOps folder and select Garden
Panel.PCT.
Open ¥¥¥¥

The hand icon accesses the
volumes connected to your

Dete Modified

computer.

I /30/ 98

'*

5/22/00
1/30/98
Todoy

5/20/ 00
12/2197

Q Hard Drive I
Ea Hard Drive 2
Ea lntemalHO

I Show PrevteWJ

The books icon lets you add
a document to your

J !It

Cancel

Elect Disk

Sl!en

I

5. Double-dick the file name and it will be imported into the Appearance dialog box,
where you can apply it to your Desktop by clicking the Set Picture button.

Favorites folder (another
Apple menu item that keeps
important documents in
one place for easy access).
Peanuts Pistachio

It

And the Clock keeps track of
recently used files.

Pattern: Moc OS Oefoult
128X 128, 16K
Picture: Ga rdening Ponet.pct
576 X 384, 639K

Pio toch io Derk
Plotoch io Light
Plotochlo Medium
Poppy
Poppy Dork

Picture:
Remove 'Picture

[Iii Fiii Screen

& The pattern may be covered by the picture.

I Set OeslctoPl

From the Appearance dialog box you can select pictures to use as backgrounds on
your Desktop.
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6. You can experiment with the different positioning options, which let you fill the
screen, center the image inside the desktop, and tile, or repeat the image across the
desktop as many times as it will fit.

Ill ScAle to Screen
Iii Fiii Screen

Ifyou see an exclamation
point in a dialog box, it's
usually a warning about
something. In the case of
the Appearance dialog box,
you might see it whenever

P,o~'ition Autom11t1c11lly

7. When you're done, you can choose to remove the picture, or leave it on your Desktop.
We took this photograph ourselves, so feel free to use it if you want.
8. If you would like to continue experimenting with the Appearance feature, feel free to
do so. When you're done, quit the application.

you select an option that

Apple Menu Options

might cover a background

The Apple Menu Options control panel lets you make a few minor adjustments to how
menus behave.

- as is the case in this

hands-an ex"'i!Jy

Using the Menu Options Control Panel
1. Select Apple Menu Options from the Control Panels menu. A dialog box will appear.

Look at it for a moment.

r......,. _
t

f)On

~

OM

[fil

D Remem,tier recently used Items:

Although the images that
bdcu1if ents:
j'

we've supplied with your

1

Student Files are our own,

j'PPllc1ttlons:

and therefore ours to use,

'

you should be careful when

I
S,erve~:

using other people's work.
Whether or not it'sposted
on the Internet, someone's
work might be copyrighted,
and therefore protected
from unauthorized use. We

2. The radio buttons on the top of the dialog box control how submenus work. If, for
example, you have them on, the contents of folders within a menu show a small
arrow, and allow you to slide down one menu into another. Ifit's off, you have to
select the folder and have it open. Turn this feature on and off and look at your
Apple menu.

recommend that you
respect the intellectual
property of other people
since someday it might be
your intellectual property
that someone decides to
steal or respect!
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me Edit View
Aboutlhls Compq~er

me Edit Y,lew s11ect1
AboutThlSCo puter

@Apple System Profiler

:@ Apple System Profller

Ii) ATM Deluxe

l!!)ATM Deluxe

mClllculator
~Chooser
' .

l!!I

AilobeGamm11
Adobe Type Reunion Deluxe
Alllddfn Compression"'
Appearance
Apple Menul-Optfons
AppleTnlk
ColorSync
Conflgu~ntfon Marrager
I C!ontrollStrip
Date &Time
Dlnl/rlsslst

Qi F11Vori i!s

fiil Key Clips

There are several built-in
tools that we'll cover later in
the book. A few examples
are Chooser, which let's you
pick a printer or network
volume, and Configuration

Calculator
~Chooser
Q'I. Control Panels
Fnvorltes
Key Caps
&,. Metronome
NetworkBrowser
Remote Access Status
~ Run Dall}< H02
IE Scrapbook1
Screen Snn~z
Sherlock 2
St:lclcles'

&,. Metronome

!:I Networt< Browser

d

Remote Access Status
~ Run Dlllly HD2
·~ Scr11pb,ook
•
Screen1Snapz
Sherlock 2
Stlclcles

l!l
J#

IL
!Al
!If
d
C'.i
J#

EnergyS11~r
~ottc- l nnc- ''•nano P

The image on the left shows the Submenus option On; the one on the left has it turned off.

Manager, which is used to
control your Internet and
Email profile.

3. On the bottom of the dialog box is a checkbox that lets you turn on the Mac's ability
to "remember" documents, applications, or servers (network hard disks) that you
used recently- and how many to remember. Turn this feature on and the Mac will
begin to remember programs you launched and files you opened. They're stored in
the Recent Applications and Recent Documents folders, which are inside your System
Folder.
4. Close the dialog box when you're done.

Control Strip
The Control Strip is designed to let you quickly access certain core systepl settings, including monitors, sounds, network, printers, and others. It was originally designed for laptops,
and found its way into the Finder feature of desktop Macs as well.

Using the Control Strip
1. Choose Control Strip from the Control Panels menu. A dialog box will appear.
0 :;'!'7!1 . l~ ~ntnJI Strip

El

,-ShC\i/Hlde

e Show Control Strip

rir1sil~

G Hide Control Strip
G Hot key to

I

10...nflt
-

'

sh ow/hl~e

)

DeRne-11ot ke v •.

r.ot ...+y
CUl'llfit,'.iOO • (:(lritrl)I •

I

s

,-Font Sellil>9S

ront:I Geneva
Slze:l 10

1 ~4

~1
!

2. Choose the Show Control Strip radio button. A tiny icon should appear on the left
side of your Desktop. You might have to search for it- it's pretty small and looks like
a seat belt latch. Keep looking, it's there .

•
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3. Click on the icon. It will open to the right.

10~11 rl~lretf1Wlm!li!IW12rli!Jd!Jdll
4. Click on each one in turn. Each provides setting for specific items. Don't make any
changes at this point - just read the choices. As we move forward in the course, the
ones that you don't understand will become clear.
5. When you're done, select the Control Strip control panel, and choose Hide Control
Strip.

Date and Time
The next control panel is Date and Time. This tool allows you to change the way today's
date and the current time of day are displayed. It also lets you set your clock from several
Internet web pages, assuming that you're connected through a modem, a cable modern, or
some other communications device.
current Date ~

I 6/ 8/2000

-aurr.ent nme

I 5:15:41 PM

I~

I Date F~rmat:s'_

I~

I Time Formats_ l

a ~·

Time Zone ---------~==i
~Set Daylight-Saving Time Automattcally

0

Dayligllt•Savi11g Time ts IMeffect
~!~1,:.~ city In the current

1r--:-se""tn="rn
""e""A!,....n=e=-""l

-iitUse a Network Timi!Server ~-,...--,...,,,..,,~~
Time ser\'.Or: ~pple ~merl~/ ...
CJock~!i$:16~1 syncjlrQnfzed ot

5: 1S;0,9 l'N on 618t QO.

The Date & Time control panel

With this control panel, you can set the Time Zone you happen to be in, and let the computer know whether or not it should automatically adjust for Daylight Savings Time.
Ifyou were using a laptop,
such as an iBook, the

te Forman"
Region:

~-.s,---,,,,----·~
l[~_J

control strip would contain

Sllort Date _........,._ _~ ·
'

several icons that control

'
<
[ ~onllliOllyWe,
irjl I

battery settings and the

Separator: ~

Sleep command, which puts

0

your computer into a sort of

O Leading zero ror month
0 Show century

dream state. This is very
useful when you need to
conserve battery life something any laptop
owner knows a great deal
about.
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Leading zero ror day

O Leading zero ror day

~
~:i

II

At the bottom of this dialog, you can see various samples ofDate formats.

The Server Options button lets you choose the Web Server that will provide your computer
with the exact time.
--

--

J_Sei;erQp"1Tons ·

NetworkTlme Server: j"Apple :Amerlcas/lL Ii~)
re-Update the time:
f> automatically, wtten the system cloci: Is
dflrerentfrom the time server

Letting your computer sleep

Geverv ~ l hours

is better than shutting it

Q manually

down, because simply

llSe!:TI!lle Now I

touching a key brings the
machine back to life almost

I

1~1

I•
I•

lit

I Cancel J ~

OK

]

Most users choose to have the system automatically check and adjust the time.

instantly. Anywe/1configured computer is
going to take a few minutes
to start up after being
turned off. That's because
the system checks its
memory, loads software
and accessories, and might
even look for viral infections
during the startup process.

Lastly, you can use this control panel to adjust the way your Menu Clock (the one in the
upper right hand comer of the Finder menu bar) behaves.

. ;z;: 1Ooek options

t•

Hee• Bar Display

Format ---~

O Dlsl!laythe time with seconds
Q Append AMIPMto the time
[]Show the day of the week
[] Rash the time separators
O Show the battery level
O Use custom clock color:
c--...-~~,e~~t-,(,..-01pr........)

c•1-.s.tth•P·~,......---~--,:

El Chime on the hour
0 , .numrer<iflimua>curnnl hour
D , .unl~Hctten""'9rl3runn1~
Select Chimes

(9

nochime

G

nochi1t1e

(j)

liD c/1fit1e

©

nochime

Font Se,.;tt;;lllP~~===;;;=;;rn
Font: diarc,o al

I

Size:

j !W--=,,~ I

I

Canter] R

There are quite a few options for your Menu Clock.
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Energy Saver
Energy Saver is a control panel that allows you to control the Sleep mode. The idea is that if
your Macintosh is not in use (for example, when you take ninety minutes for your halfhour lunch break), how long should it wait before putting itself to sleep. It uses less energy,
stays cooler, and comes on much faster than if you had turned it off completely.
As we mentioned, when
you're using a laptop, the
ability to conserve your
battery is critical; it's really
disruptive when your
battery runs down in the
middle of writing an
important proposal on the
airplane, or when your city
is being attacked by berserk
Viking warriors and you
need to quickly design a
new catapult.

Energy Saver lets you determine if and when your Macintosh should go to sleep.

A second component of the Energy Saver is the Schedule dialog box.
m~-----:~-·--·

··.: : . ~-.:.Ji. ''"Vt: ...~.•

In the Schedule dialog box, you can set times for automatic startup and shutdown.

Extensions Manager
Extensions Manager is a control panel that allows you to manage extensions, Control
Panels, Startup Items, and Shutdown Items from one convenient interface. It lets you create
sets that contain specific tools, and lets you load them at startup through the use of special
function keys.
When your Macintosh starts up, it loads certain items into memory, so they are continuously active during the session. Depending on what you're doing on your Macintosh, you
may begin to collect different types of extensions, drivers (that control hardware devices
such as printers), fonts, and specialized tools. An example of a specialized tool is the screencapture programs we use to create the screen shots you see throughout this courseware.
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Another example is the collection of fonts that you're using for a specific client's logos and
branding images.

The more extensions you
have, the longer it takes for
your Macintosh to start up.

Be aware that extensions can cause problems. For example one extension that gives you the
ability to use your digital camera might conflict with another designed to let you use your
tape drive. While sometimes you might be able to solve the problem by contacting the
manufacturers of the products and finding a working version, at other times you simply
have to shut one or the other extension off.
That's where Extensions Manager comes in handy. You could, for example, create one set
and call it "Tape Drive" and create another set that you named "Digital Camera".

Using Extensions Manager
1. Select Extensions Manager from the Control Panels menu. You'll notice that the view
is very similar to viewing the contents of a folder as a list. (If your Extensions Manager window looks different from the one here, choose View>as Folders from the
Menu bar. Now it should look like ours.) On the left side are triangle buttons indicating which folders are opened in the list. Click the triangle so all the folders are
collapsed and only the category heading is displayed for each folder. The dialog box
should look like this.
D
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Extensions can prove quite
problematic. At times, they
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Extenlou
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can cause your machine to
"hang" during the startup
process. When this happens,
your machine begins to
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freezes up (nothing works
and nothing happens) or
displays an error message.
Being able to turn off
extensions during the
startup process will let you
get to the desktop, where
you can begin to diagnose
the problem. We discuss this
issue at length in the

2. From here you can see the primary categories of items that you can control from
Extensions Manager. Notice the plus (+) and minus (-) signs in the left hand column?
A plus sign means everything within the folder/category is activated at startup; a
minus sign means that some things within the folder are turned on, and others
turned off; a blank checkbox means that nothing in the folder/category is active.

Troubleshooting section.
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3. Click the Duplicate Set button. You will have the opportunity to name the new set.
Call it "No Appearance". Click on the Control Panels icon and turn off Appearance
and Apple Menu Options.

n ____ _

'

E!l8
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extension that lets you use a
digital camera.

Unchecking the box next to a control panel or extension deactivates it on startup.

Control Panels give you
control over many of the
basic settings for your
computer.

Fonts are available to any
application you use, such as
word processors, page
layout programs, or image
editing tools.

Startup items, which are
programs that you want to
load at startup. For example
you might put an alias of

4. Click the Restart button. When the machine has had a chance to come back up, check
out the Control Panels menu - the two items you turned off won't work.
5. Load Extensions Manager again by selecting it from the Control Panels menu. Turn
on the original set (My Settings) by choosing it from the pop-up menu at the top of
the dialog box. The two deactivated Control Panels will reactivate as soon as you
restart your computer.
6. If you want, you can look through the other folders, but make sure that you don't
turn off any extensions. It's a good idea never to turn off extensions unless someone
who knows a good deal about the Mac OS tells you to do so. Failure to follow this rule
might result in your machine not turning on at all.
7. Take a look at the Startup Items folder. It probably contains two things. Launcher,
which is normally active on most Macintoshes, and Stickies, which we made a Startup
item in a previous lesson.

your word processor into
this folder ifyou wanted it
to be available whenever
you started your machine.
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You can make any program or file load at startup by creating an alias and
dragging it into the Startup Items folder in the System Folder. Later, ifyou want to
turn it offfor some reason, you can do so from Extensions Manager.

8. When you're done looking around, close Extensions Manager.

File Exchange
File Exchange is a control panel that allows you to identify which program you want to use
for specific types of files (like a word processor for text documents or Photoshop for image
documents). Secondly, it lets you map extensions from Windows systems (such as .doc,
.p65, .jpg) to specific Macintosh applications.
This is a very handy utility, since it lets you open a file created with another application
(one you don't have) using a program that you do have.
D
- · ·.
I
PC EXchllnQe

.

~B

File Translation ..___ _..:.:.:.;....:.:...::..:::____ _.....;.l~J

(irTranslate documents 11utomatlca11y
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El Include appllcetlons on servers In translation choices

[iii

Trusl1t1.. Pnferencee
Crutor: ' ????', Type: 'TOO'
Creator: 'Al06', Ty~ 'ALB6'
Creator: 'FSX3', Ty~ : 'TI FF'
Creetor: 'llfWR', Type: 'TIFF'
Creetor: '\19rd', Type: 'EPSF'
Creetor: 'ZIP'. Type: 'ZIP'

I

fl Adobefl PageMlker• 6.5
II Adobefl Photoshopfl 5.5
II Adobefl Photoshopfl 5.5
II Adobefl Photoshopfl 5.5
stufnt Expender...

Add-

File Translation lets you identify which Macintosh program you want to use to
open specific types of files.
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F111 Type
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~ GrephlcConverter
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zip
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D
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D

XWOd

D ZIVU
D z1p
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PC Exchange lets you map specific extensions on the PC to specific Macintosh applications.

General Controls

The General Controls panel lets you make changes to settings such as the cursor blink rate,
which folder you're looking in when you go to open a file, and whether or not Launcher is
added to the Startup Items folder.

a

General Co11trols_!: •• =~
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0

Foldtr U..t Is sot by tilt >ppl ~•tlon.
f) Lut foldtr usod In tht >ppllo•tlon.
0 0ooumonts foldtr.

to ~

I

Thiscontrol panel lets you change the cursor flash rate, how fast menus blink
when you select them (ifat all, and let'syou determine where a program looks to
open or save a file).

Keyboard

The Keyboard control panel lets you pick the language you're going to be working in
(which changes the behaviors of certajn keys), and the repeat rates for the keyboard. The
Options button allows you to determine how keys will react when called in a an AppleScript
program.

98 C HAPT ER 4/BUILT- IN TOOLS

DC:="""

:.'._Keyboard ll=•L

i.

118

r' Keyboard Layouts
,
Selected teyboenl leyouta viii dlapley In tho
teybotrd menu vhen more thon one la aolected.

I

1~I

Script Roman

0

Options

=

Swedish
O ; Swiss French
O ljjl Swiss German
li'.IJ!! U.S.

,,,

I

-

Keyboard Menu Shortcuts
To rotate to the default kO'/boe rd layout or Input method In the
next $Orf pt press ~

ICil• ....l.e....__....
c:J usecommalld+Optlon+Spece to rotate to Ille next

kaybOenl leyoU1 or Input metllOd In tho ectlve $Crlpt

,... Key Repeat
Key Repeat Rate

I I
Slw

~

I~:

OelOll Untll Repeat

r..t Short I

!E~H~· 1
...-....__....
( Cancel~

I

I
'

I
loh\l
Off

=OK=;;i,J

fr i"(

~

I Options- I

Im

You can control the language and response rate ofyour keyboard from thiscontrol panel.

Launcher
Launcher is a window that appears at the bottom of your Desktop, as well in the Application menu (on the far right of the Menu bar)
ti

l

r

Launcher

~ ~

S..-11>1 Editor

SlmploTtxt

~

.i•JW

,.
tide F111der
Hide others
Show All

Eil Adobe& PageMalcert> 6.5
"'CJ Finder
~ Launcher

Launcher provides an easy way to manage and launch the programs, files, and folders that
you use most o ften. It allows you to create buttons, organized into logical groups, for each
of these items. Lastly, it is an application that can operate simultaneously with any other
programs you might be using, letting you quickly access files from a standard location.
Even though the Launcher is a control panel, it does not have a dialog box in which to make
change settings. When you start the program by selecting it from the Control Panels
submenu (under the Apple menu) or double-click on its icon in the Control Panel folder,
the Launcher appears at the bottom of your screen.

Using Launcher
1. If it's not already on your desktop, start Control Panels> Launcher
. -·,;,.;,,;;;211111115

Script Editor

Launchu t! ?! !! !! : ' =

a" j_

SlmpltTt •I

The Launcher window is a launching pad for often-used applications, files, and folder.
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2. Open the System Folder on your Hard disk, choose View>as List, and scroll down
until you see the Launcher Items folder. Click the triangle button to view its contents
if it's not already open.
-- QHlnlllrtvel ____ -

Today, 12:49 PM

Whenever you want to add

Wed. Apr 26, 2000, 7:17 PM
Wed, Apr 26, 2000,6:38 PM

something to Launcher,

~

simply drag the icon onto
the window. An alias will be
created and the original left
intact.

3. You'll see two aliases in the folder (you can tell that they're aliases because their names
are shown in italics). They correspond to the items in the Launcher window.
4. There are two ways to put items into the Launcher. First, you can drag something
directly onto the Launcher window. Second, you can create new Category folders,
which we will do in the next exercise. Drag the Launcher Items folder onto the
Launcher window. Watch what happens.

Today, I :03 PM
Today, I :03 PM
L.unchtr llfllls

S<r lpt Ed lt0<

Wed, Apr 26, 2000, 7 : 17 PM
Wed, Apr 26, 2000, 6 :38 PM

Keeping the Launcher Items folder in Launcher makes it easier to remove items.

5. An alias of the Launcher Items folder was automatically created when you dragged
the folder onto the Launcher window. Close the System Folder. Now whenever you
want to access the Launcher Items folder, all you have to do is click the button.

Launcher is one of those
very personal preferences.
We use it during courseware
development, but many
skilled operators find that it
doesn't really save them
any time. The more you
refine it, using Category
folders and logical organization, the more effective
and productive it becomes.
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6. Keep Launcher and the Launcher Items folder open for the next exercise.

Launcher Category Folders
You can create Category folders within the Launcher window. These special-function folders
become Category buttons which appear across the top of the Launcher window. They allow
you to segregate items by function, project, or any relationships you might find useful.

CHAPTER 4/BUILT- I N TOOLS

Creating and Managing Category Folders in the Launcher
Inside the Launcher Items folder, create a New folder and name it"· Tools", using
Option-8 to create the bullet (•) character. (Please note that there is a space between
the bullet and the word Tools in the folder's name).

l.

Wbl,Apr 26, 2000, 7:17 PM
Wbl, Apr 26, 2000, 6:38 PM
Tocloy, I :42 PM

In this exercise, we use the
Option-8 bullet character
(·). There are dozens of
special characters available
to you on the Macintosh.
Simply select Key Caps from
the Apple menu, and try
holding down the Option
key. Thegraphicofthe

2. Look at the Launcher window. See what happened? There are now two buttons across
the top. The one named Applications is automatically created as the highest level of the
Launcher window whenever you create a new Category folder. The Tools category was
created from the"•Tools" folder.
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Launohet' lttmS
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key will create. Among them
are the trademark (™), the
degree (96°in the shade),
and more.
™is Option-2
0

is Shift-Option-8

•1

.l~

Ifyou create a Category folder in Launcher, the root folder is named "Application"
by default.

3. Click the Tools button in the Launcher window to activate that Category folder. Open
the Control Panels folder, and shift-click to select the following four items.

Try using Keycaps to find
others that might be ofuse
inyourwork.
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4.

Drag them onto the Launcher window. Make sure that Tools are active; there
shouldn't be anything in that window at the moment.

5. The four Control Panels will appear in the Launcher Tools window.

Ifyou want to create a

Category folder inside the
AppltHtnu
Options

Launcher window, you have

Datt & Ttm.

Gtntr1I Controls

to use the special Option-8
bullet(·) character, or else
the folder will simply be
another button in whatever
Category folder you were in
when you created it.

6. You can close any windows that might be open, but leave Launcher active.
Launcher is arguably one of the more powerful productivity accessories that come supplied
with your Mac OS. As you gather applications and begin to work on multiple projects, you
may find- as many do, that using Launcher can save you mouse clicks. And a.mouse click
saved is an extra minute to think.

Acrob1t1M

Toast

Dlstllltr"" 4.0

--·

The Launcher Utilities category folder in our system, populated with commercial software.

You might notice that when
you drag an item onto the
Launcher window (or a
Category folder) and an

Memory
The Memory control panel provides you with several tools with which to manage the
internal memory of your Macintosh.

alias is created, it doesn't
contain the word "alias" in
its name- nor does the
name display in italics in
launcher. In the Launcher
Items folder, however, the
names are in italics.

The Memory dialog box
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There are basically three different settings that you can control from this dialog box.
• Disk Cache. A disk cache is a portion of your computer's hard disk that is
reserved to hold files, folders, and applications that you use most often. The
Mac OS tracks this usage information and stores components of these items in
the Cache. Generally speaking, a 7k or 8k Cache is sufficient for most users.
• Virtual Memory. If you don't have a lot of regular RAM memory, you can set

aside a portion of your hard disk to fool programs into thinking that you have
more memory than you actually do. Since memory is relatively inexpensive,
most users choose not to tum this on. It can slow down your system, because
information is constantly swapped back and forth between real RAM and fake
(disk-based) RAM.
• RAM Disk. A RAM disk is the opposite of Virtual Memory. In this case you set
aside a portion of RAM memory that acts like a hard disk- except much faster.
Users working with a lot oflarge images often create RAM disks to store their files.
Mouse
You saw the Mouse control panel early on in the course. You used it to change the speed
and click-response time of your mouse or track pad.

e!l----- --~~..

. _- J!I

The Mouse control panel provides controls over mouse tracking and double-click speed.

Numbers
Once you begin doing business internationally, you quickly realize that not everyone in the
world formats numbers the way we do here in the United States. The Numbers control
panel provides a method of formatting figures using a range of different International
conventions, so if your Macintosh finds itself in, let's say, Finland, it will be able to figure out
the difference between your Markkaas and your Pennias.

-- -- ---. - -~-J~~,~~ Number Format

··--~

ru.s;; ;~;: ~~ ~:;;__3~J
r- CUrr.noy - - - - .

Decimol:

D@

Thousands:~(!)
IS1mplt

Symbol:

ll-~~:JI

e Bef~ number
O After number

~1,234.56

Ifyou want to see how the Finns format their numbers, use the pop-up menu in
the Numbers control panel to take a look at how others count. We wouldn't want
to get into a verbal math contest in Finland.
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Sound
The Sound control panel provides several choices for setting the sound sounds into your Macintosh (input) and getting sound out (output).

Alert Sounds
Input

both getting

Oloose o device for sound output
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-: ' I.___
~···-I
n -~----,--,-,-----'---'~

~tput
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Volume:
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Ifyou have third-party sound hardware, it would display here.
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I
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The Macintosh comes with the Simple Beep as the default sound. You can listen to
the others from this dialog box.

Startup Disk
When the Macintosh goes through its startup procedure, it checks to see if there is a System
Folder with the requisite extensions and accessories available on your internal hard disk. If
it doesn't find a System Folder, it can't start up at all.
There is more about the
Startup disk in Chapter 9 on
Troubleshooting. Ifyour
Macintosh can't find a
System Folder when it starts
up, it will stop andjust sit
there. Using the Startup
Disk control panel can
provide relief from the

When we talked about using Extensions Manager to create special Startup sets, we indicated
that at times you might want certain accessories, extensions, and fonts available for specific
needs. The Startup Disk control panel takes this concept a step further and let's you set any
hard disk (or partition of a hard disk) as the Startup Disk- or the drive from which the
Macintosh loads the System Folder and resources.

If you have a System Folder on more than one hard disk, then you can use this accessory to
select which hard disk you want to start from. This window shows that there is only one
system folder- and that's on the internal hard disk. That's why the other icons are
dimmed.

problem.
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Text
Last in the list of control panels and built-in accessories is the Text control panel. This is
another tool designed to allow you to internationalize the way your Macintosh behaves.
l!f£

-=mrexr
Text

Script

Audio CD Player
A great addition to your collection of built-in programs and tools is the Apple Audio CD
Player. The Player automatically launches when you want to play music on your Macintosh.
If you put a CD into the internal CD drive, its icon will appear on the Desktop.

If you double-click an audio disk, you will see the tracks on it, with their own special icons.
1;1..·
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You can see the tracks on any CD - unfortunately you can't see their names.
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Double-clicking any of the icons in the folder will launch the Player, and you will see a
window that looks remarkably like the front of a high-end stereo system, with the same
controls that you would expect from any CD Player.

You can set several options
from the Player's Menu bar.
For example, you can color
the window, controlyour
speakers, and decide

You can click in the Title and Track fields and enter the names ofthe disk and each
track. The Mac will remember these names next time you insert the same album.

whether or notyou want a
CD to automatically start
playing when you insert it
into the drive (the Autoplay
option).

•

Help
Wlnilow Color
lndlcotor Color

~
~

Sound

~

Stortup CO Drive

~

'J AutoPloy

While the built-in Player is a neat tool, and quite helpful, if you're really serious about doing
more than playing music from a CD, then you should check out some of the commercial
applications out there. A good place to start would be the Real.com site, where you can
download RealPlayer and RealJ ukeBox, two powerful tools for managing your music
library, and downloading music to portable players.

Quicklime
QuickTime Player is a system tool supplied with your Macintosh that allows you to play
movies, animations, and sounds created in a wide variety of different applications.
QuickTime itself is more than the Player - it's a complete suite of system extensions and
tools that provide the Mac with a built-in ability to view movies. QuickTime is an industry
standard, and used on the Windows platform as well as the Mac to provide this additional
functionality. Although it's not the only way that movies can be played, it is a unique and
powerful feature of your Mac OS.
There are several versions of QuickTime. The one that came with your system, and a
commercial version that provides additional functions - such as the ability to cut and
trim clips, combine them together, and overlay music. Naturally we can't cover all the
extended functions and applications of QuickTime technology, but if you're into professional video production, you will find many resources on the Web and at Apple's site
about how to learn more.
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Most popular media applications can save in QuickTime format and read QuickTime
documents. If you attempt to open a video or sound file created on another system, you can
choose to use the QuickTime player from the Application dialog box.
could not find the application program that created
the document named •sol.mov".
To open the document, select an alternate program,
with or without translation:
FreeHand 9wlth Quicklime translation
@Network Setup Scripting with Quicklime translation
~ PlctureVlewerwith Quicklime translation
Quicklime Player with QulclCTlme translation
Qulcl:Tlme Player
SlmpleSound with Quicklime translation

!ill
Ill

!if Show only recomm ended ch1~ces

I cancel I I!

Open

I

Ifyou want to view a video or listen to a sound file created on another platform,
try using the QuickTime Player. It knows how to translate most popular formats.

The Quicklime Player
When you open a compatible media file, the QuickTime dialog appears. If it's a video file,
there will be a black screen where the clip will play. At the bottom of the window is a Play
button and a Pause button. The following illustration should help you understand how the
Player operates.

File name
View Window

L
Play
Volume Control---+

Pause

Info

Fast Forward/ Reverse

Show Controls
Sizing Handle

Sound Controls

The QuickTime Player dialog box.

CHAPTER 4 / BUILT-IN TOOLS

107

Once a movie has successfully loaded, clicking the Play button will start the movie playing.
The controls at the bottom of the window act exactly as they do on a regular VCR or DVD
player, with fast forward and reverse, sound controls, a pause button, and a timeline
showing how long the movie or sound is, and how much of it has played.

The movie begins to play. You can load this movie about an extraterrestrial
(Sol.mov) from the SF-MacOps folder. It was created in Adobe Premier, but can be
run in the QuickTime Player window.

You can use the slider on the timeline to advance a movie, rewind it to a specific location, or
begin playing it at any point. As you move the slider, you can see the frames advancing in
the Player window.

The time line slider gives you direct control over the movie or sound clip.

Channels
Another excellent feature of the QuickTime Player is the ability to play Channels - special
Internet sites specifically optimized for use with the Player, with much of the available
content in QuickTime format.
Window Help
Add Favorite

•o

Organize Favorites_
••
aose Favorites Dniwer • I
Qulclffime Showcase
Disney
NPR
68CWortd
Fox News
VHI

HBO
ABC News
The Weather Ch • nel

61oomberg
fox Sports
warner Records

AolllngStone
ESPNNews
WG8H
Movie Previews

Ifyou look under the Favorites menu, you will find a number ofpreset "favorites"
which are channels of QuickTime content updated on an almost constant basis.
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Our ATC staff is based in Florida, so you might think we don't care much about the
weather. We live in constant danger from hurricanes, tornados, lightning, and torrential
downpours. That makes watching the Weather Channel on our Macs particularly comforting.

Dally Weather Animation
TNs day In weather hlstoty
or Q6A wltn our MeteorclOglslS

Jet5tttam and front traclclng
1nrormauon (no soond)

Having a high speed direct connection to the Internet makes using Channels a
more rewarding experience.

Chapter Summary
In this Chapter you gained a good deal of experience with some of the built-in programs
and applications that were supplied with your Macintosh. We discussed the concept of the
Apple menu and control panels, and looked at several different ways to access the items
they contain. We spent time looking at a range of different tools, including the Extensions
Manager, which allows you to choose the programs and accessories that will load at startup.
We spent time learning how to set up and manage the Launcher control panel, a highly
productive application designed to act as a launching pad for programs, files, and folders
that you access often. Finally, we learned how to use the built-in CD Player to listen to our
favorite sounds directly on our Mac, and how to use the QuickTime Player to view movies
and animations.
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Notes:
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In Chapters 1 through 4, you learned about the basic buildir~g blo~cks of _
the Macintosh Operating System' (Mac OS). After completin'g thefusthrlf
of this course, you should:
·
:
,~
",

I

.,.

,· Know w~~t ~e Ma( OS is-and how it ·controls; basic fun~t!ohs of t h€'_' \' . ~; :":.~
1
computer through two main interface C:omp.o nents - the~Desktop · , .' ·.
and the Finder. You. sholll~ also ·h~ve· a basic understanding of~
-· ...:~. :..
memory and,di.-ive storage. .and th~.diff~rence' between. the ~o.
, .. :
-

t

.,..

'

'.
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..

\

.../

I, ... . ,..._

Understa111d li?W to use the m<!>qse and ~he.l<,eyboarq~ h1cl:µding the ' .. : .. ~~~:(
two core modifier keys·-· Command and Option. You sh.ould be' ab(e_· _· _,
to use menu bars. Addiffonally, you should'b~ comfortable managing~-, · ;":_. '
1
wirfdows o~ !he desktop/ ~ith.in which Il)~ch of your work wµI;be
.\, - • •
storrd and qrgan'ized . . ·i. -; . •
.·.
' .
\'
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. ·, •
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'
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Know, how to use the ~uilt-'n Mac J:Ielp syste1:1, which_pi:.o,vides '
extensive documentation fu an easy-to-use,
searchable
database.
.
I
.,...
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.
I
-

~

t

I

I

Be. familiar with Folders, what they are, how to create them, how t'o .
ma9age '!Jiem,'an'd how to ~hrpw·ttiem a'Yjy. You should' be conifq_rt~, ' . ~~:::-..
able with navigati!}g intp.folders to find whatxou're looking for..:.,You ,. . ,, " should' know how to control the way items are displayed through the ~ ,: ~
use of the View comm~nds:
· ·
',
· ., ' " '• , ·• :r:. ~
; Understand how ~rograms ~r~ate ftl~s, and how_t'0.start a pr6gram ' . / .. · 1'·
from the~desk!qp. You shoul{:l feel comfortable saving files i,nto~spe,- · ,,
cific folderst and making aliases of important files to cut. do~wn the. '
time·it takr~ t~ open th~m. You should know ~ow to .ent~r-texli;to a. -!. . •:-·;
simB_le word ,~rocessor ql}d how ~o fo.r mat !t.e xt using font ~tyles.
1
Understana how to access and use the,ny-ot)rpes of built-in too1sAppie MeHu Items ar{d ¢ontrol Panels. 'four knowledge.shotild
~,
include µow tQ use the C<il.~ulator feature, how to~ change the appearance of your desktop, h9"".''to l.ise·StiGkies {b'uilt in ·desk.top notes),y
how to co.rltrol which •EX.tens.ions Iloaff at·startup.; and how tu.acth~at~ \
and manage iauncher, -a p·owerful utility that gives you in stan,faccess
1
to your most import,ant--fi:les and folders .
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• Ink Jet. An ink jet printer sprays ink onto the paper from small nozzles in the
print head. Many really large format printers (used for signs, banners, and
posters) use this technology.
• Dye Sub. Dye sublimation printers spray a special heat-sensitive colorant onto
the page and heat it, bonding it to the surface of the paper. Some very high-end
digital proofing systems use sublimation technology.
In most applications,
Command-P brings up the

Printing from a Macintosh

Print dialog box and Shift-

Whenever you issue a print command - whether from a word processor, image-editing
application, or page layout tool, it's the Macintosh Operating System that actually handles
the command. This is another aspect of the Apple Developer Guidelines, which we discussed earlier in the course. Printing resources are a part of the Operating System. Software
developers need only to connect their programs to the tools provided by Apple, and the
Mac takes over.

Command-P accesses the
Print Setup dialog box.

Among the advantages of this approach is that printing from one program is the same as
printing from another. While it is true that some applications (necessarily) offer more
sophisticated printing controls than do others, the process remains the same from program
to program.

Elements of the Printing Process
There are many popular
laser printers on the market.
Hewlett-Packard is the
dominant manufacturer of

There are four different components that come into play whenever you want to print your
work on a Macintosh:
• Application program. T he first element is the program that was used to create
the file. Examples might be the use of Microsoft Word to create a business plan,
containing spreadsheets created in Microsoft Excel.

office laser printers, with
Canon and Tektronix

Printer: I LaserJet 5

9 .7

I~I

leading the pack in color
printers designed for the

Coples:

graphic arts marketplace.

EJ O

Pages: f> All
O From:

Other manufacturers,

Collated

CJ To:~

including Epson, are
beginning to produce
extremely high-quality
color printers that are truly

I

Save Settings

I

Cancel

I ff

Print

I

inexpensive. Although
they're not designed for

This dialog box is displayed when you issue a Print command from the Finder (File>Print).

high volume output and are
somewhat slow, for under
$400 - and in many cases
under $300 - you can
produce really great color

• Printer driver. T he second component in printing a document is the printer
driver. We talked about drivers a bit in the last chapter, when discussing extensions. A driver is a specialized type of extension designed to facilitate communications between your Macintosh and other hardware devices, such as printers. A
print driver is a small program that you access either through Chooser (an

from your Macintosh or
Windows workstation.
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Apple Menu Item that we'll be using later on) or, in some cases, from within an
application's Print Setup dialog box.

• System extensions. The third component is the System extensions, such as

Remember that printing a

Chooser and Print Monitor, that provide the tools to set the priority of printed
jobs, pause, cancel them, or set specific time schedules for when they should be
sent to the printer.

file to a printer- no matter
how simple or sophisticated
- is only one form of
output. There are others. For

~

PSPrlnter

m

Acrobat" POFWrlltr

example, the Macintosh is
very popular in the video
production and postproduction industries,
where output is done either
to high-end editing systems
or directly to a variety of
different forms of video
tape. Video can also be
"output" to digital media,
such as interactive CDROMs. Another category of

~

t ...rwrlttr8

~

Adobe PS

~

Pr intMonltor

Here you can see several printer drivers and the Extension for Print Monitor.

• Printer. The fourth component of the printing process is the actual printer, also
called the output device, that will create the hard copy of your digital file. There
are many different printers available in the marketplace. In today's world, we
would argue that laser printers dominate the field. They're reasonably priced,
offer a wide variety of options, including large format sizes (11 x 17 in.), color,
and the common ability to output to transparency materials.

THE PHASER 750

EXCEPTIONAL COLOUR LASER PRINT QUALITY

output devices are known
as "slide recorders," which
are often used to create
35mm slides for use in
professional presentations.
Some presenters simply
output their slides directly
to a video projection device,

Worbroup Smart - Internal hard
disk olfers software. manuals,
videos and browset·based
support.

that projects their slides
onto a screen.

Remember that the Finder is
an application program, so
you can print from the
Desktop. You can output the
contents of any window
using any view that you
choose to set for the folder.
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This image is from the Tektronix web site. The company (part of the Xerox family of
companies) is a leading manufacturer ofcolor printers (note the British spelling of
colour)

Ifyour work is destined for high-end commercial printing, you will also learn about devices
called Imagesetters or Platesetters, which are like laser printers but with the ability to output
very small dots. The smaller the dot, the higher the resolution of the device is said to be.
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WYSIWYG, pronounced
'Wizzy-Wigg" is a term used
by professionals in the
graphics industry for 'What
you see is what you get."
Recently, computers have
begun to have the ability to
accurately display on a

As we,ve seen so far, the Mac OS is a visual experience; every aspect of the Macintosh is
based on a graphic interface. Yoµ can see the available choices in any dialog box; you
immediately see the results of a font change; windows display scroll bars, close boxes, and
you, re able to view their contents in a variety of ways.
Displaying or viewing your work on a monitor, however, is only half the battle. The other
half is creating what's called hard copy. Hard copy can be anything from a simple page
output from a laser printer to the glossy, perfect-bound annual report from a Fortune 500
company.

Output
Printing is a form of output. There are basically two ways that you can look at what's on
your system. The first is to look at it on your monitor, and the second is to print it as hard
copy.

monitor what will be
produced on a printing
press, digital output device,
or proofing system.

A proofing system is a high-

end device that prints an
accurate hard copy of what
will be reproduced on a
printing press. Some of
these devices reproduce the
image directly from data
created on the Macintosh.
Such systems are used by
large publishing houses to
generate "final-proof
pages"- the ultimate
Wizzy-Wigg that shows
embarrassed (and possibly
soon-to-be fired) members
of the editorial and
production team every
mistake they forgot to fix.
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Monitors
Your monitor is the window into what's going on inside your Macintosh. Almost all
computers are equipped with color monitors these days, and if you,re going to be using
your Macintosh to create graphics and other visual items, then it is critical to have a color
monitor.
The next issue to consider when thinking about your monitor is how big it is. Since many
Macintosh programs use a varied collection of tools that sort of "float,, around the screen in
their own little palettes (you,ll leam more about this later), the amount of space you have to
arrange your work, the tools you have available, and other things you might want (or need)
to have available to you at the time, becomes very important. The general rule of thumb is
to buy as good (and big) a monitor as you can possibly afford. If you, re working on your
system all day- as many of us are - it's much easier to sit there if you're not looking at a
tiny screen and spending a lot of time arranging things on the monitor.

Printers
The printer your computer is connected to is a critical component in your system. Without
the ability to create hard-copy output, all the work that you do on your system would be
"stuck" on your Hard disk- and you wouldn,t be able to show it to anyone, use it for
communicating with the outside world, making cool pizza flyers, worldwide best selling
novels, or the latest recipe from your social group.
There are several different types of printers:
• Laser Printers. Laser printers are probably the most popular type of printers in
use today- especially in the graphic arts. A laser printer works much like a
photocopier, using toner to image the page. They come in several different
configurations, and are available from a wide selection of manufacturers.

• Dot Matrix. Dot matrix printers use a print head comprised of some number of
small pins that drive ink from a ribbon onto the surface of the paper. They are
mostly used for low-end accounting and noncritical graphics functions.

Chooser
Chooser is a system-based tool that serves several purposes. In an environment where there

is more then one printer (either attached directly to your system or on a network), Chooser
lets you select which printer you want to use to output a specific job. That's the feature of
Chooser that we're going to explore in this Chapter.
Ifyou want to see some
really expensive, high-end

The second function of Chooser is to let you select networked volumes, servers, or specific
portions of the Hard disks of other users on the network. Those functions will be covered
in a later Chapter, when we talk about networking and connectivity to other computers.

output devices in action,

Fiie Edit Help
About Olooser_

you can always make a call

A[) Apple System Protller

!ID ATM Deluxe

to a few local printers or

Colculator

imaging companies. Most

Control P11nels

of them have systems that

Ill fovorttes
Gil Key Cops

work in commercial

L-,Metronome
Network Browser
Remote Access St11tus
~ Run Dally HD2
l1S Scr apbook
Screen Sn11pz
~ Sherlock2
Stickles

manufacturing environ-

el
d

ments, where extremely
high resolution, accuracy,

f3

and "repeatability," or the
ability to produce exactly

The Chooser is an Apple menu item.

the same image dozens or
hundreds of times, are
critical requirements. Most,
if not all ofthem, would be

By selecting Chooser from the Apple menu, you gain access to a dialog box from which you
can select printers or network resources.

more than happy to
arrange a tour at a
convenient (for them) time
for a student of their
industry. Talented and
skiffed individuals are very
hard for them to find, and
they're always interested in
meeting new people.

s

•

Acrob•t"' PDF\l'rit•r

Selec t a Postscript Printer:

~

LaserJet 5

Adob•PS

AppleSh•r•

Used to create a driver
when you install a new
device on your system
or network.

~

PSPrinlt r

e Active

ll==== ======"'=="'::::!I

AppleTa lk

Printer Drivers

Q Inactive

7 .6.2

Network Activator

Chooser is the place from which you control printer and network resources on the Mac.
C HAPTER 5/PRI NTI NG

117

On the left side of the Chooser window are the icons representing the various devices to
which you can send a file, as well as an AppleShare network icon. In this illustration, you
can see an Acrobat icon as well, which is a sort of virtual printer which we'll discuss a bit
later on in this Chapter. There is a generic PostScript printer, and a few actual drivers for
printers on our network.
Postscript is a Page
Description Language

If you select a printer driver from the left side, the right side of the dialog box will display
the printers that are available from your workstation. Select one, and the next job you print
will be printed on that device.

developed by Adobe
Systems ofEmbarcadero,
California (http://
www.adobe.com). Before
the introduction of
PostScript, each printer had
its own way ofinterpreting
data being sent to it from a
computer program, and
every program had its own
way ofdescribing a page to
a printer. PostScript is a
computer language built
into many of today's
printers - especially ones
usedinthe ~
,
graphic arts
world.It

0

uses a
mathematical
model to describe curves,
shapes, fonts, fills, colors,
patterns, and objects, and
can therefore send the
same page to ten different
printers and have them all
come out at the maximum
resolution each device is

Creating and Configuring a Printer
When you buy a new printer, or move one from another machine onto your system or
network, you have to create or install a driver for that device. In most cases they're supplied
with the printer (usually on a floppy disk or on the CD that comes with the device). If
they're not, almost all manufacturers maintain web sites from which you can find and
download the required software for any of their printers. You simply put the driver in your
System Folder ( in the Extensions folder) and restart your machine. The Mac OS will then
load the extension and you'll see it in the Chooser next time you access it.
There's an even more productive way of handling more than one printer on your system
than opening Chooser and selecting the device. You can use Chooser to create something
called a Desktop Printer, which is an icon that's placed on the desktop. When you've created
a Desktop Printer, you can simply drag a file onto the icon, and it will automatically be
directed to the correct printer. If you work in an environment where there are several
different printers available, and you find yourself using them all at various times, then this is
probably the best way to go about managing your output.

Creating a Desktop Printer
1. Open Chooser. You should see several icons on the left side of the window, representing printer drivers installed on your machine. Pick one of them, then pick a printer
from the right side, and click the Create button.

g ___,,........

i

m

' '

...

~

-

Acrobat... POFYrittr"

MoOtl'S

~

..-11or 8

Aj>plo51>¥•

~

PSPrln\tt'

Otooser c:=:.

i.!.

=-=-· .

rm_Z!llL±

Select a Postscript Printer:
~~Las~!,l!l l s

Setting up "LaserJet S".
Status: opening printer connection.

~

[

It was the introduction of
in Apple's first laser printer
the desktop publishing
revolution.
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-~,

~-

~

=

i:'.l!ii:S~',s...:s:§:SS~

"resolution independence."

(the Laserwriter) that led to

A
...,.,

capable of. This is called

Postscript, and its adoption

'B

~

I

Setu!!:J

AppleTalk •Active
0 Inactive

SelectPPD

l I

Cancel

7.6 .2

Ifa desktop printer has already been set up for the device that you select, you'll see
the Setup button instead ofthe Create button. Ifthis is the case, close Chooser, find
the icon on the Desktop, and delete it. Reopen Chooser and start this exercise again.

I

2. You will see a dialog box from which you can select options for the printer. Your
Mac OS will automatically select the proper drivers and settings for the device that
you selected. Select Printer Info.
Current Printer Description me (PPO) Selectl!d:
• .., LaserJet SM"
Current Printer Description Flle (PPO
Prlhter lnfonnatlon:

"II' LaserJetS',1"

When you're in most dialog
boxes on the Macintosh, the
Escape key (marked esc in

I

Auto Setup

1-~nter Info

Si]ertPPD-

I

~ r Conllgure

the upper left corner ofyour

Prlhter ~ame: LaserJet S
Zone; "'
Product Name: HP LaserJet SM
Postscript'" Level: 2
Postscript'" Version: 2014.~B
Postscript'" Revision: 1

keyboard) will cancel the
action and close the dialog

The Printer Info dialog displays information about the selected device.

box. Try it.

3. Click OK after you've looked and the information about your printer. (When you're
on the phone to tech support to find out why your printer is spitting out garble, this
is where you'll find some of the information they'll ask you for.) The Update button
will cause the Mac OS to go out and "poll" the printer to refresh the information. You
might do something like this after you install more memory, for example.
4. Click the Select PPD button. PPD stands for PostScript Printer Description files, and
are a collection of extensions that come with your Mac and correspond to most of the
major printers in the marketplace that you might come across in your travels. They're
installed in the Extensions folder in the Printer Descriptions folder.
Select 11 Postscript"' Printer Description File:

I 13 Printer Descriptions t ~ I = Hllrd Drive 1
HP LaserJet4MP (300 dpl)

D HPLaserJet4SI (300dpl)

fje ct

D.., LaserJet 4SI v2011.110

Desletop

~~1erJ!!t5M

Generic

D HPLaserJet4V
Ifyou have a Desktop
Printer icon on your
Desktop with an X through

D HP LaserJet 5MP
D HP LaserJet SSI
D HP LaserJet 110 v52.2
HP LaserJet Ill

Cancel

Sele~

I

Printer fl.1odel:
14' LaserJet SM

it, this means that the
necessary extensions
(Desktop Printing Extension

5. Select the proper PPD for the printer you're working with.
6. When you're done, you can quit Chooser.

and Desktop Printer
Spooler) weren't loaded.
Check your Extensions

7. Look on your Desktop and you'll see the icon for the desktop printer we just created.
Select it.

Manager to make sure that
they're loading and restart
your machine.
Ifyou have more than one desktop printer, the default printer (the one that will be
used ifyou don't select a different one from within Chooser) is the one with the
dark border around it.
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8. Notice that when you've selected a Desktop Printer icon, the Finder menu bar
changes - there's a new item called Printing.
Help
Print Queue
Print Queue

]

e Setup_
Manu•t Feed Alert
fault Printer ICU

When you install a printer
driver on your Macintosh,
an icon for the printer is

9. With the Desktop Printer icon still selected, go to the File menu and choose Info (or
press Command-I). A dialog box will appear that displays general information about
the device.

automatically placed on

LaserJet 5 lnfO

your Desktop. Ifyou try to
drag the printer icon to the
trash, you'll find that the

r show:I General lnfonna~on

system won't allow it. Ifyou

j:

KIMl:deaktop printer
Type: L8"'rWrltor 8

z1 ..:*

do want to get rid ofprinter

Prl1ter: looerJet 5
W..re: flard Drlvt 1:

icons (not the printer drivers
themselves) start up your

Creeled: wed, Jun 14, 2000, 12;23 PM
Medlfled: Wed, JU~ 1 ~. 2000~ 12:Z3 PM

Macintosh with no

4: l

L•Mbl\Nue

extensions on (by holding
the Shift key during the
Startup process). This will

Prl1t1., 11e-ry ~1lr•M1ts-
S~ed Size: 350
K

turn offall your extensions

f

(including the ones related
to desktop printers and

Mlnlm•l!lS1ze: ~ K
PreferredSlze: ~ K

drivers) and let you throw
them away for good.

10. Select Status and Configuration from the pop-up menu at the top of the dialog box.
:

~ l1.aserJet5

Ifyou're working in critical
need to be sure that what
you see on your monitor is
what you will get when you
print your files. Apple

I!

CUflgaretlH:(WH. J . . 14.

colorenvironments, you

e

±#I LaserJet 5 lnfli

zooo. I Z:ZB Ptt)

PrintH"Hamt : USff".Jtt~

Zont : 111:

Pr-t ,..,,,.; HP Wtf".HI :51-1

L Show:
Kl

.1

General lnfonnatlon

PostS«'ip\1M U vtl: 2

PostSc::riptM Ywslon : 2014 .108
PostSc:rJpttw Rtvlskln : 1

RuolJtlon: 600 dpt
Toh1I Mtmoiry Ntllltd: 6 MB

Tobi Memory

Av1 ll~lit :

I MB

Bi»ry CommJnlo>tloM S<.opj>orttd: Yts
Color 5'.worttd: No

PPO Filt : 1-F L.asitrJtt S'1

produces excellent monitors
using color-matching
technology that accurately
displays what you will get
from the printer.

120

CHAPTER 5/ PRINTING

Notice the error message under the Current Status heading. Our own laser printer
was low on toner when we were writing this book - and the Mac knew it.

Not all documents behave
well when they're sent to
the printer. In particular, files
with large and/or complex

11. Lastly, choose Show: Fonts. When the dialog box appears, click Get Font List. The
Mac will look at the printer you've selected and provide a list of the fonts that are
either built into that model or have been downloaded (which we'll talk about a
little later).

g :_._:_C:- .. ~ LaserJetS Info

graphics - especially from

~ l~aserJet S

certain drawing programs
- can cause the printer to

-"'

~~~--~~~~~~

I

.-'Show: [fronts

generate an error message.

11

1~I --~

Av1nl0.Udt·Book
AvMIW...dt·SoolcObliquo
Av1nt.Glt'dro.nt l

Ifthat happens, your
Application menu will blink,

Boo--otml
8..--otml!Ullo
eoo.......-t.llf\l
Boolon>n-l.llf\tlt•llo

and you'll be directed to

C.....ltr
Courlor-Bold
Courlor-BoldObllqyt
Cour!tr-obliquo

Print Monitor, which will

Httvtt~

';

display exactly what the
problem is. Unfortunately, it

!

doesn't tell you how to fix

;

the problem, only what the
problem was. lfa Postscript

1

HtlvtliOl-llold

Httv•Ucr8okt0bliqw
HttvtUca-Hwrow
Htlvtllc~-tf~ow-Bokf

Httvttioa-H.,.,.ow...BokK>blkp.tt
HttvtUc.t-ffwroY-Obl""'
Htlvtllo.-Obliq.,t
N•..C.nl..-ySchlbk-Bold
NtwCont..-ySchlbk-Boldlhllc
1 NtwCont1rySdllbk-ll•lio
NtwCont&rySch lbk-RoMM\

0 Geffont Usfl

error occurs, for example,
the message will say
"Document cannot be

Most printers today- especially PostScript-enabled printers - come with a
library ofbuilt-in fonts, which can be used in any ofyour applications.

printed; A Postscript error
was generated by the
Laserwriter." What then?

12. When you' re done exploring the information dialog boxes for your new desktop
printer icon, close them and any other windows that are still open.

You go back to the original
document and see ifyou

Spooling

can simplify it before trying

The term spooling refers to the feature in an operating system that manages more than one
document at a time while they're in line waiting for the printer. In many cases, it takes a
printer a few moments (or hours, depending on the length and complexity of the document in question) to actually image the page. If you're printing a few documents, they can
pile up, waiting for the last document to finish printing. The "line" that they wait in is called
a Spooler.

to output it again.

When you're using Print
Monitor, you can select Stop
Printing from the File menu.
This will cause your Mac to

Let's say that you send three or four big files to a desktop printer. They sit in a place called
the Print Monitor. The desktop icon changes and shows a page as part of the icon.

print the documents but not
send them to a printer. Later,
when you want to send
them, simply choose
Resume Printing and they'll
all go. This saves you time if
you're not connected to a
printer at the time (for
example, when you're using
a laptop).
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When you send a bunch of documents to the printer, and double-click it, and the desktop
spooler is displayed, Listing the documents that are in the queue, or waiting list.

You can send documents to
a printer directly from the
desktop by opening their
folder, highlighting them,
and issuing a print command from the desktop. The
application that created
them will open directly to its
Print dialog box, where you

From the Spooler window, you can pause, cancel, or schedule specific times at which you want
certain documents to go to the printer. They'll wait patiently until that time.

The Clock icon at the top of the Spooler window allows you to set a specific time for a
document to print.

can select the options for
each file. You can shift-click
G) Urgent

to select and print multiple

Q ~nnnl

documents as well- even

f)AtTlme

from different applications.

t

b

I 6/H/2000ll:FJ

J~12-:S-7P-M---.I~

I Cancel I ij

OK

I

They will open in turn and
let you change the print
settings ifyou need to.

PrintMonitor
If you're not using Desktop Printer icons, then a second type of spooler program comes
into play called PrintMonitor. This is a stand-alone feature (like Desktop Print Monitor)
that can be used to manage your output.
. -.aPrlntMonltor
Printing

J

L
~

Waiting

>et PtlntTI me_

In either Print Monitor
window, you can rearrange
the order in which specific
jobs will print by dragging
them around in the list.
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Documents waiting to be printed would appear in this window, just as they do
when you're using a Desktop Printer. This application works the same way but
looks slightly different.

PrintMonitor provides a number of options as well. If you choose File> Preferences, you
will access the settings for the spooler.
Preferences_
Show the PrintMonltor window when printing:
@No
()Yes

The Cover Page option that
you see in the Print dialog
box prints an extra page
containing your name, the
name of the file, and the
time the document was

When a printing error needs to be reported:
+ Q on1y display+ In Application menu
+ Q Also display Icon In menu bar
~
Also display alert

c

i!!?.

.e

When a manual feed Job st11rts:
Q Give no notification
~ • Q Display Icon In menu bar
Id) ~ + Also display alert

e

1·cance•1 11:::-,0fG:a

printed. This can prove quite
useful in an environment
where different people are

It

There are several options available to you when you're using the regular
PrintMonitor as opposed to using the Desktop Printer.

sending documents to the
same printer- a common
occurrence in a networked
professional environment
like an office or a design

Printing from an Application
In the end, it all comes down to being able to print from within a program -whether it's
an application like SimpleText or it's the Desktop, where you can print the entire desktop, or
the contents of any folder.

studio.

~=:~ W
~

Printing from an Application

someone

sortoutyour.,.

output from theirs, and vice
versa. Otherwise lots of
things end up somewhere
other than your desk- like
the resume you sent to your
competitor.

1. Navigate to your Copy Files folder, and find Moby Dick.THI.
Bnfifrl=Ei:~~mr

-~

-- ·-·

_

mn i~~Ei!t1~~~~~~~.?\t1,1~~,1~b.,,~; ~~ ufJ

B
EJ
B

Berries.txt

..LA

Semple f'ile #1 {Stistlonary)

Vacatl!!n Oemond.txt
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2. Open the document and select Print from the File menu.

,. .a

Rle Edit font Size Style Sound Help

o.

s

ft MobV Dlck.fxt •

:

ms

~@Tuw IDJ!l~

~

dm>wl

Ifyou turn offBackground

A !look of th1 Mont h Ch.i>S1ltction

printing, then the document

Hennan Melville

will go directly to the printer,

Fiiied with alegory and symbolism, th is closok story of
)l;OOd and evil unfolds among the whaler community in
ihe 1800"•· The great white whale, M>lrDid; Is punued
by the obsessiYe and cruel C.ptlin Ah&!>. In a prior battle
with the leviathan, Ahab bad lost a leg.and many say,
his mind.

without stopping at
PrintMonitor or Desktop
Print Monitor. This is usually

aose
Save
SllVI! AsPage Setup_

Aboard the P...111ad. Ah.ab e.nd bis men <hue the bout
across the world's oc:earu, until they flnolly meet him and tholrdramatk destinlos - ln •fine.I. brute.I battle of
will, determinotlon, and obseulon.

not a great idea, since you'll
have to wait idly by while

Print Ont!' Copy
Quit
XQ

your document is being
printed. You won't be able to
access anything else in the

3. You will see the Print dialog box.

meantime.
_Pr_1n_t_
er_:_"_L11_s_e_
r1_et_5_"------===~....;s;;;;.3;,;;..1
Coples:
P11oes: f> All 0 From:
To:

LJ LJ

LJ

I

----~

PaperSource

! f> All Q First from:

I

I

Hf'tlh1tlltOQ !rond

Auto Select
~lllO

WI•·· t

II Print J
I Ciincel] I

Destlnatlon ___

... I

e Printer

... ,

0

J1

I Options B

File

I

t1e1p

1

Your dialog box might appear slightly different ifyou're using a different printer driver.
The Print to File option lets
you create a print image on
your Hard disk. This is
sometimes useful ifyou

4. Click the Options button. You will see a dialog box from which you can control such
options as the output resolution and other device-specific features that are being
stored in the driver for that printer.

want to place one docu-

Print Options

ment inside another, or pass

Cover P11oe: f> None

a file to a computer system

Print:! Color/Gr11yscale ...

that you can't easily
communicate with.

8.3.I

Q 6efore

O Alter Document

I,

I

Pr11ot~r ProOh!:I Print er" Octa ult '"'

OK

I

Q°ncer:J

-- - -

I

I~
Printer Resolutlon:I Printer' s default ... I
EconoMode:I Printer's der11u1t ... I
Levels or Gray:I Printer's default .... I

II

I

PostScr1pt Errors:! No Special Reporting ...

'

lOOdpl
600dpl
levels ofGray:r l'Mnter'sdeT11iiTt ...1
EconoMode:~

~

I savn

I

J

I

5. Click OK, then click the Print button on the Print dialog box. Your file will be sent to
the printer.

An upright page (taller than
it is wide) is called a Portrait
layout. Apage printed
sideways (shorter than it is
wide) is a Landscape layout.
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6. Open the Project folder that you created before, and after setting the view to As List,
open all the folders so every file is showing in the list. Select Print Window from the
File menu, and click OK to print a copy of the list.

11 lterM, 195.1 MB evolt oble

rOlite Mod1Re4

.,.. C1 Ar lbotrm
M

Fr i, Mey 19, 2000, 1:20 PM

Rough Rider M.l lf

Fri, Mey 19, 2000, 12:25 PM

.,.. tieo~ rn..

Whenever you save files

Wed, Mey 24, 2000, 12:57 PM

-

....

onto a floppy disk or other
removable media, it's a

@I Berrles.txt
@I Molly Olck.txt
lj Semple fil e • 1 (Stotlonary)
@I Vocation Otmend,tx!

Fri, NoY 2 1, 1997, 2:32 PM
Wed, Mey 24, 20 00, 2:01 PM

Mon, Mey 22, 2000, 2:35 PM

Slmplel ext sletlo
136 K Slmplel ext text

Tue, Mey 23, 2000, 4:15 PM

Sat , Mey 20, 2000, 8:5 4 AM

-

fo lder

I ii! Benane Boot.Tl F

Fri, Mey 19, 2000, 12:23 PM

136 K Photoshop9 Tiff

•

Be r ries Plcture.TI F

Fri, Mey 19, 2000, 12:23 PM

340 K Photoshop9 Tiff

•

Gerdenln<J Penel.TI F

Fri, Mey 19, 2000, 12:24PM

612 K Photoshop9 Tiff

good idea to print the
The window will print exactly as you see it here

contents of the disk. This is
easy to do just double-click
the disk, set the views to List,

7. Open the Graphics folder, and change the view to As Icons. Print it and you'll see
that the view is reflected in the output when you print from the Finder.

open all the folders, and

IQ.........]:
-a l

issue a print command.

~-,, fil;U .;~ Q, Graphl CS •

•

Most removables like Jaz
and Zip disks come with

Gllrdenl119 Penel.TI F

little cases, andyou can

•

~

Banana Boat.Tlf

~

the outside or fold it up and
media.

..!..

r&I

Berries Plcture.Tlf

either tape the printed list to
keep it inside with the

1!!11!1

3 Items, 194.9 MB M11 eble

~

I•

IT

~

8. When you're done, close everything.

Page Setup
There is another dialog box that is available to you from within almost any applications
(ones that print, an yway) called Page Setup. The Page Setup dialog box allows you to m ake
changes to several global printing settings.
PSPrinte r Pa ge Setup

8 .3.1

~~:::::=====::::-~~~

Pa per: I US l etter• I

layout:! 1 Up •

I

Reduce or lliii)l ,..
Enraroe: l.:.:::.....J
Orientation:

llJ EJ ~

OK

I

Cancel

1

I Options I
It Help I

From this window, you can, for example, create a tiny or huge version of your page. If you
set the size too large for your output device, many programs (but not all) will tile the
output, using as m any pages as are necessary. Once they're output, you can tape them
together to create the finished page, poster, or billboard. If the application doesn't support
tiling, it cuts off what it can't print
You can also change the orientation of the page, rotating the o utput so that it prints
sideways on the page. Additionally, you can choose to print more than one object on a page,
using the Layout pop-up m enu.
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Portable Document Format (PDF)
Inside the Chooser window, it's likely that there is a print driver called AcrobatPDFWriter.
It's a driver supplied by Adobe Systems and included with your the Macintosh operating
system. It is used to print a document to a special file type known as a PDF file, or Portable
Document Format. It's a remarkable and highly useful format that has been steadily gaining
in popularity since its introduction five or more years ago.

Adobe has a great web site
where you can not only find
outabout(orbuy) their
products, but also access
excellent free information,
tips, tricks, and a wide
variety ofvery interesting
PDF files covering everything from Shakespere to
Alice's Adventures
Through the Looking

Glass. All are free and either
fun, useful, or both.
Their address is
http:\\www.adobe.com.

Actually, there are several components to Acrobat. Several of them are included with your
Macintosh, and others are available commercially from Adobe. Included with your
system are:
• Acrobat PDFWriter. This is a print driver that Jets you print your documents to
PDF format instead of the printer. Once in Acrobat format, it can be viewed
(but not modified) using the second component.
• Acrobat Reader. Acrobat Reader is a free product manufactured by Adobe and
distributed both by them directly as well as by many third party companies
who distribute it with PDF files so that the viewer can open them on their
computer. Acrobat Reader is also a free downloadable program available on
the Adobe web site.
T he amazing thing about Acrobat is that once a file has been printed into this format, it can
be viewed - with every detail, including fonts, images, pages, and more - on any computer that has Acrobat Reader installed. Whether or not they have the application that
created the document, they can view and print it as if they did.
The not-for-free parts of Acrobat are tools that allow you to add buttons, animation,
interactivity, contents listing, export the files to other applications, and modify them in
other ways. The name of the product is Adobe Acrobat and is available from a wide variety
of sources. It comes with a product called Acrobat Distiller, which is an industrial strength
program designed to batch-process multiple documents into Acrobat format.
r .. ., . . . ..,

=

ElportAdobePOf

w

.-Worlcflow - - - - - - -- -- - -- ----.
i..l~port::
1
@) Distill now
"'
•
I
Acrobat"'Reader1.0
~
~
J
I Cancel
9Vlew PDF using:
Lo~tlon :

Curn·nt

HKd Ortv• t AppUc-&tions:Aorob.. t RHdtr 41J:

We've supplied a copy of
Acrobat Reader on the CD
that came with this course.

s~ l~ot Ion :

~,-. Si-1!le-ct..-.~

Nont

D Include downloadable fonts
9 Override Distiller's options

-1
_________________

........_

PageMaker's printer style:
Paper slze(s):

Edit-

r

l
I PDF Options- I
I ContJ'Ol_ I
If save Settrngs j

O Prepare Postscript Ille for dlstllllng separately
[]Use Olstlller's 0 Watchcd Folder"

I

l[I.~ Settliijs

J

_, !LResel Se~nos1

IAcrobat I ~ J
I:=======::=.,.~~~--.,.-.
Same as page slz.e (s)
I ~I

I

Pages: @)All 0 Ranges: 2~

I

Some programs provide specialized features that you can use when generating
PDF files. This screen image is from PageMaker's Export to PDF function.
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The Acrobat Reader program provides a player that can be used to scroll through pages,
attach notes, and print any PDF document to your own printer. It's becoming a very
popular method of moving rich documents (ones that contain their original formatting,
fonts, images, and layout) across the Internet.

There are times when you
have to prepare a file that
you intend to print in
another location. Creating

way somewhere else. Since
fonts, graphics, and layouts
ofthe original, when the
quick printer, commercial
printer, or office across the
country needs to output
your file, they won't get any
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surprises; they won't need
the fonts you used, or the
program with which you
created the file. All they'll
need is Acrobat Reader and

Acrobat Reader, which is available free ofcharge, can be used to view, annotate,
and print files which have been output to Portable Document Format (PDF).

they can efficiently send
your document to their
printer.
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Acrobat Resources
As we've mentioned, a great place to find out more about PDF is from the Adobe web site,
at http://www.adobe.com. Another great site that we make use of is called planet.pdf.com.
You sign up as a member (free) and gain access to thousands of PDF users from around the
nation and around the world, discussing every possible aspect of PDF use, particularly in
the graphic arts environment.
Acrolkld ~s fonim -roste ng a networ1Co1PDF -

Emailing a PDF file is more
~ ~

efficient than emailing the

~

a.de

•.

F .,., ,,.

~ Mt-tst:

original because Acrobat

~

.:it<

0

!'_Rt!_r•~

Q •

~

(.11

Homt St•ch Ma ll Favorttn

~

....

fiil

L.arr,tr !k'Nlltr Pnftnncts

EJ !http:/lwvw.-obuoldlts_,,/w-...S/WW<.dll,.._lts

contains extensive tools

~

that compress files. Even

~

simply printing to a PDF

Convert PDF to RTF with Drake 4.0
I t even preser ves t he page st ruc tu re•

driver (selected in Chooser)
creates a much more

AcroBuddies

compact version ofthe

Name:

f

Password: . - - - -

/<'1"11 111

+;.1.11.p

originalfile. Forexample,
ten pages of this

D Remember mv p•uvord
f2!9 ot your Dtuword ?

courseware, complete with

Gutsts t nttrin9 conftrt ncu art

the images and fonts

Wp• 1t 1 •

necessary to output them,

'S'Y'"lB! personallnd profile.

limittd to ru d ~on ly ucus.

Nt w users cllck htr• to ere Ht a

takes up about 20mg to
25mgsofdiskspace. The

li1[Th
""'""I· ·mg.com I ~ 19 97·2000 8 ln• ryTh ln9.com

same file, output to PDF,

PlanetPDF

I

weighs in at an astounding
2.Smg.
This doesn't mean that PDF
can be used for every
lnttf"nftlont

possible output contingency; there are times when

The Planet.pdf web site is a great resource for information about using Acrobat in
the real world, and provides information about add-on products that can
enhance the program's functionality.

production demands the
entire package - original
files, the graphic files used to
illustrate the document, and
the fonts used to lay it out.
However the PDF model is
becoming increasingly
mature and robust, and
more and more high-end
professional documents are,
in fact, being manufactured
using PDF workflows.
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In conclusion, we feel that it's a good idea to experiment with PDF, and to explore the
possibilities that it presents for making documents platform independent, meaning that a
document you create on your Macintosh can be viewed and output - exactly as you
intend it to look- on Windows or Unix computers. Although this book isn't the place for
a fully detailed discussion of all the possibilities, PDF is increasingly becoming a standard
file format in both the graphics-arts world and the general business community.

Fonts
Fonts are the characters that make up a typeface. Some come with your Macintosh, others
are commercially available, and still others can be found for free on the Internet and among
user groups and shareware organizations. Still others can be found with certain types of
software packages. For example, Adobe Illustrator - a highly popular d rawing and illustra-

tion program from the same people that wrote PostScript Page Description (PPD) and
Adobe Acrobat- comes with dozens of very useful and well-designed typefaces.

Big and Bold
Ciofl and<:Swee!

Informal
M d
T ill P ern

FORMAL

Typography, or the art of
using typefaces, is a
combination ofscience and
design. Modern page layout

ra tional

There are thousands offonts available for your Macintosh. Some are old, based on
designs from hundreds of years ago; still others are new, and more are being
designed all the time.

programs such as Adobe
lnDesign orQuarkXPress
provide powerful tools for
using type in your designs.
The ability to use multiple

Fonts add character to your documents (no pun intended). If the world had only one or
two fonts, it would be a much less interesting place. Fonts can set the tone of your message
and give it emphasis. Their misuse, however, can distract from an otherwise great design
and obscure the m essage. (This is not a good thing, especially if the message happens to be,
"Buy our product.")

typefaces electronically was
actually introduced by
Apple - at least when
considering that electronic

A core mission of the original Macintosh development team was to provide a relatively lowcost platform that offered powerful graphics and type functions. That goal is still reflected
in the Mac OS. Fonts remain an integral component of the operating system.

typesetting equipment prior

Font Styles

to its introduction asan

In the past, fonts were constructed of individual pixels. Each output device had a certain
way of describing fonts as a series of (square) dots. A good example of a bitmap font can be
seen on your monitor. If you look closely eno ugh, you would see that each character is
comprised of a collection of square pixels that are either on (black) or off (white).

Apple feature, were very
expensive, complicated, and
the domain of the professional typesetting industry.

"LaserJet 5".

That industry no longer
exists in any meaningful

Bitmap fonts were once the standard way of imaging type; in recent years the
technology has been supplanted by newer, more accurate processes.

way since it fell victim to the
fact that designers could

Certain imaging programs can make fonts smoother using a technology known as anti-

now control their own

aliasing, where the edges of the font are softened by introducing shades of gray to soften the edges.

typography.
The art and science of
typography is complicated
subject, and one that's
definitely worth exploring in
depth ifyou intend to enter
the graphics field.

Anti-aliasing is a technique used by some imaging programs whereby shades of
gray are used to soften the edges of fonts. This close-up screen image was
captured in Adobe Photos hop to demonstrate the technique.

Since the introduction of the PostScript language in the eighties, bitmap font technologies
have largely been abandoned in favo r of outline fo nts, which rely on very accurate mathematical descriptions of each character. With their shapes described as anchor points and
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curves instead of pixels, these fonts can be sent to any compatible printer and reproduce at
the highest resolution available from the device.

I

Look around a little - at

I

magazines, books, newspapers, television, the movies,

I

\,

signage, posters, street signs,
or just about anywhere else,
and you'll begin to see how
many different typefaces

__.,,.

)

__.,./

~--· -

Outline type technology describes each font mathematically, allowing your
documents to contain fonts that reproduce perfectly on any compatible output
device.

there are and how many
ways there are to use them

Types of fonts

in design and layout.

There are two primary (and competing) font technologies in common use today:
• PostScript Fonts. PostScript fonts utilize Adobe technology and are the dominant technology in the graphics industry. If you find yourself working in the
design field, you will most likely be using PostScript fonts (also known as Typel
fonts). Most of the large commercial type houses (Adobe, Linotype/Hell, ITC,
and others develop this type of font. Many type purists argue that they're more
true to the traditional typeface designs, which were carved from wood or lead.
PostScript fonts come in two parts: a Screen Font, which is used for screen
display, and a Printer Font, which is the mathematical description sent to the
printer.

Many commercial output

~

Apple Chtncery

~

AGtrSemllt

sites - quick printers,
commercial printers, and
imaging houses - aren't

Adobe Type 1fonts come in two parts: a suitcase icon for the folder that holds the
screen font and a downloadable font image that's sent to the printer when a
document containing the screen font is output.

happy about using
True Type fonts, since they
often present problems
during output to high-end
printing devices. In the
professional design world,

• TrueType Fonts. TrueType technology was jointly developed by Apple and
Microsoft. Based on an outline model (much like Typel fonts), this is the type
of font supplied with your Macintosh, any Windows system, and many general
purpose applications, such as Microsoft Word, Powerpoint, and others.
TrueType fonts have only one component, unlike PostScript fonts. The same file
is used to generate both the screen and printer versions.

PostScript fonts dominate
the marketplace. True Type
fonts tend to be used more
in office environments,
where film output isn't an
important consideration.
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sr Serlbblod Sens

@

sr Sc r ibbled Sens (bold)

True Type fonts, which come as a standard part ofthe Macintosh and Windows
operating systems, are represented by a single icon for both screen display and
printer output.

Most output problems

Managing Fonts on your Macintosh

associated with TrueType

Fonts are stored in the Fonts folder, which is inside your System Folder. When you install a
new font, this is where it needs to go. Once you put a font inside this folder and restart your
system, the font(s) become available to your word processors, layout programs, imaging
applications, and presentation tools. To install a font, all you have to do is place it in the
proper folder, and it will become available to you.

fonts are related to mixing
them with Type 1fonts in the

tr

same document. Ifyou
intend to send a
projecttoa

com~ercial

•'

service
provider for

Working with fonts
1. Inside the SF-MacOps folder is a folder called Fonts. Open it and look at the contents.
[]

output at some point, you

c.:_- ~~~Fon~

llJ

should try to stick with a
single-font technology.

~
ATC8oh$1N.bmep

ATCBoh

~

ATCC.rRee

ATCC.relRoef.bmep

maL.
;-r
A font suitcase is an icon for
a folder that contains any

E!IB

6 ltems. 166.2 tlBaYOll1bl1

~

~

~
~

ATCSun

~
T~~

2. Double click the RTCBahama.BMRP icon. It will open to show you the contents of
the suitcase.

number of screen sizes for a
font. Allyou really need is

Slzt

one or two, and the

4K

SK

Macintosh builds the odd
sizes, such as 11 point, or 23
point, from the one in the
suitcase.

Professional designers will
often say that Type 7 fonts

3. Double-click the ATC Bahama 12 showing in the list. A sample of the typeface will
appear in its own window. When you've looked at Bahama, take a look at one or two
of the others.
ATC Bahama I

are better- more finely
Sample

constructed - than are the
typicalTrueTypefont. This

--~L..o.~......... '

cozy LUMMOX GIVES

SMART SQUID WHO

ASKS FOR JOB PEN.

might be true in some cases,
but there are certainly highquality fonts being issued in
both formats. In many
cases, you can select which

To uoe this font, dra1J It onto your System Folder
Icon.

To uoe thle font, dreg It onto your Syotem folder
lcon.

type you want when you
purchase a font.

The Mac OS lets you look at samples ofany font.
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4. Close the fonts.
5. Open your Hard disk folder and find your System Folder icon. Select the Fonts folder
and press Comm and-A to select all the icons.

Type7 fonts contain a small

6. Drag them on top of the System Folder icon. The Mac knows where they have to go,
and shows you a dialog box explaining that they will be placed in the System Folder.
Click OK.

amount ofprogram code
These Items need to be stored In the Fonts
folder hi order to be nvallable to the
computer. P!rt these Items Into the F~ nts
folder?

packaged in something
called "hints," which are
instructions on how to

I Cancel ) [I oir--j

better image the font at
lower sizes and lower
printer resolutions. These
hints are built into Type 7

7. Open your Moby Oick.THT file and experiment with your new fonts.
,.. .;I
r:J

File

Edit Font Size Style Sound Help
:..::: . Mobv Dlclc.txt ft' ~

'"""'
• ! E!l 8

fonts and, as far as we can
tell, do not exist inside
True Type character sets.

A&okol the Month Club S.l1<tion

Henn•n Mely!lle
Pilled with ole(ory end symbolism, this <W>lc st>ry of cood end evil unfolds
tmOllC the vh>ler <0mmUIU1Y In the 1800's. The CJOM vblle Vhble, M>~y
/U'.k, ls pumiod by 1ho obsessive en4 CNOI CaplOln AMb. In & plilr b&.nle with
the levl&than, Ahab had loSI & leC. 6"" many say, bis mind.

Aboald Ille Afq1•"1, Ahab en4 bis men <lwe the boost uross the vorld 's
0<eans, until they f'lM!ly meet blm ··end their drerna1lc destinies .. 1nattr.al,
bruUll battle of vW, de11>rm1M1lon, end obsession.

You can view the contents
ofa TrueType font by
double-clicking its icon. A

The fonts supplied with your student files are fully compatible with all Mac programs.

8. When you're done working with your new fonts, save and close the file. Your new
fonts will be available to all your programs.

small window showing the
font in three different sizes

Chapter Summary

will appear when you do.

In this chapter, you learned the basics about how the Macintosh prints documents, including the interaction between drivers, extensions, system components, and applications. You
learned how to print the contents of folders and how to print from within an application.
You learned how to control the Print dialog box, and how to create and manage Desktop
Printer icons. You worked with spooling programs and you learned about a the PDF print
format. Lastly, you explored the use o f fonts, how they work, how to install new fonts on
your system, and how to make them available to any application.
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Networking
In this chapter, we're going to examine one of the most powerful and useful features of your
Macintosh- its built-in ability to communicate with other computers.

Networking is yet another

The Mac's ability to talk with other computers is universal. You can communicate with
almost any other computer-whether it's next to you in the same room, in another part of
the building, across the parking lot, or across the world.

area where the Mac's

Designer

introduction completely

Copywriter

Illustrator

changed the playing field,
and set people's expectations as to what their
personal computer should
be able to do. The
Macintosh was the first
commercially available
computer with the ability to
network with like comput-

Server

ers built into the hardware

Scanning and Image Retouching

and software that came

Printer

with the machine.
Apple's introduction of
AppleTalk - a simple yet
elegant method of connecting two or more
A network in a design studio might have several people, each with different tasks,
working together. The network might offer these users shared resources, such as a
color printer or a file server- a centralized storage device accessible to everyone
in the group.

Macintoshes together
without complex software
or expensive hardware, set
the stage for "workgroup
publishing. " The ability to
work on files together and
share common resources
such as printers and hard
disks paved the way for
other manufacturers to
follow. Today,Apple's
networking solutions are
among the most powerful

Types of Networks
There are many different types of networks in use in the marketplace today, and although
we're not going to explore every one of them, we will spend a little time looking at how they
work and explaining some of the more common terms that apply to them.
There are two components to a network: the cabling method that connects your Mac to
other computers, and the sofu.vare that's used to enable communication between computers and other resources, such as printers and file servers.
Most computers today use one of two cabling methods:

- and compatible- in the
industry.
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• LocalTalk. This was the original networking method used by Apple and built
into the Macintosh. It uses regular telephone wire with standard connectors. In
the simplest form of network, called a peer-to-peer network, whereby you simply
run a telephone wire between tv•o Macs.

The business world is a
network environment,

The simplest network is a peer-to-peer connection. It exists when you conned two
Macs together with a telephone cable and activate the necessary software.

utilizing one or more of
several popular networking
methods. Almost all
companies have their own

• Ethernet. This method uses a cable that looks similar to a telephone wire but
contains more wires than its older look alike. The connections are wider than
you can get with standard telephone cabling. In many environments, Ethernet
jacks are installed in the wall just like telephone jacks.

internal networks, and
many have multiple
networks all connected
together. For example the
accounting department
might have their own
network, the executive
offices another, the design
group yet another, and so
on. These small workgroups
are connected together
using specialized hardware

Of the two types of networks, Ethernet connections are by far the most popular. Ethernet
comes in various speeds, measured in megabits, or millions of bits per second. A standard
Ethernet connection is called as 10-baseT (or ten megabits per second), and so-called Fast
Ethernet is rated at 100-baseT. There is also a gigabit, or million bits per second, Ethernet
protocol being used in the field , but it normally requires relatively high-priced cards and
special cabling in order to achieve the higher transfer speeds.
Most Ethernet networks use a hub, which is a central connector allowing some number of
computers to connect to it. Once they're connected to the hub, they can "see" other computers which are also connected to the hub. This helps to simplify network management,
because any computer can be connected or disconnected from the hub without interrupting network services to other connected machines.

Workstations

and software.

~----

Incoming High-Speed Line

A network equipped with a hub can also accommodate incoming high-speed
lines and can therefore provide Internet services to the connected systems.

Networking Tools on the Macintosh
The Macintosh operating system provides several tools that facilitate connecting your
Macintosh to other Macs or other computers. In this section we'll look at each of them and
how they're used.
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Open Transport

We can't cover everything

Open Transport isn't an application, but rather an extension that provides the Mac OS the
ability to connect to a wide range of commercial networks, such as Novell, Banyon, Sun,
and others. In order to accomplish this, the Mac must maintain a library of different
protocols, o r network communication languages. The operation of Open Transport is
transparent to you as the user, but critical to the successful connection of the Macintosh to
corporate networks.

~

there is to know about

Open Transport

networks in a book about
the Mac OS. Whatwecan

0

Open Transport ASLM Modules

Open Transport and its libraries are found in the Extensions folder.

do is discuss and explore the
tools that are available to

AppleTalk

conned your Macintosh to

AppleTalk is the built-in networking protocol developed by Apple to connect Macs together
on a simple network. You can access the AppleTalk dialog box from the Control Panels,
which is where all the networking tools can be found.

other Macs and to network
volumes (hard disks): The

file E It View 5pec1111 U~Help

Macintosh offers a range of

AboutTlils computer

functions and features

lib Apple System Proftler
~ATMDeluxe
Clllculotor
~Chooser

related to connecting to

!ill

other computers and the

••mrJ!Uzm!lll•IQ'
Adobe Gamma
Favo es
Adobe type Reunlon Deluxe

Internet, which we cover in

(j) KeyCll&s

the next Chapter.

&.. Metro

Aladdin Compression..
Appearance
Apple Menu Options

ome

!II Ne~br1111Browser
~ Remote Access Stofus

It Run Dally 11>2

lll Scrapbook

i:l Screen 5napz
J# Sherto~ k 2
Stickles

~

ColorSync
Conftguratlon Manager
Control Strip
Date &Time
D(alAsslst
Energy Saver

The AppleTalk dialog box lists several options for you to connect to your network. The first,
Ethernet, is the one that's probably in use on your system if you're connected to a network
·
right now.

.

--

AppleTliliJ- ·

The AppleTalk dialog box.

The other choices are modem port, printer port, and remote only, which is used to connect
to a network from the road.
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DialAssist
DialAssist is a Control panel that allows you to store access numbers, view and edit a
countries listing, and preprogram outgoing code requirements, such as dialing nine before
getting an outside line.
Ol11IAss1st

Ci\y/AruCodo:

There are several methods

EJ

C-by: ~~-lt...-st-.1..
--..-i

available to connect to

Aoet>ss Out :

other computers over
Prtfbc :

telephones and specialfunction telecommunications lines available from a
variety ofsources.
Modems normally operate
at speeds between 1200
baud and 56k. These
numbers refer to the speed
at which data moves across
the phone line.
DSL is a digital signal line, a

long Dist>.- Acctts:
SUffbc:

0

:::-========!
~-=========!

---=----'""I

Ahr>YJ Di>I Aru Codo

I(
I tong Distance_. ] I
Country_

... I Add-1

.Wstrll

43
32

s.19;,m
c.n.d•
Ch~•

Dt<vrwk
Finl>nd

rrO.rm.ny
ar...,
Prefix...

Honq~

1
86
45

00
00
011
00
00

3:58

990

33
49
30

00
00
00
001

~

~

I Oele.te I
~
~

I!

()I(

I

Su1Tlx-

The dialog box uses pop-up lists from which you can easily make or change selections
before making an outside call. In the above illustration, you can see how the bottom
buttons display give you access to dialog boxes, wherein you can make changes to the popups, adding, editing, or deleting items from them until they meet your personal needs.
You can also add long-distance services to the list, complete with any access codes that must
be dialed in order to connect.

special type of connection
that uses regular telephone
lines to achieve pretty
impressive speeds. DSL lines

.....,
&

AT&T(USA)
MCl(USA)
Sprint(USA)

10111288 0
101 02220
10103330

can operate as fast as 7mg

[§ill)

when you're sending files to
someone and 3mg when
you're receiving files from
somewhere else.
Cable modems, increasingly
being offered in different
parts ofthe country provide
very high-speed access to
other computers, normally
through the Internet.

~

f;" 11

()I(

I

The Long Distance dialog box from the Dia/Assist control panel.

O n most large phone systems with multiple extensions, you have to dial a special number
in order to secure an outside line. In our case, it's a nine, but it can be any number that the
you in-house phone system uses. You can enter the dial-out number in the prefix dialog
box. Notice in the Number column, the digits are followed by a comma. The comma signals
the modem to pause to wait for a dial tone before dialing the phone number. If you leave
out the comma, when you try to dial out, you may get an error message that your modem
could not detect a dial tone. In some older systems, it was necessary to use two or more
commas to allow time for the dial tone to activate.

T1 and T3 lines are large,
bonded pairs of lines which
provide the highest speeds
available today.
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Labtl:

Uumbtr ·

O..tsici. LIM - 8

8,

..

I Add- I
~

I oetete I
~
It;

~

II

OK

I

Lastly, you can store your personal credit card numbers and/or a phone-card access number
by using the Suffixes dialog:
SufOx.e s

Your credit card numbers don't show when you access the Suffixes dialog box, but
you can add and edit them safely.

File Sharing
File Sharing refers to the Mac's ability to share files (and in some special cases, programs)
with other users on the same network. The function is managed by the File Sharing control
panel. The File Sharing control panel has three sets of controls marked by tabs in tl1e dialog
box.
TCP/IP stands for Telecommunications Protocol/
Internet Protocol. It's a

Stop/Start
This set of controls allows you to start and stop file sharing. You don't have to keep your
computer connected if you don't want to; you can always turn File Sharing on whenever
you need to using this dialog box .

method of assigning unique
addresses to each computer

fil 8

V

st11rt/Stop ~j:ttvlty ~nltor~ l_!sers & Gro11ps_l

1:121

on the network so that they

on the use ofTCPllP
addresses, which are, in

:=:=====---------.

Computer Name: ~l
0o_n_ _ _ _ _ _ _ _~

II

IP Addr es'l:

"' ~~~~~~~~~~~~~ Ale Sh11rlng on
It;

r-.....

most cases, dynamically

on to the Web.

Statm _ _ _ _ _ _ _ __ ___

~
0

assigned; that is you get a
new one every time you log

!leuoers

lick Stop to hrn off file 'lharl 119. Thi'! pr..,..nb other
from ecce'lSinQ • hared folder>.

Enable fi le Sheri "'I client• to connect over TCP/IP

~ Progrnm Linking otr

°'V

[J§J
0
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j~Do-n----------------~

O>.lnor ~n!: ~==~-------"'
I-

during communications
events. The Internet is based

Network Identity

-..;r" O>.lnor tla~:

can identify each other

Statm - - - - - - - -- - ! cli ck Start to turn on procirom linking. Thluli...,.other
mers to link to •hored pr09roms.

I

Enoble PrOC)rom LI nklng clients to connect war TCP/ IP

• Network Identity. Lets you enter your name, the name of the computer, and
your personal password. It also displays the IP address of the computer, which is
the network address, usually expressed as a string of numbers, such as
22.56.123.50. We've erased the number from this display for security reasons.

A server is a specially
designed machine whose
purpose is to provide disk
storage, tape (or other)

• File Sharing On/Off. Turns networking on and off. You can also enable clients
to access your machine directly by it's IP address. This is useful if you're using
your computer to host (or hold) a web site. More on this in the next Chapter.
• Program Linking. Allows other users on the network to access a program that's
residing on your computer. Program sharing isn't very common, except in
certain situations where specially-designed multi-user applications are in use.

archiving and backup
functions to users on a
network. Since the people
using the server have their
own computers, they only
access the server to store
files, and in some cases,
applications. Apple makes a

Activity Monitor
This set of controls provides you with options for determining who is accessing your
computer from the network, and how they can use it.
• Sharing Activity and Connected Users. Keeps track who is connected to your
machine, and how much activity is occurring because of it. The more activity
going on - especially accessing your hard disks - the slower your machine
will perform. This is just a fact of life when two machines are connected directly
to each other. That's why most large networks utilize servers in their layout.

complete line of servers
.=

designed to connect Macs

ti ·:.=-

together and with PCs and

1 startistop:1fActtvlty Monitor\[USerS a Circ11q1sl l

Rle Shllrin

-

::-·;

--'

other computers.

Sh 11rlng Activity
I I
I

e..y

Idle

IuThesharlnci
com puter tends to run more slwly
activity lncroooes.

Iii
I

Connected Users

11

..I··-··

~

~

( Olsconn:e ct... ,

I

I

I

, Sh11red Items

n

I!
i:

a
a
a

Herd Drive I
Herd Drive 2
lntern1I HD

t.!.
!-;-

Privll~ges

'

11

• Shared Items. In addition to being able to see who's connected to your computer, this control panel lets you determine the privileges a specific user has
when they access your machine.

Read and Write allows the user to add and delete files exactly the same as you
can while you're working on your own machine. This is the highest level
allowable, and lets people accidentally trash something you desperately needed.
(Statistically, this has been the number-one cause for ruining relationships, until
it was recently replaced by phoning a friend who gives you the wrong answer to
the quarter-million-dollar question.)
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Read Only lets people see but not touch. They can open any file on your machine, and can save a copy of that file back to their own machine, but they can't
save anything onto your hard disk.
Write Only is exactly the opposite. They can save something onto your machine
but they can't see anything on it. This is used for mail systems where your
machine is a drop box, and other people put files onto it using mail software.

-

Microsoft provides very

None is assigned when there are network users who do not have access to your
system.

popular networking
software called Microsoft
NT Server (NT stands for
New Technology). It runs on
Intel or compatible
computers, and allows
Macintoshes to connect to it
through special software.
It's arguably the most

Iii Shore lhl• ll•m end 1t1c.ntente - - - - -

popular network software

Hime

in the world today.
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Another popular networking software is called
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Rtadonty
Write only (Orop IJa)()
-- Hone

~

I

Novelle, and has been
around for a long timebefore the Macintosh,
certainly. It is used in large
corporate environments
and also provides ways for
the Macintosh to connect to

Users & Groups
This control panel lets you add, delete, edit, and view the users and groups of users who
have access to your machine. From here you can assign passwords and decide whether or
not you want someone else to have the ability to change their password. If they do, you can't
find out what it is unless they tell you.

a network.
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You will see in this list that there is a user named Guest. This is a special user who doesn,t
need a password, and can get into your machine whenever they want. In a small private
network, this is fine, but in larger environments it's probably a good idea to not allow guests
to access your system. You can tum off guest access by double clicking the word Guest on
the list and choosing Sharing from the pop-up menu at the top of the dialog ho.:
Server software is basically
the same as the File Sharing
control panel, but more
robust. lrs normally
managed from the server or
from a remote machine
whose user has the highest
access and privilege level.
This person is normally
called the System Administrator, and can add and
delete users from a central
location. (In recentyears,
your System Administrator

You can use this dialog to deny access to Guests without a password.

You can add as many users as you want using the New User button, which brings up a
dialog box that allows you to enter Identity information (their name and password):

has replaced the company's
Operations Manager as the
person whose name should
be first on your list of
chocolate brownie recipients.)

From the Sharing control panel, you can set program linking privileges for the user, or tum
off their ability to access your machine.

CHAPTER 6/NETWORKING 141

The Remote Access control panel lets you determine whether or not a specific user may dial
in to your system from outside, for example from the road using a modem. This dialog box
provides a callback number so that your computer can connect to them.

r:
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The Remote Access control panel gives user the ability to call your computer on the phone.

Modem
The Modem control panel is a simple tool that lets you select from a list of available
modems. Ifyour modem doesn't show up in the list, you'll have to contact the manufacturer to get the right driver.

COnlltot. via: JMOCIMtfetW~:I:U
r

S.tap - - - - - - - - - - - - - - - - .
Modtm:

Olalhg:

(05mt.V1tf!PPl!tbain/.:.:: Id

e0n

G>Off

f)Tont.

Q>Piitn

ID 19nor• d1a1 t-~

Your Macintosh comes with dozens ofmodem drivers installed in the System
Folder. You can add more to the list ifyours isn't already there.
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Remote Access
..,

Remote Access is a relatively old software application that allows users to dial in to your
computer -or lets you dial into a server or directly to your own computer. If you're
travelling with a laptop and need something from your hard disk, this can be a real positive.
~ RemoteAccess ~-

CJ

Remote Access is another

f) Rf9ln.,.td Unr

() Outst

KMnt: l~~~~~~~~J

item thars best left to
experts.Ifyou're currently

El

p.,.,....d : ['--_ _ _ _ _ _ __,]

rn S.vt pus vord

able to connect to another

flumbtr:

l~________.J ~

computer using Remote
Access and make changes
to the configuration or the
connection, there's a very
good chance that your

L. _
I Options- I l

connection won't work
anymore.

ConneCfJ

From this dialog box, you would enter your name, your password, and the phone number
to dial when you want to connect to another computer using Remote Access. The other
computer must have a user set up with Dial-up access privileges, or accept dial-up Guests,
which probably isn't a good idea. Once the fields are complete, the Connect button becomes activate, and clicking it v.rill start the process.

=

·:. "~..:!.'!!Uff¥¥"'1 Options

.L Ro<ll•lllltY°c-uon\.t:Pr•'-~
D u.. v.rt>os• 1o991n;
0 L.und\ St.lus tt>Pfiution wi- COMt<tlnoj
R.mlnders :

Some large companies use
the Remote Access network
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feature allow their professional staff certain leeway
to work from their computers at home. In the comfort
oftheir favorite worn T-shirt,
employees can Jog-on from

I

C11ncel J

Iii

OK

I

The Connection tab under Remote Access options lets you flash the menu bar
while you're connected, in case you forget. You can also disable the connection
automatically after ten minutes ofinactivity.

home to work on the files in
theirofficecomputer. The

Using Chooser to Access a Network Volume

downside to this arrange-

The m ost popular way to connect to another (remote) volume or server on an AppleTalk
network is through the Chooser. We used Chooser in Chapter 5 to select the printer we
wanted to use for output. The other use of Chooser - accessing network volumes - is
done the same way.

ment is that employees can
also be expected to work
from home during vacations and holidays.

The Chooser window displays icons for printers as well as for AppleShare. If you click on
the AppleShare icon, the right side of the window will display available network volumesin the same way it shows printers when you click on a printer ico n.
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. . I Select a file server:
I-

I

~H~~ri ;~ -~~ ~ - ~-

I

··:~

~

I

( ,Server IPAtfdi'ess... ) 11-. OIC "

AppleTalk

@)Active
0 Inactive

7.6.2

In this situation, there's only one volume available on the network, and that's
£/Jenn's machine. In a large network, the list could be long, in which case you can
scroll the list.

Ifyou double-dick the server that you want to access, the Connect dialog box appears,
where you can enter your password if you're a registered user (the other person has created
a user on their machine and given you the password).

Here, Don is about to enter the password that Ellenn provided to him when she
created his user in her File Sharing dialog. IfEllenn allowed guests, he could click
the Guest button and not be required to provide a password.

Once you get past this dialog box, you can see which (if any) volumes are available on the
machine you're connecting to. In this case there's only one.

i'i~!~~~:~::~'.:~m
,: !Stonupftlm1r
" ' . ' .· , · :

' "

.·

··

- •

Selecting the checkbox will cause this volume to automatically appear on your
desktop whenever you start up your Macintosh.
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Once you double click the drive you want to access, it appears on your desktop.

l..r

E11 ~ r1 ri H[1

When you access a remote drive, its icon shows cables, indicating that it's part of
the network, not part ofyour personal machine.

Network Browser
The Network Browser application, found under the Apple menu, is similar to Chooser but
can access multiple networks at the same time. In most cases, Chooser will suffice for your
personal needs.

The Network Browser Window.

Chapter Summary
In Chapter 6, you explored the tools supplied with the Mac OS for connecting to other
computers. We discussed the types of network connections in popular use today. You
looked at how each of the networking control panels operate. You learned how File Sharing
works, and how the File Sharing control panel can be used to provide others access to the
files, and sometimes the programs, on your hard disks. You saw how to create Guests and
Users, and how to control the specific privileges for each user. You how to use the Remote
Access feature.
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Notes:

146

CHAPTER 6/NETWORKING

.,

--

,

,.

' , . .- I
,". . ,1 . ;

-

... ""'

•~

'""'"\ .......:t 4'.l
'
-

·I-

• 'i·

l

.... _

I
)

~

/ Uw>rER (JBJECFIVj,:

,

~

. ..

,...
'

•

.

.

-

I

"''~

\

, \

\

~

-

To learn about the 1)1'.1.l!Y !!1tffnet-1elated · fe~tures of the MaxC?~· In
1·
Chapter 6, you will; •- '· _
· . ....
•.
1
· ·l

•
-

\

\

•

,,t"

-

'-

....

~

1'

o

,·

>

.. 1/.

'I

l --

..

......

j

'

•

'Ii.-\'

,

·' ~.

'

,I •

'

1

I

\

..

\

;--......

' •

~....

•

.·,. -·', e,...Learn the t~o ~~ys);;~-c.ah co~nec~ !~ the)nt~rne~.- throu~~ ~ still-~? .
uptcohnec~ion that uses regular pli~ne lines. to a di(ect cqµnect~on,
,such as those fotlnclln cori>oi:ate settings. '
I

'

I

.--

, " ; Learn

'

\'

• .I

.,\, .

-.

,

'

-·~: ~

>: _'-

., '...

-

I.~

..... . \•

I

#

abqu~ -Inte~net Service Provider~ (ISPs) the c~mp,anies thatlbuy · .... , ;<-

vol~me access tQ ~hf Intern~t ands~µ sma.11 pieces to eotY-f>anie~ a~d ' ~ __ . i2

r,

' individuals.

' .

_,, , , . _

I

' /

_

,.. "

· ~1

1~ ~·-

·

- ,•

·

I I

,1

, ,:...

1-

.

• Learn aboutJ3rowser ~oftware, which is specially designed_to read and.·
interpret Hyper'.fertMarkup Language (HTML).
_ , , ·,
.

! '·

I

...

-

• Explore File Tran$fer Protocol (FTP) and1how it's used to sefid a,nd
Iece1ve large files. ~
•
. , ...._.~ , .
• L_e arn ab9ut Chat rooms ana,Newsgroups, which' are excellen~ redarls: side. ;.- ' ,
..1 ,, ,,
search resources with'·a1l'admittedly
.
I

o

r\

-

"-

.....--';-P-

.,

'

I

"'

•

t

,

'

'

/

.
-_

-r

'

•, i

I

-

,.

J.

,1•/

!

I
I

{

)

.

I

\

r

'

.

•

.J

-

I

,

--

...

.,L

r

...
/: -

<

,

t

,

-

....'

t

J

-\

• .

I '

'

-.:,

~,

,,../

~

..,

....

.

'

1

• J.

...... \

,I

-- -·

(

\'

;
~

\

/

·.

,,

~
~

•

-

;. _ r

....

,

.....

,/'

~,

•

• •

,.

..

...

·'

..-:·. ' -:. .

.

. ,..,.

I

.

....

\.

-·
:-..

'·
~

/

;

'

,,

/

,' .-

'

~

·~

•

'

1 --

• Learn how to use an email-prngr<!m,~and how to l,\Se' directbry servit;:~S ' '\,1
' to find anyone ai:~h~re ~n th~:Weh.
·. _
.. ·. _
•.• ~·.~~-' ·

,

•

1

• Learn tq us~. the Key~hain access function", which provides a~secure
', i·~ -~
location fo k~ep track of your passwords and secu! ity c~rtific~tes.. : '-.
1 .

'\.
#

'

•

"'.t

)

·.-

·-.· i ' "

• l;xpl'ore Configura_tion .Manager, which' letS}'OlJ tont.rol 1every-.;a~pect
· ~. ··~-'. ·
I .
of yo'ur Internet ·envirop rnent, fa:01n automatically 'fj.lling. out forms to .1 • ...-> '
1
tont~oling.the rype of conte_n t that yo~ ~an'.i yiew ~n you'r Macin~osh:-., ." :1 • ~

-.-: I

i '

_,,

• . Learn how to dR_wnload files1and where to find great game~; utilities,
· and ot:her Ma~intosh goodies for free or darn nea~ free~ ' J . - ,. , :- ,

,-..,
'

'

,< '.

...,...::..,

..

I

-

.

·'\_·"'
.),..

\

,.

''·

,.... -...;.·._

'"

'"

,

-'

I

\

• •

~~_/;,.,

,·.- r

I

I

,' '

The Internet
The Macintosh is designed to provide simple and effective access to the Internet. In many
ways, the Macintosh is the ultimate Internet appliance; designed from the ground up to
take advantage of the Web while offering a safe and secure method to get the most from
your Internet browsing experience.
The Macintosh comes complete with a range of tools for accessing the Internet, customizing your Internet environment, and ensuring that your information is secure from prying
eyes and hacking fingers.
In this Chapter, we will take a look at the Internet and the related tools available to you.
In order to experiment with
some of the topics we
discuss in this Chapter on

Internet Connections
Before we talk about how you connect with the Internet, we should take a moment to talk
about the Internet service provider, called an ISP- why we need them, and how they work.

the Internet, you will need to
either have a modem on
your computer or a direct
connection to the Internet
(perhaps through your
school's or company's
account). In addition, you

will have to be able to
connect to the Internet
through an ISP, or Internet
Service Provider.

Internet Service Providers (ISPs)
At the very core of the Internet are huge fiber-optic cabling networks, connected with
highly secure, fortress-like switching centers, much like the telephone companies use to
connect their networks. This backbone of cables provides the ability to move huge blocks of
data in packets. This Internet backbone is controlled primarily by two companies - Sprint
and MCI/Worldcom. They got in early, installed the necessary infrastructure, and are
profiting from their foresight and (at that time arguably risky) investments.
The second link in the Internet chain are ISPs, the Internet service providers. ISPs purchase
the right to move a specific amount of data (called bandwidth) over the backbone. They
purchase large amounts of bandwidth, and therefore are said to have large pipes. A pipe is a
metaphor for how much data (water) they can force through their plumbing.
Then they take this product, for which they received a volume discount, and resell it to
businesses and individuals.
ISPs buy and resell Bandwidth

Large connedion (Pipe)
to Internet Backbone.

-

Some ISPs offer a range of
plans, for example you

Large block broken into
smaller segments and
resold to businesses
and consumers

might pay a certain rate on
weekends, or evenings, and
another rate during peak
hours. Some /SPs offer a
range ofspeeds at different
prices as well.

Once you establish an account with an ISP, they agree to supply you some amount of their
bandwidth in exchange for some amount of your money. In the early days of telecommunications and the Internet, the more time you used the more you paid. These days it's quite
common to pay a single monthly fee and have unlimited access to the Internet.
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Connecting to an ISP
There are two ways you can buy bandwidth from an ISP:
• Dial-up connection. A phone line is plugged into your Macintosh, which is
equipped with a modem. When you give it the command, your Mac literally
calls the ISP up on the phone. A special router at their end answers the phone,
and connects you to their pipe. The bandwidth you receive (the speed at which
you can send and receive information) is limited by the speed at which your
modem can transmit and receive. Modems today average around 56k, or 56,000
characters per second. This is relatively fast compared to a few years ago, but still
far short of what's required to access the more robust features the Web has to
offer, like streaming video, audio, and animations. Downloading large files over
modems is still a tedious process.

A relatively affordable direct
connection is a cable
modem, offered by the
same people that bring you
cable TV. Cable-modem

• Direct connection. A direct connection is always active - you don't have to
connect, logon, enter a password anytime you want to surf the web. The connection is active 24 hours a day, seven days a week, and you don't pay an hourly
rate for usage. You pay for the entire time whether you surf the web, spend a
million dollars on e-Bay, or talk to your friend in Kazakstan for twelve hours
about raising honey bees. Direct connections are expensive (in most cases) and
usually the domain of academic institutions and corporations.

service costs between $30
and $70 per month. While
this isn't exactly cheap, if
you use the Internet for
business at all at home, it's

•

msn. ·- .A.AOL.COM

There are thousands ofcompanies acting as ISPs, Internet communities, or combinations of the
two. You can choose a local provider or a national presence.

probably a good invest-

Other ISP Services

ment. A typical cable

ISPs normally offer other services in addition to simply renting you some of their bandwidth. Some act as local or international virtual communities. America Online, which also
owns Compuserve, one of the very first commercial ISPs, is a good example. Another ISP
with local presence and high-speed cable modem access services is Time Warner, whose
Road Runner product is probably the most popular cable service in the United States.

modem delivers about 5 72k
- and downloading takes
40 or more times less than
conventional modems.

Regional ISPs like Time-Warner's Road Runner service often provide access to local
services, special interest items, support, shopping, and more.
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Browser Software
The Internet is a collection of different services, the most popular and well-known of which
is the World Wide Web. The Web is a huge Ethernet network (we talked about Ethernet in
the last Chapter) consisting of personal, corporate, educational, and organizational computers with special files known as Web Pages on their hard disks. A web page is a special type
of file written in a language called HTML (HyperText Markup Language).
A browser is a software program that translates HTML and displays it in a friendly and
familiar manner.
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The ATC Web page on the left looks a lot different when viewed as HTML on the right.

operating system, they
essentially were giving it
away for free, in addition to
demanding that resellers
who were bundling the
Microsoft OS with their
computers (like Dell and
Compaq) install Explorer
insteadofNavigator. This

• ·t· • )

There are several browsers available on the market, but by far the two most popular are
Internet Explorer, a program from Microsoft, and Netscape Navigator, from Netscape.
You're probably using one or the other on your computer if you're connected to the web.
Throughout this course, the screen shots you see will have been done with Microsoft's
Internet Explorer, which we use on both the Macintosh as well as our PC workstations.

Other Services Available from an ISP
The World Wide Web isn't the only service available on the Internet. There are many others.
Among the most common are:

led to the accusation that
Microsoft was acting in a
predatory manner. As of the
writing of this book the case
is still in court, with
Microsoft appealing the
government's decision to
break it into two or more
companies.
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• Email service. This service provides you with an address for sending and
receiving email. (The email you receive often includes stuff you want to see and
stuff you don't want to see, such as warnings that it has been scientifically
verified at NASA that the moon is, in fact and without doubt, made of blue
cheese.) There are two parts to an email system: the email server that gets your
messages and another one that handles outgoing mail.

· FfP. These initials stand for File Transfer Protocol This service allows you to put
files onto a special type of server, where authorized individuals can go to
download the files to their own machine. FTP is somewhat faster then using
your browser to download a file - especially large files that you want to view
off-line after you've received them. Here at ATC, we make extensive use of FTP
servers to distribute to and collect work from our authors, editors, and technical
personnel.

Authors Mallbox Area
PU.. 10 •o'W'1lloall

An Internet connection
that's running over regular
telephone lines is sometimes called a POTS - Plain
Old Telephone Service.

Uplod a file

[Browse •• )

This page from the Against The Clock web site allows authors to download and
upload files from the site without any special software. It is a user-friendly way to
let authors and editors access an FTP site with no prior experience.

There is an excellent public domain (essentially owned by the "public" and free
to anyone who wants it) software package that lets you access FTP sites directly.
The software is called Fetch and is an FTP client, that it is lets you access FTP
sites to which you have a password and user name. Some sites let you log on as a
"anonymous user" without a password (ATC's site isn't one of them).

Although chat rooms and
newsgroups offer excellent
opportunities to talk with
people ofsimilar interests,
they also contain the most
offensive materials anyone
can find- and we can

'
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Enter host name, userld, and password (or
choose from the shortcut menu):

assure you that there's

Host:
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something there that can
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your household access to
newsgroups and chat
rooms - the potential for

Using Fetch, an author can directly access the ATC FTP site and access the files they
need somewhat more efficiently then they can directly from within the web page.

abuse exists in good
measure within these
environments.
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• Chat rooms. These are virtual rooms where people can get on line and talk in
real time with other people who have similar interests. You can find chat rooms
on any imaginable subject (and some that are beyond your imagination). To
chat you need special software ca1led a Chat client, which lets you log in and
begin typing.
• Newsgroups. In the early days of the Internet, these were called bulletin boards
In the screen shots of the

where people who subscribed to that particular "beeb" could post messages and

FTP sites in this Chapter,

read all the other messages that had been posted. Beebs evolved into
newsgroups with slightly better organized conversation threads take place.
(Unlike having a conversation in a room full of real people, you won't be
interrupted in the middle of a thought.) A newsgroup lets people interested in a
specific subject post questions and receive answers. Answers can be sent by
email directly to the person asking the question or posted where the entire
group can read the responses. The subjects that you can find covered by
newsgroups is as diverse as those in the chat rooms.
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the problem seems a bit out
ofproportion to the reality.
Hackers are more interested
in big sites than they are
individuals accounts. That
doesn't mean it doesn't
happen.
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Here you can see a posting from the Seattle Mac Users Group newsgroup. The
original poster had a problem shutting down his iMac, and three people responded with answers. Newsgroups are an excellent support network used by
millions ofpeople worldwide.

Internet Tools
Let's explore some of the tools that came with your Macintosh and provide control over
your accounts, your access methods, and the security of your personal information.
When you sign up with an ISP, you get an account number, a user name, and a password.
The provider also gives you certain codes required to access their system, for example the
name of their server, and the names of any special servers, such as those that provide email
services, FTP services, chat rooms, and newsgroups.
You must manage all this information, and have access to settings that control your connection with your ISP. That's where the built-in Internet applications come into play.

Configuration Manager
In Chapter 4, we explored
the built-in applications

The most useful of all the Internet management programs that Apple provides with the
Mac OS is the Configuration Manager control panel.
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do with the Internet and
networking until Chapters 5
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turned on and off using
Extensions Manager. If any
of the tools that we feature
in this Chapter aren't on
your list, be sure to check
that they're loading at
Startup.

General Controls
The General Controls section of the Configuration Manager stores the fundamental
information about your account, including your Real name, your email address, and the
company you're working for.
You'll notice that there is a field under Sending Mail named SMTP host. This is the server
that's used for your outgoing mail. You can get this information from your ISP, and should
have it if the m achine you' re working on is able to send email. Under Retrieving Mail, you'll
see that the protocol being used is called POP. This means Point of Presence, and is the
most common way of receiving mail. Whatever program you're using to send and receive
mail requires this same basic information.
AutoFill
Lots ofWeb sites require that you fill out forms. Whether you' re registering with an offshore
blackjack company or buying books on Amazon.com, you often have to provide basic
information about yourself. When you are, you can select the AutoFill feature.
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There are two functions available from this dialog box. The first is the Forms Completion
Editor, which gives you the ability to create a sort of shorthand where the Mac recognizes
what you're about to type by looking at the first few letters. This is handy if you have a long
email address, or if you want to quickly enter a positive or negative comment. You can enter
the phrase here, and when you start to enter information into a form, typing the first few
letters will result in the rest of the phrase appearing automatically.

You can create a list of frequently entered phrases in the Forms Completion Editor.
The AutoFifl feature is very
powerful, and can save a
tremendous amount of
time ifyou're researching on
the web or performing

The second function of the AutoFill dialog box is to provide a place for you to fill out
complete personal information form. You can enter the information you need into this
form, and retrieve it by clicking the Auto Fill icon, which will be available to you whenever
there's a form you need to fill out on the web page you're working with.

similar activities that
require you to provide all

v E-••11

your information routinely.

v

0 Otntt".tl

11,.iem 1Pnflr::,l~•E:::=::::'.::==:=:::=:;::==:::::'.:'.:;l
fl"I neme:

Fetrms A•tof'l ll

Most research sources and
( v ......,.,1c

all commercial sites require

G Pro1ocol Htlpws

that they gather some

0 Proxl.,

O Sitt P.arsvords

information on you before

v

they give you what you

I
~

:========:i:::==z====~,

t;ut no"'e:
Mfildle ,Jnlt)ol;
O.-.ienrzelion:

;:::==i:::=========:'

[ljome pllQne:

;:;:::c;;==::=::==:~~~;:;;:;::::::;:;::z~

1

FE=::::~=::~:::::::;E==~~

Rooohrlng Flt.s

O Do-.tnload Options
0 Flit Htl>ff's

want. Using AutoFifl can
v ... Brews.r

v

save thousands ofkey-

0

strokes over a period of

Sro'WUI'

Dlsploy

0 'o'tbConttnl
O Homo/Sorch

time.

This Profile form lets you prepare forms once for use in dozens ofdifferent places.

The Auto Fill command is simple to use. Once you've entered all the information into the
AutoFill profile window, all you have to do is click one icon, and a form will be filled out
automatically. This illustration is from Internet Explorer 5.0 for the Macintosh.

You can see the AutoFifl icon between Home and Print.
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Network Settings
The next category of items over which Configuration Manager offers you control are the
network settings for your Browser. These include Protocol helpers, which let you map
specific file types to applications on your Macintosh. Most of the default settings are fine
the way they are.
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Standard Internet file formats are mapped to specific Macintosh applications
using the Protocol Helper Settings in the Configuration Manager.

In many corporate environments, a security device known as a fire wall is deployed. A fire
wall is a special application, normally running on its own separate server, which monitors
incoming and outgoing traffic in an ongoing effort to protect the contents of the company's
network from unofficial access. Fire walls often limit the way an individual workstation on
the network can access the Internet, as well. Because they're designed to stand in between
the Internet and the corporate network, most IS professionals choose to install what are
called "proxy" servers. Proxy servers are a security device that lets people behind a fire wall
access the Internet normally.
Ifyou are acceHlM the lqternet throuoh a network at your compeny

you can.oelect internal ·OOrvel'O (gote'otayo) to
moneoe lnfernehceeao. Contact your nefwork.odmlnlolrotor for
more lnformetlon.
0 Enebled f) Dloable<I

o~ 2,..,.ntzallon,

before doing so. In corporations, they're referred to as
IS, or information services
professionals.
~~ Pl'W<Y for

Joool oe"'"r•

Lls1 the oiteo yotf'olent to connect lo directly, b\lpeo•lllll Ille proxleo
oet aboVe. Put a space or commo bet>.lten eoeh site.

Your system administrator would have this information ifyou're behind a security fire wall.
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All sites that have anything to do with commerce or, in some cases, proprietary information
will require that you have a password to enter the page. You can keep a list of your passwords in one place within the Configuration Manager.
Pasavord seft1a1a -__ _.......,.~_..,....__ _.-..-_...._,
If l/OU vl•lt e sl~e thel<rt!lul res e uoe•ne"!". end pesrw:ord,
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We will talk more about
11

password management

Delete

when we discuss the
You can use the AutoFill to keep track ofthe passwords for specific sites.

Keychain feature, which
when used in conjunction
with the Multiple Users
feature, can provide limited
access to questionable

Downloading Files from the Internet
Surfing the Internet often includes downloading, or receiving files from other sources, you
can set exactly where these files are saved from within the Download options category here
in Configuration Manager.

areas for users within your
household.
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Shareware is software that
you can download for free
and use for a while before

Once you've identified where you want your Macintosh to save downloaded files, all you
have to do is find something to download. There's plenty to find. You can start with http://
www.tucows.com, or shareware.com.

paying a nominal fee for
permanent registration and
the ability to receive
information about updates
and new features. Freeware
is software that you don't
have to pay for but often
doesn't get updated by the
authors.
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This image is from TuCows.com, an excellent shareware site where you can find
plenty of Mac software in dozens ofcategories.

Most shareware sites allow you to search within categories for particular products, then
they supply you with a list of items that fit your criteria.
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Filesavailable for downloading are normally
compressed, or "stuffed" to
save time for both the
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originating site and the
person doing the down-
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loading. To facilitate
opening these stuffed files,
you'll need to download a

This image from Shareware.com, another well-respected shareware site, shows a
listing ofgames available on their servers.

file called Stuffit Expander.
It's free and available on
any of the sites we mentioned as well as at the
manufacturer's site, which is
http://www.alladin.com.
They have commercial

When you begin the download process (usually by clicking the Download button or the
name of the file that you want), the Download Manager comes alive.
Download Manager is a system-level application that automatically activates whenever you
choose to access a file from the Web. It maintains a list of files that you've recently downloaded, and you can access them directly from within the download manager, pausing or
cancelling them if need be.
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Download Manager sends the files into the folder you set within Configuration Manager.
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When your file arrives, it will be stored in the folder you targeted in the Configuration
Manager. In this case it's the Downloads folder, which is at the top level of our internal hard
disk.
Downloads · · Name

Mocllttock t.99 f.slt

"m oppllcetlon.pdf
Iii Sf Scribbled Sons v i .O.slt
Iii E13ytonult
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-

Sluffll Del
oppllcetlon
Sluffll Del
oppllcotlon

oppllcetlon
folder

Don't think that downloading files can't lead to
trouble. There are malicious

The Downloads folder is, by default, the location where your downloads are stored.
Once you've unstuffed them and installed the software, you can throw away the
original stuffed files. They can really add up if they're large files, so watch this folder
carefully.

people out there who want
to wreak havoc because
they think its fun. Every day
on the news we hear about
new virus attacks bringing
large corporations and athome surfers to a halt
through a variety of
damaging programs that
infect your computer when
you download and open

Controlling the Behavior of your Browser
The Browser controls within Configuration Manager control how your browser functions,
including how it looks, what site it uses as your "home page," and other useful features.
Display
In the Browser Display dialog box you can select a color to differentiate between links
you've visited and ones that are yet to be explored. The Toolbar setting allows you to
customize the toolbar that sits above the Browser. In our case we're using Microsoft's
Internet Explorer, but if you're using Netscape instead the controls are essentially the same.
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Web Content
Web Content determines whether or not pictures are displayed, if video can play, whether
or not animated GIFS go through their motions, and other settings related to the graphic
quality and complexity of the content your browser can put on screen. This is naturally
related to how fast your connection is. If you're using a slow modem, it's a good idea to turn
off some of the more processing-intensive functions (such as video).
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msnbc.com. Other people
like to go directly to what's
known as a portal site.
There are many different
portal sites out there. AOL is
considered a portal site, but
its proprietary, members-

The Content dialog box provides settings to control the complexity of the objects
being downloaded to your browser from any Web page.

Home/Search
This dialog box lets you determine which page (if any) will load whenever you start up your
browser and log onto the Web. It also lets you determine what search engine you want to use
when you click your browser's Search button.

only causes some people to
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'
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0 Slbsorlptlons
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Your aeerc~ per,ie lo openedvhen you select Sesrch the Internet
ftom \hi Go menu.
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I
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-
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It Use Default
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OK

I

Select any site in the world as your home page, or have the Browser open without
any pages showing - just waiting for you to command it where to take you.
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Language and Fonts
The Language and Fonts dialog box lets you pick the language you want to use and which
fonts are used to display page content in your Browser.
l n t - ...,.-~------------,
Some lnternel sites send different l*jeS dependl"'l on !ht 11"9"'90

\,'OUr br.....,.r ls-xt to. lf\,'OUereoccesolnr.ioneof t,_ sites,
select the l•"'luogo !IOU ....,uld II kt to see.
leng1J09&: I Enqllth (tn)

u~ I

Foals -~~;;;>;-:--~--------,

Select tho default clla...cter set ud font to use vhen Mrvtrs or
Web pocJOS dO not p ~ldoo ne.

Character set: I Western (Lttlnl)

P~oportlonellfont: ~(T~lme::•:::=;;;:;::::;.:;::=~
flXed·vldlh ronl: '-'(Mo-"=nec:o=-_ _ _ _ _ _......,

Proportional fonts are for reading text and fixed-width fonts are used for tables.

Subscriptions
Subscriptions provides a way for you to be notified if a web page has changed. Some sites,
such as cnn.com or msnbc.com are changing every five minutes, and therefore aren't well
suited to being set to "notify by email." If it was, you would be getting about thirty thousand
emails a day. Others, like corporate sites, or sites that list press releases for specific corporate
sites, might be a good candidate for notification.
When !/OU subscribe to s ites In your fOYOrltn, Explorer cu notify
!/OU or che..,.. to those sites.
the .,ttlnr.is belov to errenoe hov
\,'OU'd like to be Mtlfied.

u.e

f Cbeck For Cllaaged Sllet , . . . - - - - - - - - . , . ,

I0
0

Manually
£ech time Explorer It launched

f) Every

rr=:::::J (._,O!'J$=:;__

O Ploy• sound: 1~c~~~....rw~_
0 Olsploy en elert
9 flesh Explorer'• icon

__..,..,

_....~

I

0 Sende-mell

Java
Java is a programming language originally introduced by Sun Microsystems and put in the
public domain. It provides much of the animation, flying logos, lighting buttons, and
scrolling marquees we see on the Web these days. Because it is a program that runs on your
computer, there is a remote possibility that someone could write a Java program that did
something bad - for example, erase your hard disk. Although it's not likely that will
happen (there are much more devious ways to accomplish this if someone really wanted
to), you can turn off Java so that it can't run. It will make the Web a less interesting place if
you do, however.
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The Java dialog box does offer some security measures. It's a good idea to leave
the security settings as they are when you set up your computer.

Ever visited a web site that
knew who you were, and
welcomed you back? That's
the case with many
commercial sites these days.
The trick is accomplished
through the use ofsomething called a cookie. A

Ratings
The Ratings tool provides some control over the type of content that can be viewed on your
system. Ifyou have kids in the house, it's a must-have. There are a number of commercial
products available as well that will provide access control over your system.

v

cookie is a small file that
contains information about
you, your surfing habits (at
that site, at least), and other

--

,- Rathip S.ttlllp
0 £111bled f> DIMblod

I! tr..\!l! "-J'Ord... )
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l·; I
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IL: I
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('llont

11: I

0-Un9"19f

( IS~

11: 1

v

0-Yloltnce

I

11

turn offyour Mac's ability to

0-Nudlty
0-L-.

information, such as your
buying preferences. You can

.._

~TM RSAC Rati119s &.rvlff

hconn1o1

!iii

~

P...Jonoto ti..11111
Clothed 90Xuel toUChlfl\l
Non-expilcll -uel acliYlty
Ex_.e!lcll MXuel acllv~

The llecreet101111 So""9re AdvlaoryCouncll re!ing~rvlce. Be*
on the "(Ork of Or. Oo111ld f . Robert• of StenfoTII UnlYt~lty, "'ho
hot •ludled tbt effect• of-~· on children fer rihrly 20 y..re.
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download cookies from the
Configuration Manager,
under Cookies. It will show
you which ones are on your

("'AllifStrv!Ci:..

..=:=-

I [Remove Service )

l

(Options...

J

---....
Don't ask us - it was Dr. Roberts ofStanford University who came up with the
Rating System adopted by Apple for the Mac OS.

machine right now, as well.
You can also set the Mac to
ask you before it accepts a
cookie, then you can decide
who to let into your kitchen
and who to keep out.
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Advanced Settings

There is a collection of advanced settings, that control, among other things, how many of
the site you recently are kept in the Browsers History tab.

A security certificate is a
special type offile thars

Keychain

downloaded to your

One of the newest features in the Mac OS is the Keychain feature. The keychain is a special,
secure file that stores passwords and security certificates for specific web pages.

browser when you're
visiting a so-called "secure"
site. A secure site is one that

The Keychain is a control panel. The first time you access it, the program asks you if you
would like to create a New Keychain, and explains what the Keychain does for you.

is using high-level encoding
andencryptionsofnvare,
and maintains a level of
security that is acceptable
in the eyes of the issuing
company, which normally
and routinely performs
security checks ofits client's

If there isn't a Keychain on your system, you have the option of creating a new one
when you launch its control panel.

sites. This service costs the
subscribing web company a
fee, but irs well worth it in
these days ofincreased

Ifyou click the Create button, you can create a new keychain, by providing a name and
password.

concern over internet
security.

Providing a name for the Keychain and a password (which you have to retype to
confirm it's the one you want) creates a new keychain with that name.
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Once you provided the password and name for the keychain, the Keychain window appears.
E!l el"

"'
Once you Jog onto a site that requires a password, you will see a checkbox asking
you ifyou want to save your password. Clicking 'yes' will add the site to the keychain.
You should make sure that
you pick a password that's

From the Edit menu, you can choose to modify the keychain by changing the password or a
time after which- if there is not activity on the system - the keychain automatically locks.

at least six characters Jong
when you create your

[_m

keychain. Any Jess than that

Ouinge "Gary" Settings

is considered not to be a
secure password, because
there aren't enough
characters to make sure

D Allow occess wlthoutwomlng

someone can't figure out

Iii Lock otter ~@ minutes of lnoctlvlty
Iii Lock lt"len the system sleeps
[ C.iincel ) H Sove I

the word or phrase you
used. Ifyou attempt to use
too short a password, the
Keychain program will
warn you with an Alert box.

You can set options for an individual keychain from the File> Settings menu.

From the same menu, you can choose to view the built-in certificates. There are several
companies listed, with Verisign arguably the leading Internet security company on the
market today.
Kind

li3
!i3
!i3
li3

verlSIQn, Inc. Cius 2 Primary
VerlSIQn, Inc. Cius 3 G2
Ve riSign, Inc. CIUS 3 Primary
Ve rlSlan. 1!11). c11m 4G2

root certiOcete
rool certlncel•
root certlflcete
root cerllflcete
root cerllflcele
root certlflcete
root cortlflcele
root certlflcete
root certlflcele
rool certlflcate
root certificate

~

@I ( View Certificate I
Here you can see several different types ofcertificates from two companies:
Thawte and VeriSign.
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Certificates are highly complex objects that contain chains of numbers, which when
accessed with the proper key, are able to verify the security of the documents being sent, the
passwords being used, and the transactions that might occur between the connected
machines. You can view the contents of the certificate by choosing one of the certificates in
the list and choosing View Certificate.

~

Root Certificate

~

This certlftc11te Is OK

Issued to:
Secure Server Certlficellon Authority
Key length:
I OOO·blt
Key type:
RSA
Serl al Number: 3558802160848854062232407011 s21
Expires on:

ThuNCtay, Jtnllary 7, 201 o

Issued on:

Wedneoday, NcWember 9, 1994

Angerpr1nts - - - -- --'-'--'-'----'..:..;,,..-..
MOS

74:7B!82:03:43:f0!00:9E
6B:B3:EC:47;BF:8S:ll5:93

SHA· I
44:63£5:3 1:D7:CC£.1 :00:67:94
61 :28:86:S6:03:BF:82:S7:84:6f

~

It.

Ht

Qone

I

Viewing certificates and trying to memorize their serial numbers is a great way to

spend a rainy day.

Email
Although we can't be sure which program you're using as a Browser for the Internet, or for
your email, but since Microsoft's Internet Explorer ships with Macs and includes an
excellent email program called Outlook Bcpress we felt safe using that program for the
examples in this chapter. Even if you're using something else, the basic concepts are the
same.
Email is, without question, the most popular Internet-related tool in the world. It has
replaced millions of phone calls, saved millions of dollars in postage, and helped create a
new brand of worker- the telecommuter.
Launching Outlook express displays the Outlook Main Window, which shows a list of
functions and objects on the left side, and your email In box on the right.
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~ lnbo•
Outl>o•
~ Sent l«ms

&

~ omt.(5)

Ii

GI
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Although Outlook is the

~

target ofmany virus

Deleted Item s
Book 8 uslneu:

(I

Ad dres s Book

I

news •strver

CH

ntws9ro1.1p s

Ro .. dRunnu

Dft-vs.Mcu

attacks, it seems that for
certain reasons the
Macintosh version ofthis
excellent email client is
impervious to them. A part
ofthe reason that many of
them are written in a
language called Visual

You can see a list ofavailable items on the left, including your lnbox, your Outbox,
things you've already sent, drafts of new emails, and more.

Basic, a Microsoft language

Sending an Email

that's limited to the

To send an email is quite simple. You click the New button in the upper-left corner and
select New Message.

Windows and WindowsNT
platforms. The Mac OSis not
as easy to break into; many
programmers who are

When you do, you'll be presented with a window that allows you to compose a message to
anyone. The first thing you have to do is let the system know who you're sending it to. This
requires an email address- usually in the form o f som eone@som ething.com.

perfectly able to disable any
PC on the planet simply
can't figure out how to do it

f rom: I ellu n ( Ellenn Behor lem)

to the Mac. Also, since the

9 To:
9 Co:

PC is so dominant in the

" Bet:

SQbject:'~:::::::::::::::::::::::::::::::::::::::::::::::::

marketplace, with some
85% ofall computer users

working on Windows

@d

•

Defeull

Attechmenti:

?.l I

/JW1lf

fo~·

TtxtSl:e ·111

I

Jl

T

I

machines, you can concentrate your meanness more
easily and more effectively if
you mess up PCs. Who cares
about a few million artists,
designers, free-thinkers, and
graphic professionals
anyway?

The new message window, where you can compose a message to a friend or associate.
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Outlook has the very useful facility to add anyone who sends you an email to a built-in
address book. Additionally, you can add people to the list yourself, and include their email
address. Ifyou already have names in your list and click in the To: field, you can access your
address book. If you type in the first letter or few letters of a name, the address book
intelligently assumes you're looking for someone in that range ofletters.

The image is fine; we've smudged the addresses a bit to make our writers feel more secure.

Once you've picked who you're going to send the email to (and you can send it to any
number of people by separating their names with commas), you can enter the body of your
message in the space below.
You can also attach a file to be sent along with the email by clicking the Attach button and
browsing through folders until you find the file you want to send. It will automatically be
saved to their computer when they receive the message.

Signing Your Emails
A very useful feature is the ability to store a list of signatures, and then use them for specific
types of emails.

You can make Outlook
Express randomly select
from the list ofsignatures
that you have created.
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You have access to a list of three standard signatures. You can add more or double-dick any
of them to add your own signature.
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You can delete your mail by
selecting it and clicking on
the garbage can icon in the
Outlook Express too/bar. It's
a good idea keep your
lnbox cleaned out by

!-;Nole: - - qpoce><return> I! en optlonel lnternel·etenc!erd •!ineture seperetor.

~,

~
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You can make friendly, formal, fun, or angry responses with which to "sign" your emails.

sorting through old mail
and deleting what you no
longer need. Ifyour lnbox is

Once you've created your list, you can select any of them from the pop-up menu that
appears on your toolbar.

full ofemails that you need
From: ( elltnn CEllifili Behorlam)

to keep, use File>New>New

I

Folder to create places
where you can store stuff.

To:

II Gary l'<>yoolck

ICC:

9

8":

When you're done, click the Send Now button, or the Send Later button (to which you
assign a time and day it should be sent), and you're done. Outlook closes the window and
takes you back to the main page.

Receiving Mail
You can see all the mail that's in your Inbox in the right side of the main Outlook window.
To read one, click on it, and its contents will be displayed in the lower half of the window
To permanently delete
emails, you have to open
- ' lnbOH

&

deleted items and throw

Outbow
~ Stntltuns

them away again. An

ei
Ii
Iii

alternative is to set your

(&

preferences so that the
trash is emptied every time
you quit. This might prove
troublesome, though, ifyou
ever want to retrieve
something from the trash.
We try to do it about once a
week, to make sure we don't
accidentally trash some-

~

~

I

OQfb(S)

......

Dtltttd It11ms

Book &uslntu
A ddress &ook

nevsg roups

RudRunntr
OlrtcU>rys..vlcts

From: Oirtlook Expr...'1",eem <mo.-•mlcrosonoim>
Subj.ct. Walcome to Oull~k Exp....,.

If!- .J;.

j Deliver the message with Outlook Express S Macintosh
Edltlonl
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Microsoft Outlook Express 5 oives you easy-to-use e-mail and
contact information manaoement, with Mac.first innovations
designed to meet your everyday needs. It's easier than ever
to send and receive e-mail messaoes and to manaoe
information about your friends and contacts. What's new and
important about Outlook Express 5?
• Simple-to-use You can easily create and keep track of
messages. With a single dick of the mouse, you can use
Address AutoComplete to address messages to contacts

,.-

thing we really needed.
All ofyour emails are listed at the top of the lnbox window. Unread mail shows in blue and has
a star icon to its left indicating that it hasn't been opened yet.
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Using Outlook for Newsgroups
You can use Outlook Express to browse newsgroups. First you will need t11e name of ilie
newserver iliat your ISP is using (some ISPs only offer limited access to newsgroups, so
you'll have to check with them to make sure they offer the service). Once you have that
name, you can enter it in the Tools>Accounts>News window.

You can addyour newserver to this list ifyou have the proper address from your ISP.

Once you're connected to your ISP's newserver, you can find t11e thousands of newsgroups
t11at are out there on the net. Here we typed in the word Macintosh and you're looking at
one-tenth of ilie groups.

•ft.bin1ri•s.sound1.m.ctn·t o1h
• lt.bln1rt• s.w.arez.m1clntosh
•lt.com p.sys.malnbo1rd.m1clnto1h

.alt.tl•mt.m• clntosh
.tt.fhm1.m,acfntosh.fl1mt.t.odd
11tt.9.11m •s.mlcro:1oftm1cintos h

tlt.l_rc.channtl.mulntosh

.ah:om•clntosh.k•ltldoscopt
•lt.n1dntosh.waru
1
11t.maclntosh.waraz:.1ppllcatlons
.alt.n1clntosh.w1rer.9.amts
1ft.mulntosh.w•ru.stt.1z

i

1lt.rn1c int'Osh .w.arez.udlltJ11

comp.svs.maclntosh
ts .1tt.bln1rtos.m1clntosh
1s.bin1rtos.m acintosh
es.comp.m.aclntosh

1s.c=.omp.rn •clnto.sh.m l1c
1s.comp.m.aclntosh,pro9r1m1cion
up.comp.slst1mu.maclr.to1h

.. ...... ............ _.,.,......
,.

48DID rou Csl 41 dis I

These are a few of the 41 Macintosh-related newsgroups we found on our newserver.
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Using Directory Services
You can use Outlook Express to access a list of directory servers - virtual phone books
containing millions of email addresses for people all over the world. You do this by clicking
the triangle icon next to Directory Services and pick one of the books.

We have a list offour different resources with two servers each. Interestingly
enough, each of them contains items that the others seem to not contain.

To find someone in the directory, pick a book, enter their name (or their email address),
and you will be presented with a list of matching entries. Here we entered the name Smith.
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S mith
Smith
Smith
Smith
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~

Surprisingly, we were able to find quite a few Smiths in the Bigfoot directory,
proving the effectiveness of this powerful tool.
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Security

-

In the next Chapter we're
going to explore the use of
Sherlock, Apple's answer to
the ultimate search engine.
Sherlock can be used to find

Although the Internet isn't the only place where the security of your data comes into play,
its rapid development has certainly left many experts a little behind the curve. It's clear that
the systems at any company or organization - no matter how secure they feel their systems
are and regardless of how much money they spend- can be breached. There are constantly reports of break-ins. Some are benign and others destructive. There's only so much
an individual can do to protect their secret information. If a really talented computer thief
wants to see your grocery bill, or how much you spent at the liquor store, they're going to
see it. You have to decide what is top secret information that really needs protecting and
what's just dull, useless information. If you want to send relatively secure information to
someone via email, or you want to protect certain information on your computer from
prying eyes, then there are two tools included with your Macintosh that can help you do
just that.

things on your hard disk as
well as people, places, and

Multiple Users

things on the Internet.

In offices where more than one person needs to share the same computer, and in homes
where it seems that every member of the family has a different use for (and simultaneous
need of) the one computer in the house - Apple provides a powerful yet elegant method
of ensuring that everyone's experience is personalized. The feature is called Multiple Users.
We felt that it was best to discuss this feature in this Chapter, since the Internet and online
services create the need for solid security measures, as well as creating a situation where
what's appropriate for one user is totally inappropriate for another.

Directory services is an
effective and powerful
search engine though,
especially when you're
looking for people.

EJ !ii;lw

l--

,M=> Don
.,,

wner

( 111i!W User )

I

Open

[ Duplicate
Delete

I
I

It !!ii!liifd

-

I

The Multi-User feature is

Multiple user ~ciounts: O On

f> on

available as a control panel.
The Multiple Users control panel allows you to add and delete users in three
different categories, each with their own privileges and access.

There is one default user you, andyou're listed as the
system's Owner. Yourfirst
name (taken from the
Configuration Manager) is
your user name, and it's also
your password. Ifyou're

How it Works
Inside your System Folder is a folder named Multi-User Items. This folder contains a special
collection of folders and preference files that combine to provide the facility to present
custom desktops, custom system folders, custom control panels, and access to only those
items and applications that the Owner deems appropriate.

going to use the feature, it's
a good idea to change this
right away.
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i
Normally, the Multiple User
function is turned off, and
can only be turned on (or
offagain) by the Owner. No
other user- no matter

,, - - i..

Global Prefs

Groups

Printers

0$er Default Profs

[Jt

UsersCeche

Pictures

~

Users

~

User Profs

how much access they have
to the machine - can
disable the function. Ifyou
forget your password, there
are very few ways that you
can get around any security
or access settings. One way

Additionally, when there are multiple users set up on the system, a folder named Users is
created on the hard disk where your System Folder is located. Inside this folder is the actual
user information, as well as aliases of a Shared Items folder, which any user who has the
privilege is allowed to put files that are visible to other users on the system.

is to completely format the
machine, but if the other
users on the system can't
see all the other user's

:ll\
1

Junior

ra

Shored Documents

documents, you can't
effectively back all your
data up before you go and
fry the drive.

The Users folder contains the Shared Documents folder for each user- a place
where other users can access files created by the current user.

User Levels
There are three different levels of user besides the Owner.

As the Owner, you have the
option of determining the

• Normal. A Normal user has essentially the same access as the Owner. Exceptions
are the ability to turn off the Multiple User option, and the ability to open other
users' document folders. A Normal user can be granted the ability to manage
other accounts.

User Status ofa New User at
the time you create them.
You can also change an
existing user's status to a
higher (or lower) level, or

• Limited. A Limited user also sees a Desktop and volume icons the same way the
Owner or a Normal user does - but their access is limited to exactly the
applications, folders, and resources that the Owner (or Normal creator) has
assigned. By default the only thing that a Limited user can do is save files into a
global Shared Items folder.

edit any of the privileges.
Such changes will take
effect the next time they log
onto your system.

• Panels. Designed for the user whose access is limited to a very narrow selection
of applications, volumes, and system resources. The Panels user sees an interface
different from that seen by Owners, Normal, and Limited users.
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Creating Users
Creating a new User is as easy as clicking the New User button, which activates the New
User dialog box. If Multiple Users isn't turned on at the time, you can still m ake changes,
but you will see an Alert dialog indicating that the modifications won't take effect until you
restart the computer.

Changes take etrectwhen Multlple users Is
turned on.
Multiple Uoer ee«1unts ore cur ronlly turned off. Art;
changes mode In usor eetlln<JS ...111 toke effect ..,hon tho
wnor turns f"1ultlplo U"r ~unts on.

You can create new users and edit the settings for an existing user even if the
Multiple Users feature isn't turned on at the time.

The New User dialog box presents an array of choices for customizing the User's experience
and what they can and cannot do. First, you create a User Nam e and Password.

userName:~jr_o_m_111:~Y~~~;:;;;;;o.,._~....,._.-..
Password:

I.....

~nd ofl.JserA~count: .
Normal

l.Jser Info
User Picture:

I

l1itI

•
Limited

Panels

Altemnte P11ss\Yord

[JJ@

Select picture or drag Image and drop on
picture frame

(if User can change password
(if Can log In

O Can manage user nccounts
El Access by others to user's documents: IRead only

password to a User, they can
log on by double-clicking
during the Startup process.

j

The New User dialog box (which is the same as the Edit User dialog), can be
expanded to show Setup Details by clicking the triangle below the "Kind of User
Account" icons.

Ifyou don't assign a

their User name or icon

:

In this example, Tommy is a Normal user. You can see four tabs in the bottom portion of
the dialog. User Info is the only one that's applicable to a Normal user. You can allow them
to Log in, to Change their password, to manage other User accounts. By checking the
"Access by others to user's documents," you can determine if other people can read them,
change them (read/write), or write only (for mail drops, for example) .
When you create a Limited user, however, the other tabs -which control access and
establish restrictions - become active.
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!iii

UserNllme: lrommy
Password:

I••

00

I

•

KlndofUserAccount .

•
Hormel

•
Penels

li mited

When you're creating a user,
you can assign them any of
the several icons that are
supplied with the program,
or- ifyou have an imageediting program -drag
custom icons into the User
Picture window.

Alternate Password
User Appllcatlons:
D 0 Share a Folder (no Guest)
D B ShareWay IP Personal Bgnd
Iii l1J Sherlock 2
D ~ ShockwaveDownload
D Show profile Info
D Slmple!Jeund
9 ~Sln1pleText
Show: [ all appllHtions

~

I
Selecti\lr 1

MdothFr-

Setecflliliiej

c

The first choice you have when creating a Limited user is which applications the person is
able to use. The Control Panel maintains a list of all the applications on the computer. You
can go down the list, and activate any program by checking the box to the left of its name.
When that User logs on, these are the only programs that they'll be able to run.

The Multiple Users feature is
a real space hog - it
essentially creates an entire
duplicate System Folder for
every user you create. Be
aware of this when
considering creating new
users. Ifyou have plenty of

The Privileges tab is where you determine if the user can access CDs or DVDs on the
system . You can also restrict or allow the user to access removable disks, such as Jaz or Zip
disks. Additionally, you can determine if they can see the Shared folder, use the Chooser
and Network browser, and whether or not they can print. You can even limit their output to
specific printers if there are more than one on your network.
User Info

Alternate Password

Allow access to ----------------~
9 Shored Folder
Iii CO/OVD-ROMs
@)Any

0 List for restricted users

D Ottler removable media

Iii Chooser and Network Browser

D Control Ponels
Iii other Apple Menu Items

9 User Con Print
Allowed Printer: [ All Prlnfers

drive space, then it's not a
problem. Ifyou're limited on
space, though, you should

You can use this dialog box to limit or allow access to Control Panels and other
Apple menu Items.

check to see how much
room is left afteryou create
a new user, and remember
that you should try to never
use more then 70% of the
available space on your

The third kind of user - the Panels user - is the most limited type of User status you can
apply. In this mode, the user doesn't see the normal desktop when they log in. They only see
a set of panels, which display the applications they can use, and their own documents
folder. If they double click a folder, a third panel opens displaying the contents of that
folder. It's a very useful mode for users that are likely to break something iflet into the
basement.

drive.
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Acrobatn

Reade.-4.0

•
[It

Phot~ ...

Adobe
lllistrat0<0 8 ...•

r!
PegeMal:"'® ...

~

~
Internet

1.99

Shared

OocuTients

Adobe®

Adobe®
Photoshop® ..•

~lacAttack

Desi<topfolde.-

Explorer

~

t~icrosoft

PowerPont

~

M1erosoft YIOfd

The Panel User doesn't see the regular desktop. Instead they're presented with
only those options the Owner allows.

Logging On
When the Owner enables the Multiple Users option, the machine will begin to start up, and
then display the Log In window. From there, the user selects his or her icon from the list,
and are then asked to enter their password (if one was assigned) .

4Jf'

it
Y'iii.

Don
Gary

Junior

Cllaqoo Password

~
~og In

If the wrong password is entered, the User will be unable to use the computer. The dialog
box will simply sit there and shake its head, so to speak.
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Deleting Users
As the owner, you can delete any users you want with the exception of yourself; there always

has to be an Owner. To delete a user, select their name from the User list displayed in the
control panel and choose delete.
Don

'°"'ner

Gary
normal user occount
manages oc:counta

Junior
ptnels user oc:count
Tommy

limited user eccount

When you do, you will first be asked ifyou're sure that you want to delete the user. You
cannot Undo this command. Once you delete the user, you will be asked if you also want to
delete their documents folder.

As the owner you can delete a User and the files they created- but you have to
do it in two steps.

Chapter Summary
In Chapter 7 you explored how to connect your Macintosh to the Internet. You looked at
Browser software briefly discussed services available on the web, such as File Transfer
Protocol, chat rooms, newsgroups, and email. You learned the use of Configuration Manager for controlling the behavior of your browser. You explored the use of Download
manager, and learned how to connect to shareware sites and download files for use on our
own computers. You also learned about the Keychain Access control panel.
You looked at the operations of Outlook Express for creating, sending and receiving email.
You also saw how Outlook provides access to newsgroups and directory services. Finally,
you explored the Multiple Users feature, which allows you control how your Macintosh can
be used by other people.
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Notes:
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Sherlock
Sherlock is a unique and powerful application known as a search engine. It's an important
component of the Mac OS, unique because it's the first tool offered as a component of a
commercial operating system that's able to search both locally (on your machine or network) and globally, using the World Wide Web. It's both intuitive and intelligent.
Finding a specific file on
your hard disk or network is
one thing; finding what

Sherlock is an Apple Menu Item called Sherlock2. It is the second generation (the first was
released with Mac OS 8.5) of the program, and it is unlike most other searching tools
available on any computer platform.

you're looking for on the
vast universe of the Internet
is another. Ofthe hundreds
of tools designed to help
you effectively perform a
search, Sherlock is the best
of the breed. It can look
around the world almost as
quickly as it can find that
important letter somewhere on your system.
Designed to function
seamlessley within the
Macintosh operating
system, Sherlock is worthy
ofstudy. The more you use
it, and the more you
understand its subtleties,

Sherlock doesn't look like most other Macintosh dialog boxes; some people feel
that this interface represents a new look for Apple that will begin to show in other
places.

the less time you'll spend
tunneling through garbage

Channels

to find the one article you're

Sherlock operates with what are called Channels; that is it maintains separate lists of places
to look under several built in categories. Additionally, you can modify and add to this list of
Channels, to make Sherlock increasingly customized to the way you work.

looking for- or that one
best high-school friend.

Channels are represented by the large icon buttons that you can see across the top of the
dialog. Each of them is designed to search for and find a specific type of object or piece of
information.

The Disk Drive channel looks for files and folders, and can even search the contents of files,
seeking out and locating a specific word or phrase within, let's say advertising copy, or a
newsletter layout file. In the window below is seen the drives and volumes currently con-
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nected to your computer or mounted over your network and visible on your Desktop. It is
the only Channel that doesn't require an Internet connection to work.

You can activate Sherlock
from the Finder by pressing
Command-F for Find.

The World Wide Web channel looks for web pages containing the copy you enter as a search
criteria. Unlike using a single search engine, like Yahoo.com or CNet.com, for example,
Sherlock will look at multiple sites at one time, each running in parallel, and display the
combined results in a logical and meaningful fashion. Sherlock makes searching the web
much easier and more effective then any other application we know of.

Command-W closes the
Window and puts the tool
away where it will patiently
awaityour next command.

The People channel looks for individuals, using directory services much like those we used
from Outlook Express in the last Chapter. Actually, in their default states, the Outlook
directory services contains three search servers, compared with the two that come standard
with Sherlock.

The Shopping channel (not to be confused with that award winning television program of
the same name) is used to access retailers, a few of which have been selected for your
shopping convenience. Later on we'll show you how to find and install new servers within
the Channels that Sherlock offers.
You can collapse the
bottom halfofthe window
- the part that shows a
file's hierarchy- by
grabbing the slotted bar in
between the top and
bottom windows. Slide it up

The News channel looks for articles containing your search criteria within about a dozen
high-profile news sites, including one of our favorite sites, CNN Interactive. Naturally you
could use your browser, access the sites, and read everything, but if you're interested in a
particular subject, or wanted to check out a story you heard somewhere but haven't read
yet, this channel can prove quite useful and effective.

or down to adjust the sizes
ofthe windows.

;_ -- , -_·yµ.1: -: .

This Apple channel provides the ability to search an extensive service, product, and support
database maintained on several sites, among them the Apple site. It can return a wealth of
information about the most esoteric questions, as we'll see a bit later on.

The Reference channel looks in dictionary and encyclopedia sites to find references to
almost any subject imaginable. You can also add the ability to search a thesaurus for
alternative words if you're in the midst of writing the great American novel, or simply a
computer training book.
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My Channel is a custom channel to which you can add your own search sites, and categorize them under any subject that interests you or is required for your work. We'll explore
how to modify this and the other channels in this Chapter.

Searching Drives and Volumes
The Disk Drive channel provides the ability to search any mounted volume - either a local
drive -whether they' re on your machine or anywhere on your network, assuming they're
mounted on your desktop.

Finding Files with Sherlock
1. Ifyou're at the Finder, press Command-For select Sherlock2 from the Apple menu.

Volume la not lnclextd
Volume I• not lnclextd

When you use the Disk
Drive channel, you will
notice that one of the
columns indicates whether
or not the drive is indexed.
Indexing is a method that
stores an invisible pointer
file on your hard disk
containing key information
about the content of the
files stored there. We will
work with drive indexing in
this Chapter. Although it's a
time-consuming process
that does take up a
considerable amount of
hard disk space, indexing
can considerably speed up
Sherlock's ability to find files
on a hard disk containing
hundreds or thousands of
files.
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2. Your screen display might differ from this one, because we have a different configuration then you do. When you select the drive channel, you will see a list of the available
drives showing in the middle portion of the window - they'll be the ones mounted
on your machine and/or network. In the empty field as the top of the window (below
the Channel icons), enter the word "Moby."
3. Click the Magnifying Glass icon to initiate the search. The drive will spin for a second
and the results of your search will be revealed in the middle window, replacing the list
of the drives that was there a minute ago. Select the file named Mo by Oick.THT.

Ifyou create a custom

search - for all PageMaker
files creating in July, for
example, or every Microsoft

-

_mo

.

!::ii 03-39....sevemow.or

r!il 05-28-.mo~l~k.lif
E3 05-54-mobynevfonts.ttf '

[l
[l

Moby Dick 1.tif

Q

HllrdDrlvo2

•

Moby Dick 2.tlf

II ppWt!MM

Photoohopl!l Tl ff me
Photoshopl!l Tiff me

do<ument
document

Excel spreadsheetyou
created in the past ten days
- you can click the Save
button and they/I be saved
in the Custom Search list.
The next time you want to

Cl Cur rant Boob In Progr..•
(l

B&slc M&c OperetloM

It\ MocHD
ll Project folder
Cl Copy flleo
~

Molly Olct.txl

do the same type ofsearch,
you simply pick it from the
list and can avoid having to
make all the same settings
over again.

You probably have a lot fess files with the word "Moby" in their titles on your
machine. These are illustrations from the creation of this course.

4. When you select the file, the bottom portion of the window will display the file's

hierarchy, showing exactly what folder it is in, and whether or not that folder is within
another folder.
5. Hold down the option key and drag the file's icon onto your desktop. A copy rualog
box will appear and a copy of the file will be created on your desktop.

6. Click the Magnifying glass again to refresh the view. Two Moby files will now appear
in the list; one on the Desktop and one in the same place you found it (probably in
your Projects folder we created in a previous Chapter).

Clicking the Magnifying Glass refreshes the search and reveals any changes that
happened since the fast time you looked.
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7. With the new copy selected in the list, hit Command-Delete, which will send the file
to the trash. Look at the display; Sherlock knows where it put the file.
Kind

Ifyou create a custom
search - for all PageMaker

Dele Modified

,:a Hard Drive I

a Trooh

~ Moby Oick.txt

files creating in July, for
example, or every Microsoft

8. Empty the Trash and put away Sherlock by pressing Cornmand-W.

Excel spreadsheet you

Working with files within Sherlock

created in the past ten days

As you can see from this brief exercise, when you find a file with Sherlock, you can access it
directly from within the dialog box. You can:

- you can click the Save
button and they'll be saved
in the Custom Search list.

• Copy or move the file by either dragging it or option-dragging it to another
location.

The next time you want to
do the same type ofsearch,
you simply pick it from the
list and can avoid having to
make all the same settings
over again.

• Print it by pressing Command-P. The creator application will load directly to its
print dialog box, from which you can control the output using the program's
built-in features.
• Throw it away either by dragging it to the Trash or by using the CornmandDelete key command.
• Sort the list by clicking in the titles above each column. For example you can
sort by the date created, the size of the file, the name, or the file type.
• Create an alias of the file by selecting it and pressing Command-M for Make
Alias. Once it's created you can move it to wherever you want it to permanently
reside.
• Get information on the file by selecting it and pressing Command-I.
You can expand the criteria for your searches by selecting Custom Options from the menu
bar (Find>More Options) or by creating a Custom Search.
·~~~~~
Q me
Names
0 Cpntents

f)

-.:ms:mmliiilliiiiii'.!~::f~l
~
I Edit- I
Appllclltlons
L11r11e r than IMB

Modlfted todll)'
Modified yesterday

Modified
8, 11 :06 ...

You can add your own custom search criteria to this list by saving your searches.

A custom search provides you with a broad range of basic and advanced criteria, each
available in either a pop-up menu (for ranges that are predetermined, such as bigger than
or less than) or a field where you can enter specific info rmation (like a phrase within a file's
comment box, for example).
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Flnd ttemswtlose:,,,,__ _,........_=:-::----------==",..,..._.~-~c

!if me name
O content Includes

,....'.:;;;========::;;:=~====~
!if dote created "1i1s_,,_.._ _,~ _ _.....
I ;....,I 612112000 I~

I

1

Until you get used to

I~

E]dotemodlfled (1s

l; ll 612112000

O comments

f; I.....___________,

[ contain

working in an intense

Oslze

l lslessthan

commercial environment,

0 ldnd

Iis
Its

you cannot begin to

0 label

understand how much time

[]vi1rsJon l •s

;;

I: II

IK

J( alias

·

*l

Advanced Options - - - - - -:
[]Is l._tn_v_ls_lb_le_ _ __,

I ~ l l._N~o_ne~--~-'
'! ~ J I

..__,..,....,...,.,.,...,...,...,..--,-,-~

------~

and headaches a good
search tool like Sherlock can
be. Finding files by date
ranges when they were
created or modified, for
example, can often help you
located something whose
name you simply can't
remember. In environments
where files are numbered
and not named (like in our
courseware-design studios),
these types ofsearches can

Sixteen different search criteria are available to you from within the More Search
Options dialog box. You can also use this window to Save custom searches for
later use.

When Sherlock is looking through a lot of material during a search, it naturally takes longer
than when the program's search vista is limited to only a portion of your drive. You can do
this by dragging a folder onto the area of the window where the drives are displayed. Then,
if you check off the drives and leave the folder, the program will run considerably faster. You
can make it even faster if you index the drive or folder, which we'll cover later in the
Chapter.

be a real life saver-

Index Stat111
Volume Indexed 5aturday, Mey 20, 2000, 8:54AM
Volume I• not Indexed

because no human can
remember that the file was
named 03_ 18.tif. At least

Q

Jnle~nal

Cl

Qurrent Boo~ In P.ro, .~

HD

Vo lume Is not Indexed
Volume Is not indexed

none of us humans.

By placing a folder in the Sherlock window you can speed up the search considerably.

You can leave the folder in the window, or delete it when you're done. Deleting the item in
the Sherlock window does not delete the original folder from your drive.

Indexing Your Drives
The Indexing feature is new to Sherlock, and causes the program to scan your hard disks
(or any folder therein) in order to create an index file. An index file is an invisible file that's
stored on the indexed drive and contains pointers to key information within those files.
Indexing has its pros and cons. Among the negatives are the fact that it can take a long, long
time to index a large drive containing thousands of files. The second problem is the size of
the file itself- it can range to 20 megabytes or more. Adding to the problem is the fact that
the file is invisible-you lose space and you really don't know where it's going.
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The upside to having your volumes indexed is the blinding speed at which Sherlock can
find things on an indexed volume- practically instantaneously.
There are a few work-arounds that can lessen the negative impact of indexing. They are:
• Index your drives as soon as you get your Macintosh. That way subsequent
indexing commands don't have to start from scratch- all they have to do is
update an existing index.
In an earlier Chapter we
talked about the ability to
assign a label to a file, and
modify the names of the

• Schedule your index commands for a time when you're either away from your
machine, away from your office, or both. From Sherlock's Find menu, select
Index Volume.

labels?

That invokes the Sherlock Index dialog box, from which you can select the
volume you wish to index at some predetermined time.
You might notice that one
of the choices in the More
Search Options dialog box
is the ability to search by
label. Sherlock will deliver a

"° I

i

Awlume mlJst be fndexed bofol"6 ~by Content c.n be Usei!. lndexlr..i preperea your wlumes co,11tent liiiil
searches a-re"feot. lln indtx conto1 .. stgnlneont wrcb found In Ille nemes end contenb of your Olea.
l»t.I

1

lbe Sc1$1ule

lndcc status

D
0
0

Indexed Wed. J un 21 . 2000, 4:56 PM
Volume Is not Indexed

4.9MB

list of all the files marked
with your custom labels.

From there it's a simple matter of clicking the Schedule button and setting a
convenient schedule for the indexing to take place. Late at night is usually a
good time, unless your Mac is tied up playing the latest DVD movie.

Once a volume is indexed,
you can search for files by
the content they contain for example a specific
name, word, or phrase
within a word processing or
layoutfile. To perform
content searches the drives

'create or. Ul!dat~ tli11 lndex,f0r
r e selected VOl~rlle"S II!=

Ii ' I •:OOAM 00
III Mon~ayis
EJ TUeS!lll}'S
Iii Weilnesdays
El Thursdays

0

Fridays

D Saturdays
osundays
lndexlng<:11n toteo.,.hlle,aoyou moy
""nt to s• lfll a time vlin you•re w.y
from your compute•i

containing the files must be
indexed.
You can schedule routine indexing events from this dialog box.
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• Index folders that contain the files you're likely to be looking for. This way you're
only indexing the folder and not the entire drive. You can index any folder by
Control-Clicking it and choosing Index Selection.

s
I 2 iloms, 151.6 MBawlloblo

o.t• Na!llr!ed
--~,

Finding invisible files - of
which the Index file created

Fri, J un 16, 2000, 3:56 PM
u-_...,..;.__ _ _ _ _--tl Set, Jin 3, 2000, 1:28 PM

u-----.,...,.....,..,---.,..;.-.;,...i

•

by Sherlock is one kind -

•

use Sherlock. Create a
custom search set called
Invisible Files. First use the
Advanced Find under More

jijifiifiijijiijjiiii
-..-.....:.0.0....-.--..--_..._,

Sli. Kind
- folder
- folder

Tue, Mey 23, 2000, 5: 18 PM
Wtd, Hay 31, 2000, 5:09 PM
Tue, Mey 23, 2000, 5: 15 PM

-

Set, J on 3, 2000, 8:0 I AM

-

fo

Tue, Apr 18, 2000, 7:31 AM
Set, Moy 27, 2000, 9:47 AM

-

fo

-

fo

Fri, Jun 2, 2000, 9:58 PM
Set, Jin 3, 2000, 1:34 PM

-

fo

fo

Creating Index of"Baslc Mac
Operations"
Time remolnll'IQ:
lndeXll'IQ: 01...05Jnousemechu119

-

fo

Sot, J1n 3, 2000, 1:30 PM

It
- ro......-....-,.,-- - - - - - - - -

Set, J1n 3, 2000, 9:09 AM

-

folder

Search Options.
Adva•c•• Options _

_ _ _,..

I 11w11i.1e
El ~•• I• cust.o1w lcoo

ril I{

l

1:

CJ name/1<0n (ls lo<ted
CJn••tYll•

I
!: "

I:

CTL:::DI

CJ rre1tar ~l

I
I

Control-clicking allows you to selectively index individual folders within a volume.
It can take a considerable amount of time to index a complex folder. The selection
here, which contained 879 items occupying a total of376.5 megabytes, took a
little over 25 minutes on a 500 megahertz G4 Macintosh.

Searching the Internet

Once you've selected the
criteria under Advanced
Options, save the set under
the name Invisible Fifes.
Select that search set from
the Custom list whenever
you need it in the future.
Iii•

As we've mentioned, one of the truly unique features of Sherlock is that it's as capable of
searching the Internet as it is of searching your hard disks. Of the seven predefined channels, all but one (the Disk Drive channel) requires that you have an active connection to
the Web.

Understanding Sherlock's Internet Channels
When Sherlock is first installed on your system, each Channel is pre-loaded with a select
number of sites specifically selected for that Channel.
For example in the World Wide Web Channel, we see fifteen sites already in the list, and
several of them, like Aladdin Systems and Cnet have multiple offerings.
fOrl

la ~ Aloddln Sy$te"1$
0 -A ~loddln Sy$teJ110: f requentl y Asked Questla~
lif 8 ! AlteVlste
f

[)

0
0
0
0
lif
0
Iii
Iii
0
Iii
0

... Apple l Revlev
• lle$t Site First

8 CHET
8 CHET l>!Nnloed.com
<iJ Direct Hit
00 EX<lte
Q

built-In
built-In

cuotom

::.r.:~~~~~=-

built- In
built- In

GoTo.com

built- In

<i

HotBol

bullt- ln

(I)

lnfooeek

00

IADl:S""'rt

11'1

Rollll'IQ Stone

llJ tycos

Sherlock comes pre-configured with a list of search sites under each Channel category.
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If you look at the Shopping Channel, you'll see several Amazon sites, Barnes and Noble, and
e-Bay.

and turn down the slider

•Boy

You can see that each of these sites is listed as "built-in" under Kind.

that says "responsiveness."
more sluggishly your

{Q,

If you look inside of your System Folder, you'll find another folder named Internet Search
Sites. Opening it reveals folders that correspond to the Channels in the Sherlock dialog.

system will perform during

Internet Search Sites

an indexing. This is fine if

~··Modified

I>
I>
I>
I>
I>
I>
I>
I>
I>

indexing while you're away
from your machine, but if
you're doing it while you're
working on something else,
it's best to turn it way down.

~==:=·:.-:-,:~
-~-·
4&.tWtm•• ,.. f-.rr...-....>

,.,....,.,,.,..w...••

making sure it'sonly doing

Yetleriloy, 5:15 PM

Cl Channel
Cl Internet
c:;i My Ch6nnel

ci 11.....
!l Ptople
ll Refennce
fS Shoppl1"19

v..terdey , I 1:20 AM
Tue, J un 20, 2000, 10:5 1 PM
Thu, Apr 27, 2000, 11 :08 AM
Wed, Apr 26, 2000, 7:45 PM
Wed, Apr 26, 2000, 7:45 PM
Thu, Apr 27, 2000, 1 l :OBAM
Wed, Apr 26, 2000, 7:45 PM

Inside each of these folders are special files with an .src extension. They're written in HTML.
If you look inside of the News folder, for example, you can see that the .src files reflect the
names in the New Channel List.

it in one language. Select
the Languages button and
turn offany languages

~

LengugH

ESPH.arc

Solct ti. la"'l-l'O'J - U..t obooto i.,
lndt;<tO •nd ...,.'*'- Soloctl119 lwer
l•f'l9Ul9l' rnek:N l l'IOl:Xlng f.,tt-r ,,.. U3a las
•'*i9tnyow htrddlst.
ij

-

CNET nevurc

you're not using.

~

Mot1eyroo1.orc

[8
Selected Sites

•

0

Alrlb..,
Ar•blc. Forol. eno Urdu
C.lalon
Cmll•n

0

Cyrllllc 111111_.

O cnch

0

Donl•h

i;J

Dult h

....-==

c.,.i1oh

0

C.lonlan

(ii'

rnncb

Iii Otrrl)tn
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The Internet Search Sites folder contains the actual Channel information for Sherlock.

up Sherlock's indexing is

"61

Wed, Jun 7 , 2000, 7:03 PM

'•)

Another thing that speeds

0

i:l APPie

..,.~

, ..,.,~

0
0

ll!IB

9114ms, 1.82 GB evolloble

you'rescheduling your

. ............
......,...

Kind
built-In
built-In
built-In
buil t - In
built- In
built -In

Cl Bernot end tiilb le

Open Sherlock'spreferences

The higher the setting, the

li!J
li!J
liJ

Anion.com Auction
Anion.com Boob
A1TmOn.com Music
A!TmOn.com Video
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Items in each Channel reflect the contents ofits folder.

You can fully customize the lists contained in Sherlock's Channels by adding .src files to the
proper folders, or alternatively by taking files out of their respective folders. We will explain
how to find new Channel resources later in this Chapter.

Searching for Web Sites
Ifyou've ever used a search engine on the Internet, you'll find that the method is similar.
• Sherlock searches all the sites in the Channel list at one time (assuming that
your ISP allows simultaneous connections, which they probably do).

Use Sherlock to find a file
named Find by Content
Indexing.

• Sherlock understands common language a shade better than do conventional
search engines.
• Sherlock is extensible; that is you can customize the search process through the
addition of freely-available .src files. If you know HTML, you can even create
your own (see the Sidebar on the previous page for more information).
• You can save custom search criteria for Internet channels exactly the same way
as you can for the Disk Drive channel. This allows you to repeat a search at any
time without reentering the criteria.

Select the file and press
Command-I to access the
Information dialog box for
the file. Set its memory

Using English language queries makes Sherlock much friendlier than most Internet search
engines and portal sites - even the ones listed as Sherlock Channel resources. In the
following example, we asked where to find information about growing orchids, and were
rewarded with a list of sixty or so sites.

allocation to as high a
number as you're comfortable with. Eight or 1Ok is
appropriate. The program
will index much faster with
more memory.

Relewnce

llllmt

Easy Orchid> wb •lte

(J)
8:
(l)

CD

Auotrelien Corrupondence School• H...
The Central Onterlo Orchid Society
II Ake r no Orchid> botanical orchid nu ...

(J)

Orchid•
Bob Cempbell'• Orchids

CD

BIAH-- Grwlno Orchid•

i!lf' I '§I f§ 1 j I
.,._,__._v_ _
...._

~!<

,.,_.............._ _;i

00 Botllnlcal Orchid> end "°""To Grw T... <D arguo
orchid> boobtore: book re~I...,
:~~=~=~
a:
erguo orchids: orchid• for sale

txJ Seel Rock Orchid> - Home

00 Gro'JIno Tl I" for Orchid>
CD

Kelley's Korne r Orchid Suppl loo - £...

<D Boob

liil IW To Grov Cypri pedium 1lo9lnee0f...

a:

======

~tlerockorchl'!:' ....

........,.eta mt.CC!!'
..W.cllarley'l)reenhou ...

\NVJIM90~

.......,.ergorchld>.ccJn

When Sherlock returns a list of potential sites with information relative to your question, it
rates that relevance and displays a comparative graph under the Relevance column, which
you can see in this list.
You can also access a brief description of each site by expanding the bottom half of the
Sherlock window. A paragraph of text will explain a bit about the site.
. A 'torldof O,.c!Jidt

A 2~0 sq.qr"• fttt connrntor"y v lth i ptrm.tntnt indoor flowtrir'IC} orchid dts"play, .as -w•ll u •n orohld l"KrUf'Y
Ith ai w idf r'.anc)• of sptotfs .ind hybrids .

~
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Finding People
Using the People Channel, which searches several directory services sites, we looked for the
President's email address by entering Bill Clinton in the search field. Over 100 entries were
returned, and not surprisingly, the President's email address was, in fact, in the list (it's
Prez@whitehouse.gov).
Ifyou know a little bit about
HTML programming, you
can find out how to write
your own .src files for use in
Sherlock's Channels by

prezwhltehou.e.dc.gov -

visiting the Apple
blll_.ilntonwhileholl$0...,m -

Developer's Site. Here's the
address:
httpi!developer.app/e.com/
Mac OS/sherlock.html

Look under the section

There it is, second in the list- the President's email address. Isn't technology wonderful?

If you double click one of the names in the list, you will automatically launch your email
program, which in this case was Microsoft Outlook, and a New Message window, with the
person's name already in place, will appear. Type your message, click send, and await the
arrival of the FBI (Hint: they usually drive Mercury Marquis with moon hubcaps).

entitled "Extending and

-

Ci! untttted

Controlling Sherlock."
fn>l)l:

l:t iro;
lit Cc:

I •lien~

I; I

@ pmwhltehoU$0.dc.goY

It eJ,
SubjeC\, ..l _ _ __,.._ _ _ _ _ _ _

I> llt!ec:h~n+= tW'INI '
~J Defeult Font • JTtxl Size

11

'-11B

I

ll

T

Once you've received a list
ofsites that match your
search criteria, you can drag
any of them onto the
desktop or into a folder
Be careful what you say- big brother is watching.

(such as your Favorites
folder, or a specific research
project folder). They become
a special file called a
Location file, which will
automatically launch your
Browser and load the site if
double-clicked.
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Shopping
Shopping on the Internet has mushroomed dramatically over the past several years. If you
haven't bought anything on the Internet, you're in a growing minority. Although we did
spend time at the local malls this past holiday season, it was more for people watching then
it was for buying (well, maybe some buying). Sherlock makes the process even easier than it
already is. Here we looked for Bikes. We found dozens.

r

IBicycles
The Bicycle Repair Book

You can drag people's

i!,
i!,

names to the Desktop or a

~ blcycl.. JEEP COMAhtHE LI MITED FULL SUSP ALUM
~ blcycl.. MOIG>OSE MCX ALUMINUM FRONT SUSP NEW

us
us
us
us

folder as well. The resulting

i!,

us

file will automatically

~ GT Bicycl .. Beby J-r ~r otroller LIGHTEST I

us

i!, blcycl .. MANTIS MOUNTAI N BIKE NEW IN BOX bike
i!, blcycl .. MANTIS FRONT SUSPENSION HOUNTAIHBI KE
i!, blcycl .. MANTIS MOUNTAIN BIKE HEW IN BOX bi ke
i!, blcycl .. LADIES CRUISER 3 SPEED COMFORT BIKE

us

launch your email client
with the person'saddress in
the To: field ofa New

blcycl.. J EEP CHEROKEE SE FULL SUSPENSION AL
blcycl.. JEEP WRAll;LER SPORT FULL SUSP ALUM

blcycl.. MANTIS FULL SUSPENSION MOUNTAIN BIKE

~ ROAOMASTER BICYCLES.COM domain name bicyc le

Message.

us
us
us
us

$6'lt....
$325....
$249....

24houro
06/23 15...
06/ 23 15...
06/ 23 15...

$195....

06/ 23 15...

$160 ....
$169....
$152 ....

06/ 23 15 ...
06/ 25 03...
06/23 15...

$145....
$137....

06/23 15...

$120....
$100 ....

06/ 24 14...
06/ 23 15...
06/ 22 23...

More bikes than even we can ride.

Looking for News Articles
For anyone doing research-whether in an academic environment or a corporate marketing department - the ability to simultaneously search multiple sites for news articles is an
effective and convenient feature.
In the following example we searched for articles containing references to Apple Computer.
We could have used the More Search Options dialog to narrow the search down to a range
of dates. If you were doing competitive analysis, for example, you could check every week or
so to see if any new articles appeared. That's an excellent way to stay on top of the competition, or to see what people are saying about your company.
You can sort any column in
ascending order by clicking
in its name in the title bar.
You can reverse the order of
the sort by clicking in the
little sort arrow, which is at
the top of the vertical scroll
bar.

(t
(t

a
(t
a
a
a

a
a

(t
(t

a

The ,,,..k In rev le"': AOL's departure

Getes: Anlltr usl trlal '"a "'aste of r ..ources;
AO L blocks another Instant "'""491119 rival
Gl... r. Jobs unval I streaml119 partner.hip

6/17/00
6/13/00
6/12/00
6/12/00

RealHoMlrb, ~pie I nk Web streaming deal
Envlslonl119 llfeoflerWlnc!ws

617/00

Instant messaolnv bottle ooes to Wash1119ton

617100

Reaction to Microsoft rull 119 1. ...,ift, mixed

617/ 0
6/5/00

Analyst> say IMec sales ex pected lo cool this summer
l nstent -aol119 start-up connects AIM, ICQ

(t

Emechlneo financial chief resl9ns

(t

Apple 9ome developers oound off on OS X che119e

a Senate heors computer expcr1 conl rol or9uments

nevo.c
........c
nws.c
.......c

617/ 00

Exodus names chel rmen, •PPtlnt. nev president

Short Take: Tel.,,an firm oets !Mac production order

fle'\lf3,C

6/1/00
5/31/00
5126100
5/26/ 00

Using a custom search for news articles about a specific company and constraining the search to a range of recent dates could prove quite effective for an
ongoing research assignment.
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Searching Apple's Technical Archives
If you're looking for support information about anything having to do with the Macintosh
(or any Apple product, dead or alive, for that matter), this Channel is the first place to look.
It contains site add resses for their Product Guide, Tech Library, and Apple.com. The Apple
iReview, a publication dedicated to the iBook laptops, is also optionally available (by default
it's not checked off, and therefore inactive).
Don't limit your searches to
built-In
built-In
bulll-ln
built-In

the Channels that seem
logical; searching for
references to PDF files on
the Web Channel might
very well produce better

For example, a search for additional plug- ins for Sherlock resulted in 44 references from the
predefined sites.

results than using the Apple
Channel. Ifyou don't find
what you're looking for the
first time you try, think of
other ways to phrase your
question and other search
sites that might contain
what you need.

Relevance

Nome

Apple - Education - Sherlock
['.] Apple - Educstlon - Sherlock
['.] Apple - Education - Sherlock

..,.,,..,.1pple.com

II M'FIM~-ifiMP 1 08

"""'·•RPle.com
..,.,,..,.1pple.com

['.] Apple - Medie: : :t lnformellon - ...
['.] Apple - tbt tlovs - Veer ofThlnkl09 ...
['.] Apple· f ind

"""'"pple.com
"""'"pple.com
"""'"pple.com

~.H...!Sl!!!l9

lnttrn• t C'\i!lf'ltlt

80

CrH tlnq or ~itinig lnttrntt ch•nntls . v~u cin crntt }'GUI'" own lnttmtt channtls so th1t you o-1n st.1rch only tht slttr
you•t•t lnttn1ttod In. YOIJ c,.ul t chvinels us1r\9 tht Ntw ChMW'lt l comtNnd In tht SMr~ck pr09t"1m ..Crut1n91 dl.M"IMI
, To crtatt • ntw ...

The Reference Channel
The Reference Channel provides virtual models of a traditional encyclopedia, a dictionary,
and if required, a thesaurus. If you or a family member needs to produce a report or term
paper in short order, this Channel is a great starting point. A search for references to
Vikings, for example, resulted in a considerable body of material.

RilMnce

!JI Oenmerk ( History)

mexoblOloW

!JI t19urtifll Gnat Britain (Ea rly E09llsh H111ory)
fll ltelend ( History)
fll lrtlond ( History)

m f1ers, estronomy

•

"""'~ncycl

-

"""'~ncycl
"""'~ncycl

""".encyc I
"""'~ncycl
"""'~ncycl

Need to know about marauding Berserkers? Check out the Reference Channel.
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As you can see from these brief examples, Sherlock provides a dynamic method of searching for the exact information you need at exactly the time you need it. Or does it?

Customizing Sherlock

-·-·

Ifyou have an Internet
connection, we strongly
suggest that you mark the
Apple-Donuts site as one of
your Favorites, because we're
sure that once you've visited
them, it will become so.
They have the dynamite
resource files for Sherlock
that we discuss in this
Chapter, as well as a bunch
ofApplescripts (small
programs that can
automate certain functions

As we've mentioned earlier in this Chapter, one of the most powerful features of Sherlock is
its extensibility, or the ability of a savvy operator to completely customize and expand where
and how Sherlock looks for the information you're seeking. In this next section, we're going
to show you just how to make Sherlock work the way you want it to.

The first thing you'll need is additional site resources - the .src files that you can see if you
open the Internet Search Sites folder in your System Folder. There are two ways to get them:
• Download them from the Internet. Without question, the best place on the Web
to do so is from the Apple-Donuts site. This excellent Macintosh support
network provides - free of charge - over three hundred different .src files that
you can use to immediately customize your Sherlock search engine.
• Write them yourself. Ifyou have a fair knowledge of HTML, you can write your
own resource (.src) files and drop them into the correct folder. Although it is a
relatively simple process, HTML coding is beyond the scope of this book, so we
would suggest that if you want to do so you find the Apple Developer's site we
talked about in the sidebar.
For now we're going to look at using the ones that we can get for free from the fine folks as
Apple-Donuts.

on your Macintosh), tips,
tricks, news, andjust a
bunch of totally fun stuff.

www.GpRl&-donuts.com

a5et1Mlnatlno noutlshmont for your mac

Check them out today, and
tell them we said thanks!
The Apple-Donuts home page is chock full ofgoodies for your Macintosh, and for
Sherlock in particular.

If you log onto the site and follow the instructions, you can download a huge collection of
Sherlock search site resource files.
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rs

Apple- llonuto.com

Qlt,

8ook/1119uln..

Commerct

Companies

Computer

ri na nolal

Geml"'I

Government

Healt h

Info

Internet/Search

Mac

Nalll09 Lisi>

~
Media

Movies/TV

Music

He'WS

Schools

Sort"Ware

Speolal IOther

tn,

Trevel

"• "

HolmeoSets

Read Me

Sher lock Assistant Sets

Recipes

As of last count (the day we were writing this Chapter) there are over 300 different
add-ons for Sherlock on the Apple-Donuts site. Ifyou download them, make sure
you drop these guys an email thanking them for the great stuff.

Modifying an Existing Channel
To add resources to an existing channel, all you have to do is drop the appropriate resource
files into the proper folder. In this following example, we're going to move the contents of
the Mac folder into the Apple Channel. Here's the original Apple Channel contents.
Internet Search Sites

Thu, Sep 23, 1999, 12:00 PM
Wed, Jun 7. 2000, 7:03 PM
Wed, Jun 7, 2000, 7:03 PM
Wed, J un 7, 2000, 7:03 PM
Wed, Jun z I , 2000, 1 1:20 A
Wed, Jun 21 , 2000, 5:15 PM
...-..,,..,..,.,.,....,.,..-T~ue, J un 20, 2000, 10:5 1 PM
Thu, Apr 27. 2000, 1 t :08 AM ,..

•

The predefined Apple Channel has four search sites installed.

In the Apple-Donuts Mac folder, there are m ore than a dozen excellent Macintosh reference
sites, all in neat .src files. Drag (or copy) them into the Apple Chann el folder inside of
Internet Search Sites, and then check out the Apple Channel from within Sherlock. O nce
you've made this change, the chances you'll find exactly what you're looking for are greatly
enhanced.
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Kind

custom

custom
cuotom
buil t- In
built-in
built- In
built -In

custom
custom

You can also add resource

custom

files to a Channel by

custom

dragging them directly into

custom

the list, or simply dropping
them directly onto the

Once you've placed new .src files into the appropriate folder, they will appear in
the Channel, listed as "custom" resources in the Kind field.

System Folder. In this latter
case, the Mac will askyou if

Modifying My Channel

you want to store the files in

Sherlock comes with one predefined Channel called "My Channel." You can place .src files
into it just as we did in the above example. Simply drag the .src files that you need into the
My Channel folder and the sites will appear in the list.

the Internet Search Sites
folder. Responding yes to
this question will result in
the new resources going
into My Channel -

Another, even easier way to add resource (.src) files to yours or any other Channel is to
simply drag them onto the Channel icon in the Sherlock window. They will automatically
appear in the Channel list.

because the Mac doesn't
know exactly what Channel
you would like to place
them in. Youcanalways
open the folder later and
drag them from one to
another so as to better
organize them to meet your
needs.
Dragging a resource file onto a Sherlock Channel icon will add that resource to the
Channel list.

Creating A New Channel
There's plenty of room for New channels in the Sherlock interface. If you drag the lined bar
that's under the Channel icons down a bit, you will see blank spaces. These are for any New
Channel that you create.

You can add dozens of custom Channels to Sherlock if it suits your needs.
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To create a New Channel you can select New Channel from the Channels Menu, assign the
Channel a name, and pick an appropriate Icon to represent the Channel in the Sherlock
dialog. Fortunately, for our new Travel Channel, we were able to find an old, sticker-bound
suitcase. Looks like one we used to own, as a matter of fact.
Name the channel:

Icon:

ITravel

Channel type: ! searching

~ ~I

{II@

Description (opt!onel):

[
fil

~

OK

~

I

You can select icons for your New Channels, and assign a name and a comment if
you want to.

Once you've created your new Channels, simply drop in resources that match the content.
In this following illustration, we've added a Channel for Travel, one for Schools, and
another that contains mailing lists. The contents of all three came from the download set on
the Apple-Donuts web site.

You can see our three new Channels in the second row oficons. They add to the
functionality ofSherlock.

Chapter Summary
In this Chapter, you explored Sherlock, Apple's second-generation search engine. You've
seen how it relies on a special folder within the System folder which contains Internet
Search sites, in a special file format known as .src, or search resource files.
We looked at how you can use Sherlock to find files on your hard disks and connected
volumes in a wide variety of ways; how to limit searches to specific portions of your drive,
how to create and save a custom search command or criteria, and how to use the Index
feature to speed up searches and save time. We discussed several ways to speed up the index
process, including setting Sherlock to index specific volumes at scheduled times, when
you're away from your system.
Lastly, we used Sherlock to search the Internet, seeking specific information in a variety of
categories. We learned how Sherlock segregates search criteria into categories known as
Channels. We also saw how to download new resources from the Web, how to use them in
existing Channels, and how to create New Channels for personal searches.
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Troubleshooting
Although the Macintosh is a relatively stable computer platform, there are times when
things don't work the way they're supposed to. In this Chapter, we'll discuss what kinds of
bad things happen, why they happen, and what you can (hopefully) do when something
does go terribly, horribly wrong.
Although we make light of

it, don't let usscare you
when we talk about things
going wrong. Sure, it

There are several common problems that most Macintosh users encounter at some point in
their life. Of course these things happen when you least expect them, and at the most
inconvenient time. All you have to do is know how to respond, and in most cases you can
get out of trouble.

happens, and there will

• Your machine won't start up. When it does, it displays an icon of a blank floppy
disk with a question mark inside it.

certainly be times when you
lose the most important file

• Your computer begins to start up, makes a weird chiming noise, and shows an
icon of a sad Mac, with crosses where its eyes are supposed to be (indicating it's
dead and not at all OK) and a sad expression on its down-turned mouth.

in the world - the one you
worked on for 214 hours
straight with no sleep and

• Your Mac starts up, and might even appear to be working fine, when it suddenly
freezes up on you; the mouse doesn't respond, typing doesn't work, and cursing
definitely doesn't work (except, perhaps, to make you feel better).

less energy. But fortunately
the real horror stories are
the rare ones. Most of the

time when your Mac

• A program acts crazy, displaying weird things on the screen or just not doing
what it's supposed to be doing.

bombs, freezes, or otherwise
acts up, your data is

• You can't open that critically important (and sole) copy of the annual report
you've been working on for three weeks and it's still late.

perfectly safe and can be
recovered. In some cases

• You're cranking along, writing your most recent theory on Black Holes and how
they can harnessed to supply power to the each of the city's 140 Rave venues,
when the application just quits. No warning, just closes up and goes away.
Sometimes after this happens you can't start it again.

you might need professional assistance, but most
of the timeyou can recover
almost anything from a

• You're informed that your Mac is critically low on memory, and that you better
save your stuff before you lose every little tiny bit of it.

hard disk that's not at the
bottom of the ocean or
inside an incinerator.

Although this isn't the absolutely comprehensive list of everything that can and will go
wrong with your Macintosh, it's a good place to start. If you know what to try in the event
of one of these things happening, then it's less likely that you will just jump out the window
when you think you've lost important work.

1n the following sections, we'll discuss each of these problems at length and offer some
suggestions as to what might make the problem go away. We're going to say this a few more
times in this Chapter, but it's worth repeating before we've even said it the first time:
Shutting down your computer, counting to ten (so the hard disk can have a rest, and so you
can cool down) then restarting it, will solve maybe 80% of your problems without having
to do another thing.
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Startup Problems
You know you're having startup problems when you see a blank disk icon, a sad-looking
Mac face, and your computer freezes during the process. If your Macintosh refuses to start
up, then one of three things has gone wrong.

Hardware Failure
Don't forget Sherlock's
Apple channel when you're
having a problem that you
can't seem to resolve. There
are a tremendous number
of technical bulletins and
papers on their sites - and
more ifyou customize
Sherlock using the Mac
folder from AppleDonuts.com.
There are two more sites

The sad Mac isn't good. It is an indicator that something didn't work properly during the
startup procedure. It can be generally traced to a few specific problems.
• RAM, boards, or new hardware. Ifyou just put memory into your computer,
installed a new board to add functionality (such as a graphics board), or
installed a new hard disk (internal or external), this could cause a hardware
failure. Make sure to reseat the card or memory chips, ensuring that theyre well
placed and firmly seated in their slots.
• SCSI problems. SCSI (pronounced "scuzzy") stands for Small Computer
Systems Interface, and is the connection method used for many external devices
- particularly hard disks and storage devices. Each SCSI device has a dial or
other method of changing its address (usually one through nine, with Zero
reserved for the internal hard disk). If more than one device has the same
address, this can cause a sad Mac or other hardware freeze failure.

you should check out ifyou

Read the documentation that came with the device and learn how to change its
address. Check all the other devices in the chain and make sure no two have the
same address. Restart your machine when you're done checking and changing
addresses.

have problems that you
can't resolve. One is
macfixit.com and the other
is macintouch.com.

• General hardware failure. If you continue to get a sad Mac and chimes, and
cannot locate a loose board, RAM chip, or conflicting SCSI device, then it's
probably time to call a pro or carry your Mac to the McHospital.

Freezes

lfyougeta blank disk at

If your Mac appears to be starting up just fine and suddenly just stops or freezes, there is a
chance that you have a conflict with an extension or startup item. Certain extensions and
control panels have been known to conflict with others, and when that happens your Mac
will just hang (another word for freeze up, lock up, stop working, and dying in its tracks).

Folder. Start from another

If you suspect that an extension conflict is causing the problem (because, for example, you
just installed a new extension or a new application which may have placed an extension in
your system folder), try the following steps.

disk that contains a system,

1. Restart your Machine. If it's hung up, press Shift-Command-Startup (the key in the

startup, the Macintosh was
unable to find the System

and check your internal
hard disk to make sure the
System is OK Also check the
Startup Disk control panel

upper right hand corner of your keyboard) and the machine will restart.
2. Hold down the spacebar during startup. This will turn off all your extensions. If the

machine starts up and the desktop appears, then the problem is in the Extensions
folder. Restart the machine again.

to make sure the Mac is
looking in the right place for
the System Folder.
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3. Hold down the Shift key while the startup process is occurring. This will cause
Extensions Manager to appear.
0

rm

-- - ... -

x:-= ... Extensions Mllnoger

----- I!]- Ener9)1~r
------- -ll!I
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and interesting people. Even
better than a chat room in
some cases.

You can load Extensions Manager during the Startup procedure by holding down the Shift key.
Then you can turn off which ones you think are the offending extensions and try again.

4. When you load Extensions Manager duri.ng the Startup procedure, you should try to
find any new extensions. You can tell which ones came with the Mac by the Mac OS 9
title in the Package colum n - they're probably OK. Look for new ones, especially
ones associated with any software you recently instaJled.
5. Turn them off, and continue the startup process. If the Machine comes up OK, you
fo und the problem.
6. If the machine hangs again, turn that one back on an d look fo r the next one. It's
usually a matter of triaJ and error, but with patience you can often find the conflict.

Never, and wemean never,
attempt to put a board in,

7. If it is a new piece of software, it's time to call the m anufacturer and ask them if they
know about an y conflicts that their software causes. They usually have received other
reports by the time you fi nd a problem and have an answer.

reseat RAM, or connect or

Program Failure

disconnect drives or

Program failure can take m any forms. The most common are:

peripherals while the
machine is turned on. The
best thing to do is to pull the
plug from the back of the
Mac so that there's no
chance your kid will turn on
the light switch and turn off
Mom or Dad.
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• The application has problems with screen display. Thi.ngs don't disappear when
you close them , garbage appears on the screen, or something doesn't look right.
• The application starts and freezes, or freezes during some routine operation.
And it does it every time you restart the application.
• The application quits in the midclle of something. You might get a message that
says something similar to, "The Application FramusFixlt has quit."

Under most circumstances, an application that doesn't run is either:
• Having memory problems - there isn,t enough memory for the program to
run.
• There is a corrupt file somewhere. Usually it's a Preferences file that's loaded by
the program when it launches.
We encounter many new

So what do you do when a program isn,t working properly? There are several things to try.

users who say "there's a bug
in this program." Most of
the time, that's simply not
true. Sure, there certainly are
bugs in all major software
packages - someone once
wisely said that "all this stuff
is broken at some level; it
just depends on how
broken it is."

Allocating Application Memory
The first thing to try when a program isn,t working right is to give it more memory.
Programs have two memory settings in their Info dialog box. One is the minimum
memory under which the program can run. The second is how much you want to allocate
to the program. If you have plenty of memory, for example, you can give a program
4megabytes when it only needs 2 megabytes to run. In most cases, this fixes memoryrelated problems.
To allocate more memory to a program, you select the icon and press Command-I to access
the Info dialog for that application. Set the pop-up menu to Memory and give it more.

But having said that, we
also stand by our claim that
most major problems are
found before the thousandth copy ofan application is sold and installed. It's
not like Microsoft Word has
problems printing, or that
Adobe Illustrator has a
problem that makes a/12point rules disappear for
some strange reason.
Ifyou encounter problems,
it's 99% likely that the
problem is on your machine
and not in a commercially
available software program. Itjust don't work that
way. While you might be the
one to find a new bug, ifyou
can't make the same thing
go wrong over and over, it's
notabug.

Giving a program more room to work with often solves performance problems.

Once you,ve given the program more memory, restart it and see if you can duplicate the
problem. If not, you,ve found and solved the problem.

Preferences Problems
Some programs store a special file inside the System Folder in a folder named Preferences.
These files are where your default values are stored, such as the default type size, the default
page size, and so on.
If these files become corrupt, they can cause their corresponding applications trouble when
they're loaded. A corrupt file is one where digital garbage of some sort was written to the
file by mistake. This can happen if the machine bombs or hangs, or if you turn the machine
off without quitting the program or using the Finder,s Shut Down command. You can find
the Preferences folder inside the System Folder. In it are the Preferences files for all the
applications on your system.

Almost all applications have a preferences file in this folder. If the program starts up and
can't find one, it creates a new one from scratch during the launch procedure. Therein lies
the fix: delete the preferences file for the offending program. Restart it, which will make it
build a new Preferences file for itself, and see if the problem goes away.
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Although you may have to reset all of your defaults that customize the program for your
working environment, at least you can run the application.
Temporary Files

Sometimes your machine
doesn't have enough RAM

Some applications create temporary files when they're running, and (hopefully) delete them
whenever you quit the program. If the program shuts down unexpectedly, and won't start up
again (or starts up part way then dies), use Sherlock to look for files with the letters temp or
tmp in them. Ifthey're associated with the program that failed, trash them all. Then try
starting the application again. This is a somewhat esoteric problem, but we've seen it happen.

to run certain programs.
Make sure that your
configuration provides the
application what it needs to
operate. Ifyou don't, you
can try going to the
Memory control panel and
turning on Virtual Memory,
which uses a part ofyour

Ado bee "°90Mokere 6.5 do ...

hard disk to act as RAM.

Adobef> "°90Moker8 6.5 do...
Adobe& P090Mokerf> 6.5 do ...
Adobe& "°90Moker9 6.5 do ...
Adobef> P990Mokore 6.5 do ...
Hol p Yl...-er document

While it isn't as fast as real
memory chips, this trick can

folder

sometimes fool a program
into thinking you have
more memory than you
really do. Like driving a car
that's too expensive for you.

You might be amazed atthe numberofTemporary (also called Scratch) files that
can be found at anytime by looking with Sherlock for tmp or temp files. As long as
the program isn't running, you can trash them right from the Sherlock dialog
using Command-Delete.

Broken Applications

There are times when an application program just breaks - it refuses to work anymore.
You've trashed the temp files, thrown away and rebuilt the Preferences file for the program,
and still nothing. It continues to hang, not start, or quit by itself. It's time to reinstall the
application.
Before you begin reinstalling anything, you must make sure you throw away any files
associated with the offending application. To do this you must use the applications's
distribution CDs to uninstall the files. If you don't uninstall first, you may have the
problem happen all over again and not be able to figure out what went wrong. What
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might be happening is that the newly installed program is still loading an older (and
potentially corrupted) library, extension, or temporary file. If the program doesn't come
with an uninstall routine, you'll have to make sure you find all its parts and discard them
before you reinstall.

Not all problems have fixes
or causes that you can
discover. Therearetimes
when your Macintosh will
Mon.Feb 3 , 1997, 10:34AM

hang up and crash for no
apparent reason; the same

..;t:~':!""~

Set, Jun 17, 2000, 1:54 PM

~~~

Thu, Sep 2, 1999, 10:33AM

goes for most applications.
Sometimes they'll just die

Ifyou're reinstalling an application, throw away the whole folder and anything in
the Preferences folder related to the application. Otherwise the problem might
resurface even with newly installed software.

and there'sno obvious
reason for it.
Quite often, restarting your

Corrupt Files

machine or the offending

Sometimes an individual file is broken - that is, it can't be opened. This is not a good
problem, because if the file is truly corrupt, there are times when it cannot be recovered.

application will make the
problem go away. Ifthis
happens, chalk it up to the
McGremlins, and get back to
work. An occasional bomb

Although your Macintosh comes with a program called Disk FirstAid, its features are
limited. We strongly suggest that you purchase a file and hard disk utility program such as
Norton Utilities. You can find out more about Norton and the excellent drive utilities and
virus programs they offer from their web site at http:www.symantec.com.

c.N

isn't a problem unless it's
happening a lot or you can
make it happen whenever

A world leader in Internet security technology.

you want. That's when it's

June 23, 2000

IC"'*-Sola-

time to look for a fix.

-~..

-~

Though Symantec is famous for virus software, they also make an excellent series
ofdisk and file utilities that can sometimes pull your pants from a fire.

Ifyou try to open a file and receive an "Error 39" or "Error 43," find the backup; you're
going to need it There are times when a file cannot be recovered using the Mac OS, but can
using third-party utilities. One common example is a file that you've trashed and emptied.
There's nothing you can do unless you have something like Norton. With it, recovering
recently deleted files is a snap.

Other fixes
There are several other problems that display specific symptoms and have simple fixes. Here
are the most common:

PRAM
What the heck is PRAM, you ask? It stands for Parameter RAM, and is the reserved portion
of RAM that the Mac uses for such system level information as the time and date. PRAM
can sometimes become corrupt - just like a file can - and cause problems throughout
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your system. PRAM problems can cause disk drives to apparently disappear (same with
your printer in Chooser); it can cause peripherals to act up, and it can cause your machine
to hang for no other apparent reason.
The fix is pretty simple - if you're an ambidextrous octopus. All you have to do (having a
friend around helps) is hold down Command-Option-P-R while the machine is starting
up. This causes your machine to beep and forget what time it is. When it restarts, set the
time and date and see if the problem went away.

Rebuilding your Desktop
Your desktop file stores icons, aliases, and pointers to all sorts of files and functions - most
of which are invisible to you as a user. If you go to launch a file and the application can't be
found, for example, or if stuff seems to disappear randomly, or you can't get your icons to
stay aligned to the grid inside a folder - you might have a problem with the Desktop file.
The Macintosh can rebuild its own Desktop file if you tell it to. To do so, start up your
machine while holding down Command-Option. You will see a message asking if you want
to rebuild the Desktop (and that it might take some time). Click yes, and once your Mac
has built itself a shiny new Desktop, see if the problems went away.

Last Resorts
The last resort for some major problems is to rebuild your system. You have to do this from
another hard disk, or preferably, from the original distribution CD with the Mac OS on it.
In extreme cases, you should probably just back up your documents, format the drive, and
reinstall the system. Once you've done that and checked to see if it's working properly,
reload all your applications, then put your documents back in their folders. If this doesn't
fix the problem, take a nap then rethink your career choice.

Troubleshooting List
Let's recap the list of things to try when something goes wrong.
• Restart your computer. Often this will make problems go away and they won't

happen again.
• Trash the preferences and temporary files for the application. There's a good
chance that if an application isn't working properly, one ofits parts is broken.
It's a good bet that it's a temporary file or the program's Preferences file, which is
inside the Preferences folder in the System Folder.
• Reinstall the program. If all else fails, throw away everything having to do with

the offending application and reinstall it. That's why it's such a good idea to
actually own the software you're using- in case you have to reinstall it or (the
worst of all fates) call the manufacturer to get the answer to a question.
• Turn off Multiple Users. The Multiple Users option can lead to an array of
problems with applications that require a single preferences file. There's an
entire list of things that can go wrong if this option is active, and it's a good
place to look if there is something going wrong that nothing else seems to fix. Be
sure the check this before you reinstall an entire clean system.
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• Reinstall the system. This is a pain in the neck, but sometimes it just has to be
done. You have to have the distribution CD or another drive with a System on it
to accomplish a complete system rebuild.
• Restart your computer with the extensions and control panels disabled. To do
this, hold down the space bar while starting up. If the machine starts, restart it
holding down the Shift key to access Extensions Manager during the startup
procedure. Try to find and disable the conflicting extension until you find which
one was causing the problem.
• Assign more memory to your application. This is done in the Info dialog box.
Set it as high as you can spare. If you don't have enough memory, try using
Virtual Memory (in the Memory control panel) or buying more RAM.
• Upgrade your system software and/or hardware. You may need upgrades to
meet the requirements of the application you're trying to run. Make sure your
computer is configured to meet the minimum requirements of the program.

Chapter Summary
In this Chapter you've learned some of the more common problems that you might have
and how to go about troubleshooting a fix. You've explored problems that occur during
startup, when your Mac might not start up or might start up and freeze. You've seen the
types of problems that you can encounter because of extension conflicts, and how to use
Extensions Manager to find and solve the problem.
You've also learned about applications, how they need the proper amount of memory, and
how to give it to them. You've learned about corrupt files, particularly preference and
temporary files. You've also learned how to reinstall applications to avoid additional
problems, and you've learned to refresh the parameter RAM of the Macintosh to stop bad
behavior on the part of your Mac OS. Finally you learned that sometimes you just have to
start all over by reinstalling your system software.
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GLOSSARY
Acrobat
This program by Adobe Systems, Inc.
allows the conversion (using Acrobat
Distiller) of any document from any
Macintosh or Windows application to
PDF format, which retains the page
layout, graphics, color, and typography
of the original document. It is widely
used for distributing documents online
because it is independent of computer
hardware. The only software needed to
view these documents is a copy of
Acrobat Reader, which can be downloaded free.

Alias
An alias is a stand-in for an item on the
desktop (the item's name appears in
italics). Opening an alias actually opens
the item it represents.

Apple Menu
This is the menu at the left end of the
menu bar, indicated by the Apple logo.

AppleShare
Software that lets you connect to other
computers on a network and use the
contents of shared folders or disks.

Application Switcher
This is the area at the right end of the
menu bar, indicated by either a
computer icon or the icon of a running
application. (It can include a name as
well as the icon).

Balloons
Small boxes containing text identifying
objects on the screen and explaining
their use. You can hide or show
balloons by choosing the appropriate
command from the Help menu.

Bitmap
A bitmap is a type of image file that
uses pixels to form the picture
displayed on your screen.

Browser
An application that allows visitors to
see the contents of a Web server.

Chooser
A program which lets you designate
devices, such as printers and shared
disks on a network for your Macintosh
to use.

Clipboard
Your computer's clipboard is a portion
of its memory where items you cut or
copy are stored.

Control Panel
A control panel is a utility that controls
various aspects of a Macintosh
computer, from simple controls (like
the volume of the speaker) to complex
ones (like an entire macro program).

CPU
Central Processing Unit: A computer
consists of a number of physical parts.
The CPU is the part which holds the
processor and the memory. This is
sometimes in the same case as the
monitor but on many computers the
monitor is separate from the CPU.
A CPU is often the part of the
computer which contains any internal
disk, CD, or tape drives.

Desktop
Your working environment on the
computer (the menu bar and the
background area on the screen), on
which you work.

Drag
To position the pointer on an object,
press and hold the mouse button, move
the mouse, and release the button.

Driver
A driver is a type of software that
controls communication between your
Macintosh and a peripheral device
such as a printer, scanner, hard drive,
and removable media.

Ethernet
A high-speed standard for connecting
computers and other devices in a
network. Ethernet ports are built into
most newer Mac OS computers and
laser printers.

Extension
An extension is a file that modifies the
behavior of the Mac Operating System.

File Compression
The process of reducing the number of
bytes in a file, file compression is
usually used when transferring files
between computers.

Finder
This application program maintains
the Macintosh desktop and starts up
other programs at your request.

Folder
A container for documents, programs,
and other folders on your computer's
desktop or directory windows.

Guest
A network user who is not identified by
a registered name and password.

GUI
Graphical User Interface. GUI is the
interface we all know and love by
which we communicate with our
computers. GUI was developed at
Xerox PARC, and recently copied by
Windows.

Hard disk
A magnetic storage medium consisting
of one or more specially coated metal
disks, and associated mechanical and
electronic equipment. A hard disk can
be found inside most personal
computers. A hard disk can store a
tremendous amount of information
(depending on its size), but it is not
removable or portable.

Home Page
The first page readers encounter when
opening a Web site.

HTML
HyperText Markup Language. The
special language used to format Web
pages.

Icon
Icons are small pictures or symbols on
your computer screen that represent
documents, applications, devices, and
sometimes processes.

Imagesetter
A raster-based device used to output a
computer page-layout file or composition at high resolution (usually 1000 3000 dpi) onto photographic paper or
film, from which to make printing
plates.

Internet
A worldwide network that provides
e-mail, Web pages, news, file storage
and retrieval, and other services and
information.

Landscape
Printing from the left to right across
the wider side of the page. A landscape
orientation treats a page as 11 inches
wide and 8.5 inches long.
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Laser Printer
A high quality image printing system
using a laser beam to produce an image
on a photosensitive drum. The image is
transferred to paper by a conventional
xerographic printing process.

Local Talk
A relatively low-speed standard for
connecting computers, printers, and
other devices to create an AppleTalk
network.

Menu Bar
The strip across the top of your screen
that contains the names of the menus
available to you.

Modem
A device that enables your computer to
communicate with another computer
over ordinary telephone lines.

Multimedia
Any combination of graphics, video,
animations, text, and sound is called
multimedia.

PDF (Portable Document Format)
Developed by Adobe Systems, Inc. (and
read by Adobe Acrobat Reader), this
format has become a de facto standard
for document transfer across platforms.

Pop-up Menu
A pop-up menu contains a group of
choices in its own window, much like a
pull-down menu on the menu bar.

Portrait
Printing from left to right across the
narrow side of the page. Portrait
orientation on a letter-size page uses a
standard 8.5-inch width and 11-inch
length.

Postscript
PostScript is a programming language
developed by Adobe. It is used to
describe printed text and graphics on a
page. This is used on many type's of
printers.

PRAM
Parameter RAM is the area of Mac's
RAM set aside for settings such as date
and time, monitor resolution, and
more. PRAM is powered by battery so
settings won't be lost on the shut-down
of the machine.
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Printer Driver
The device that communicates between
your software program and your
printer.

Public Domain
The term public domain refers to any
created work, including software, that
the public has every right to copy and
use in any way they see fit.

QuickTime
QuickTirne is a software extension that
lets you play synchronized video and
sound clips on your Macintosh.

RAM
Random-access memory is physical
memory built into the computer in the
form of electronic chips or small
circuit boards.

Scrapbook
A scrapbook is an accessory in which
you can save frequently-used graphics,
text, and sounds.

Service Provider
A firm that provides a range of services
somewhere on the continuum from
design to fulfillment.

Shareware
Shareware is software you can test out
for a while to determine whether or
not you want to buy it.

Sharing
When you are on a network, you can
allow others on the network to view or
copy files on your computer. You
control which of your files are
available, who has access to them, and
what type of access they have using the
File Sharing control panel and the
Sharing settings in the Info windows
for your shared folders or volumes.

Sherlock
Sherlock is a utility that allows you to
search for files, folders, news, people,
and even do your shopping online. You
can organize your favorite Internet
search sites into custom channels to
look for any type of information on the
Internet.

Spooling
A printer-driver operation in which the
driver saves page descriptions in a file
(called a spool file) for later printing.

TCP/IP
Transmission Control Protocol/
Internet Protocol. TCP/IP is a set of
rules for exchanging information
among different computers on a
network.

Trash
An icon on the desktop that you use to
discard programs, documents, and
folders.

TmeType
The outline font technology built into
the Mac OS (and Microsoft Windows). TrueType fonts can be
smoothly scaled to any size on screen
or to any type of printer.

Type1Fonts
A PostScript font that includes
instructions for grid fitting so that the
font can be scaled to small sizes with
good results.

Type Family
A set of typefaces created from the
same basic design but in different
weights, such as bold, light, italic,
book, and heavy.

URL (Uniform Resource Locator)
The address or location of a Web site
or other Internet service.

Web Site
A collection of HTML files and other
content that visitors can access by
means of a URL and view with a Web
browser.

Window
A rectangular area that displays
information on the desktop. You
create and view documents through
windows and view the contents of
disks in windows.

Zoom box
A small box in the top-right corner of
the title-bar of the active window.
Clicking the zoom box resizes the
window so that you can see all of its
contents (if possible); dicking it
again returns the window to its
previous size.
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account
with an ISP 148
account number 153
accounts 168
Acrobat 124
Acrobat distiller 124
Acrobat reader 125
addition 83
address
email 165
scsi 197
addresses 25
Adobe 128
Adobe acrobat 124
Adobe illustrator 73
Adobe.com 126
advanced settings 162
aliases 72
creating 75
finding the original file 74
guidelines for usage 74
America Online 149
anchor points 127
animations 149
anonymous user 151
anti-aliasing 127
appearances 88
Apple channel 179
Apple developer guidelines 70, 113
Apple developer's guidelines 60
Apple extras folder 75
Apple menu 78
Apple menu options 90
Apple system profiler 79
AppleScript
help for 20
Appleshare icon 143
application palette 60
application picker 60
application program 12
application quits 196
applications 24, 79
printing from 113
arrow pointer 53
audio 149
audio cd player 105
auto-resize 17
autofill 153, 154
B

background color 6
backgrounds 88
baud 137
bitmap fonts 127

bits per second 135
branding 95
browser 150
browser controls 158
browser software 150
bullet (•) character 102
buttons 9

c
cable modems 137
cache 103
calculator 83
can't open a file 196
cascading 32
category folders
in launcher 101
cd player 105
central processing unit 23
certificates 162
changing
the name of a file 63
the name of a folder 32
views 39
channels 108, 109, 178
chat rooms 152
chime 6, 196
chooser 115
clear 83
client
software for ftp access 151
clipboard 72
clipping 80
clock
setting the system 92
cnet.com 179
CNN interactive 179
color monitors 112
color menu 85
color picker 49
command key 8
commands menu 82
Compaq 23
components
cpu 23
Compuserve 149
configuration manager 153
connection tab 143
connections
to the internet 148
content
controlling web 159
control panels 78, 87
control strip 91
controlling your system
the menu bar 7

controls
general 98
cookie 161
copy files 33
copying a file 12, 64
the progress bar 65
core 7
corrupt (un-useable) files 23
corrupted 25
cpu 23
crash 24
create
keychain 162
creating
a new folder 30
an alias 75
files 61
folders 30
creating your first file 61
curves 128
D

data files 58
date and time 92
deadMac 196
default pattern 88
default sound 104
delete key 31
deleting files 52
from the trash can 54
desktop 6, 58
using pictures as backgrounds 88
desktop button 63
desktop printer icons 120
devices and volumes 80
dictionary 179
die sub 113
digital camera 95
direct connection 109
directory services 169
disk cache 103
disk drive channel 178
disk firstaid 201
display
browser 158
displaying the content of folders 14
displaying your work 112
distiller 124
division 83
doc 97
dot matrix 112
double-clicking 11
download manager 157
download options 156
downloading files 156
INDEX
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drive utilities 20 l
drivers 94

modem 142
dsl 137
duplicate 31
duplicating an alias 74
dvd 108
E

edit 7
editing commands 70
editor 154
email 150, 164
empty trash 12, 54
encyclopedia 179
energy saver 94
equals 83
error 39 201
ethernet 135
ethernet network 150
examining a file 58
extensions 94
extensions manager 94
extensions on the pc 98
external storage 25

renaming 32
trashing 52
using within the launcher 100
viewing as pop-up menus 42
folders 12
font 85
font list 119
fontmenu 68
fonts 66, 160
postscript 128
formatting text 67
forms completion editor 154
freezes 196
ftp 150

general controls 98, 153
get font list 119
gigabyte 23
graphics folder 43
groups 140
groups of users 140
guest 141
guidelines

apple developer 60
H

Fetch 151
file 7
file exchange 97
file menu 13
file sharing 138
file translation 97
files

hands-on activities 6
hard disk 7
hardware 94
hardware failure 197
help 17
helper 155
hierarchy 37, 38
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J
Java 160
jpg 97
K

key caps 101
keyboard 7,31,98

commands 8
G

F

copying 64
creating new 61
saving 62
finder
preferences 46
firewall 155
fixed external hard disk 25
fixed media 25
float 112
floppy disks 26
folders 30, 58
changing the names of 32
changing the contents look 40
changing views within 39
creating new 30
creating practice 34
definition of 30
hierarchy 38
managing your practice folders 36
nesting 32
organizing 32

Intel 23
internal hard disk 24
internet 138, 148
Internet Explorer 150
internet service providers 148

using aliases to control 73
highlighted 67
hints 130
history tab 162
home button 20
home/search 159
html 150
hypertext markup language 150
I

i-beam 67
IBM 23

icon sizes 48
identifying a folder's hiearachy 38
imagesetters 114
information panels 81
inkjet 113
input

keyboard, using the 8
input methods
the mouse 8

keychain 162
keypad

numeric 83
kilobyte 23
L

label 50
landscape 122
language 99, 160
large format sizes 114
laser printers 112
launcher 99

usingthe 99
launches 59
launching

applications or files 61
Linotype/Hell 128
list view 48
local provider 149
Iocaltalk 134
logon 149
low on memory 196
M

MacHelp 18
machine won't start up 196
machospital 197
Macintosh

operating system 25
maintenance 25
make alias 31, 75
making a copy of a file 64
marquee 35
MCI/Worldcom 148
megabits 135
megabyte 23
memory 23, 102

virtual 103
menu bar 7, 58
menu options 90

Microsoft's Internet Explorer 150
minimize 17
minimize your clicking 35
minus 83
modems 137, 142, 149
modifier keys 8
monitor 6, 112
mouse 8, 103
pads 9

movies
quicktime 87

multiple volumes 80
multiplier 83
my channel 180
my settings 96
N

navigate 63
navigating through folders 37
nested folders 72
Netscape 158
network browser 145
network hard drives 91
network identity 139
network settings 155
network users 140
network volumes 143
networks
typesof 134

new hardware 197
new message window 165
news channel 179
newsgroups 152, 168
Norton Utilities 201
numeric keyboard 32
numeric keypad 83

password 139, 140, 149
pattern
background 6

PC Exchange 98
PDF 124
PDFWriter 124
peer-to-peer network 134
people channel 179
Photoshop 12
picker 60
pipes 148
pixels 128
platesetters 114
platter 24
player
audio cd 105
quicktime 108

offending application 200
open 31
open transport 136
operating system 25
option-8 102
organizing folders 32
orientation 123
original 72
outline type technology 128
Outlook Express 164, 179
output 112
output device 114
p

application 60

help for 20
R

radio buttons 90
ram 23, 197
ram disk 103
random access memory 23
ratings 161
read and write 139
read only 140
Reader
Acrobat 124

realplayer and realjukebox 106
recovering
lostdata 25
trashed files 53

aliases 72

pop-up 40,42
portable document format 124
portal site 159
portrait 122
PostScript fonts 128
PostScript page description 127
power-on switch 6
powerpc 6
ppd 127
pram 201
preferences 46
finder 46

print 31
printer 112
printer driver 113
printers 94
printing 112

printing from an application 121
printmonitor 120
private network 141
probability
of search results 20

profile form 154
profiler 79
programs
utility 25

progress bar 65
projects folder 32, 34, 41, 52, 58
proportional fonts 160
protocol
file transfer 150

packets 148
palette

queue 120
QuickTime 106

pointer files

resolution 114
the printer 114
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Q

storing in keychain 162

protocol helper settings 155
proxy servers 155
put away 31

reference channel 179
reinstalling an application 201
remote access 143
removable media 26
renaming folders 32
report function 81
resolution 114
response rate 99
restart 96
retrieving mail 153
Road Runner 149
router 149

s
sad mac 196
Sanford University 161
saving files 62
scrapbook 86
screen-capture programs 94
scsi 197
search 159
search button 159
search engine 159
seattle mac users group 152
sectors 25
security certificates 162
security of information 24
select all
command-a 35

sending an email 165
sending mail 153
servers 91
service providers 148
set desktop 88
shared items 139
INDEX
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shareware.com 157
sharing 141
sharing files 138
Sherlock 178
shift key 35
shopping channel 179
show: fonts 119
shutdown command 23
shutting down 12
signatures 166
simple beep 104
simpletext 59, 75
small computer systems interface 197
smtp 153
software overview 80
sound 104
speakers l 04
special 7
special characters

accessing from key caps 101
spooler 119
spooling 119
standard flow chart 37
standard view options 48
startup disk 104
,
startup items 96
startup problems 197
stickies 84, 96
storage 24

external 25
fixed disks 25
random access memory 23
removable media 26
streaming video 149
subscriptions 160
Sun Microsystems 160
switching centers 148
symantec.com 201
system administrator 155

4 INDEX

system extensions 114
system folder 39, 78
system profiler 79

using the help system 17
utilities 20 l
utility 25

T

v

ti and t3 lines 137
tab 42
tcp/ip 138
technical support 79
text 105
text style

vcr 108
version

for stickie notes 85
themes 88
thesaurus 179
throwing things away 52
Time-Warner's Road Runner 149
title and track fields 106
title bar 43
tracks 25, 106
trademark symbol

creating a 101
translation 97
transparency materials 114
trash can 12, 31, 52
trash warning 54
TrueType character sets 130
turning on your system 6
type technology 128
typel fonts 128, 130
typefaces 66, 127
types of networks 134
typing 7

u
username 153
users & groups 140
using

folders 30

of the macos BO
video

streaming 149
view 7
view certificate 164
view menu 42
view options 48

as list 100
views

changing a folder's 40
virtual memory 103
visual environment 7
volumes 80, 143

w
wallpaper 88
web channel 179
web content 159
web page 150
windows

cascading 32
working environment 6
working with files 58
working with folders 36
working with text 67
write only 140
y

yahoo.com 179
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